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Getting Started
Product Overview
Product Overview
Genie Backup Manager™ (GBM), is a very easy to use yet powerful and flexible software that
can backup and restore files, documents, emails, settings, programs and more, to virtually any
local or remote location, including internal and external hard disks, FTP locations, across
network, optical media, removable media, memory sticks, and Amazon S3 storage.
GBM is the only backup software on the market that offers unlimited FREE Plugins, which the
user can download or create to extend the capabilities of Genie Backup Manager™ .
GBM is perfect for users of all computer comfort levels. Novice users will find it easy to create
their first backup job in matter of minutes after installing the software, thanks to its intuitive
wizard-based user interface, while advanced users will appreciate the software's extended
scalability and flexibility, with features such as preserving NTFS Alternative Data Streams, Email
notification, and scripting capabilities.
GBM also caters for the data protection needs of business enterprises, by offering features that
ensure a reliable backup mechanism for mission critical data, such as backing up using Open File
Backup (OFB), for businesses operating around the hour that cannot afford to shutdown its
running applications during backup, highly secure encryption, for sensitive documents that must
not fall into the wrong hands and scheduling unattended backup tasks for regularly safeguarding
constantly changing data.
As we introduce GBM, we are confident that it can efficiently and effectively address all your
data protection needs. Let GBM work for you and never again worry about losing what you have
spent years building or collecting.

Feature Matrix
Genie9 offers a variety of backup and recovery products, each priced and carrying a set of
features tailored to cater for the needs of different categories of users. Genie Backup Manager
comes in three editions: Server, Pro and Home.
Below you can find a comparison of the features available in each edition.
GBM
Hom
e9

GBM Pro 9

MS Exchange backup 2003-2007

-

-

MS SQL Server backup (2000-2012)

-

-

System State Backup

-

-

Feature

GBM Server 9
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CPU Affinity Control

-

Amazon S3 Support

-

Differential Backups

-

Multi-Drive Spanning

-

Pre & Post Commands

-

Preserve NTFS Alternative Data
Streams

-

Advanced Scheduling

-

Backup Performance Control

-

GRunScript (For creating Shareable
backup jobs )

-

Clone backup jobs

-

Military Grade 256-bit AES
Encryption

-

Military Grade 192-bit AES
Encryption
Military Grade 128-bit AES
Encryption

-

-

Cloning Backups
Full Backups
Incremental Backups
Open File Backup (VSS)
Wizard Based Interface
Easy Backup Wizard Layout
Jobs Manager
Report Manager
Time Stamps
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Quick Backup Desktop Shortcuts
Editing Previous Jobs
Duplicate Backup Jobs
Backup Summary
Outlook (2000-2010)
Outlook Express
Registry
Windows Settings
Internet Explorer
Favorites
Windows Address Book
Desktop
Windows Fonts
Media Playlists
Files
Folders
Auto Exclude
Plugin Support (Search &
Download)
My Photos
My Media
Disaster Recovery
Backup to Hard Drives (External &
Internal)
Backup Over Network (LAN, SAN,
NAS, Etc.)
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Backup to Flash drives
Backup to Removable Media Devices
Backup to FTP
Backup to SFTP
Built in CD/DVD/Blu-ray Burning
Engine
CD/DVD (3rd Party Packet Writing
Software)
Purging Backups
Rollback
Rotating Backups
Modified Date/Time Stamp use in
Backup
Zip Password Protection
10 levels of Compression
Backup Without Compression
Self-restorable Backup Sets
(SwiftRestore)
Power Saving Options
Schedule Backups
Backup While Logged Off
GBM Agent
Power Options
Snooze the Backup
Incremental Testing of Only new
and changed files
File Filtering (By file type, size, and
date)
Backup Logs
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Email Notifications
Catalog
File Search
Browse File in Backup Archives
without loading them
GenieScript (For creating custom
Plugins)

Unavailable features
Genie Backup Manager is packaged in 3 different versions to meet various markets. Some
features might not be available, depending on the product you are using. However, all features
are documented. For a feature comparison of the versions, please refer to the feature matrix. If
a feature is not accessible in the product user interface, it is likely not included with your version
of the product.

What's New In Version 9.0
















Enhanced Performance: Faster and uses less resources.
Enhanced Graphical User Interface
New CD/DVD Engine
Blu-ray support
Outlook 2010 Support
Microsoft SQL 2008-2012 support
The ability to backup to Amazon S3 Cloud storage
Amazon S3 bandwidth throttling
The ability to backup to secure FTP locations (SFTP)
Added RAW image support in backing up photos
Enhanced Volume Shadow Copy support
Added social media elements
Added swift restore to GBM Server
Added Windows 8 support
Improved Disaster Recovery engine

Copyrights
Copyright© Genie9 Corporation 2002-2012. All rights reserved.
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Warning: This computer program is protected by copyright law and international treaties.
Unauthorized production or distribution of this program, or any portion of it that's owned by
Genie9, may result in severe civil and criminal penalties, and will be prosecuted to the maximum
extent possible under the law.
Outlook Express®, Outlook®,Internet Explorer®, Windows® and Microsoft®, are Registered
Trademarks of Microsoft® Corporation
Amazon® and Amazon S3® are Registered Trademarks of Amazon®
All trademarks and registered trademarks used in this documentation are property of their
respective owners.

End User License Agreement
END LICENSE AGREEMENT
PLEASE READ THIS DOCUMENT (THIS "AGREEMENT") CAREFULLY BEFORE USING THE
SOFTWARE PROVIDED ALONG WITH THIS AGREEMENT (THE "SOFTWARE"). BY CLICKING "I
ACCEPT THE TERMS IN THE LICENSE AGREEMENT", YOU AGREE TO THE TERMS OF THIS
AGREEMENT AND TO THE Genie9 PRIVACY POLICY, WHICH IS INCORPORATED IN THIS
AGREEMENT AND CAN BE FOUND AT Genie9’S WEBSITE
(HTTP://WWW.Genie9.COM/ABOUTUS/PRIVACY.HTML). IF YOU DO NOT AGREE TO THE TERMS
OF THIS AGREEMENT, IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, PROMPTLY
DELETE AND DESTROY ALL COPIES OF THE SOFTWARE.

Versions of the Software
There are two versions of GENIE BACKUP MANAGER EDITION (registered and evaluation), each
of which is subject to this Agreement. UPON ORDERING, DOWNLOADING, INSTALLING OR
USING ANY VERSION OF THE SOFTWARE, YOU ARE REAFFIRMING THAT YOU ARE BOUND TO
THE TERMS OF THIS AGREEMENT.
The registered version requires registration with Genie9.com Corp., Which includes payment of
the then current license fee. The evaluation version is the only version that is provided without
charge; however, the evaluation version is not free software. All rights and licenses to the
evaluation version automatically expire 30 days after first installation, after which you must
register with Genie9.com Corp. and pay the then current license fee. Payment must be in US
dollars drawn on a US bank. For details on registration methods, please refer to the help file in
the software, or contact Genie9.com Corp.

License to Use
One copy of the evaluation version of GENIE BACKUP MANAGER EDITION may be used by a
single person for evaluation purposes without charge up to 30 days. Subsequent downloads of
the evaluation version by or for the same user do not extend, renew, or otherwise restart the
term of the license for the evaluation version.
One copy of the registered version of GENIE BACKUP MANAGER EDITION may be used by a
single person who uses the software personally. The registered version of GENIE BACKUP
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MANAGER EDITION may not be rented, loaned, leased, licensed, or otherwise used, by anyone
other than the individual who has registered the software.
Site licenses for GENIE BACKUP MANAGER EDITION may be obtained from Genie9.com Corp
which cover multiple users at one location or multiple users within a business entity.
You may make a reasonable number of copies of the registered version of the software for
backup and archival purposes. You also agree that you may not reverse assemble, reverse
compile, or otherwise translate the Program.

No Additional Licenses
All rights to the GENIE BACKUP MANAGER EDITION software and documentation not expressly
granted under this Agreement are reserved to Genie9.com Corp. You may not translate,
decompile, disassemble or reverse engineer the GENIE BACKUP MANAGER EDITION software or
documentation.

Costs of Litigation.
If any action is brought by either party to this License Agreement against the other party
regarding the subject matter hereof, the prevailing party shall be entitled to recover, in addition
to any other relief granted, reasonable attorney fees and expenses of litigation.

Disclaimer of Warranty
THIS SOFTWARE AND ACCOMPANYING DOCUMENTATION ARE PROVIDED "AS IS" AND
WITHOUT WARRANTIES AS TO PERFORMANCE OF MERCHANTABILITY OR ANY OTHER
WARRANTIES WHETHER EXPRESSED OR IMPLIED. BECAUSE OF THE VARIOUS HARDWARE
AND SOFTWARE ENVIRONMENTS INTO WHICH GENIE BACKUP MANAGER EDITION MAY BE
USED, NO WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE IS OFFERED. IN PARTICULAR,
GENIE9.COM CORP SHALL HAVE NO LIABILITY FOR ANY DATA STORED OR PROCESSED WITH
THIS SOFTWARE, INCLUDING THE COSTS OF RECOVERING SUCH DATA. THE USER MUST
ASSUME THE ENTIRE RISK OF USING THIS PROGRAM. ANY LIABILITY OF GENIE9.COM CORP.
WILL BE LIMITED EXCLUSIVELY TO PRODUCT EPLACEMENT OR REFUND OF PURCHASE PRICE.
NO LIABILITY FOR CONSEQUENTIAL DAMAGES. TO THE MAXIMUM EXTENT PERMITTED BY
APPLICABLE LAW, IN NO EVENT SHALL Genie9 OR ITS SUPPLIERS BE LIABLE FOR ANY SPECIAL,
INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES WHATSOEVER (INCLUDING, WITHOUT
LIMITATION, DAMAGES FOR LOSS OF PROFITS, BUSINESS INTERRUPTION, CORRUPTION OF
FILES, LOSS OF BUSINESS INFORMATION OR ANY OTHER PECUNIARY LOSS) REGARDLESS OF
CAUSE OR FORM OF ACTION, INCLUDING CONTRACT, TORT OR NEGLIGENCE, ARISING OUT OF
THE USE OF OR INABILITY TO USE THE SOFTWARE PRODUCT, EVEN IF Genie9 HAS BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME STATES AND
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY OF
CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

LIMITATION OF LIABILITY
Genie9'S ENTIRE LIABILITY AND YOUR EXCLUSIVE REMEDY UNDER THIS END USER LICENSE
SHALL NOT EXCEED ONE DOLLAR (US $1.00).
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USE OF THIS PRODUCT FOR ANY PERIOD OF TIME CONSTITUTES YOUR ACCEPTANCE OF THIS
AGREEMENT AND SUBJECTS YOU TO ITS CONTENTS.
SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES SO THIS
LANGUAGE MAY NOT APPLY. IN SUCH CASE, GENIE9.COM INC'S LIABILITIES WILL BE LIMITED
BY THE ABOVE LIMITATION OF REMEDIES PROVISION.

US GOVERNMENT RESTRICTED RIGHTS
Use, duplication, or disclosure by the Government is subject to restrictions as set forth in
subdivision (b)(3)(ii) of the Rights in Technical Data and Computer Software clause at 25
2.227-7013.

Installation
Genie Backup Manager
GBM System Requirements
GBM Server







Windows® 2003 Server, Windows® 2008 Server,Windows® 2011 Server, Windows®
SMB Server, Windows® Advanced Server
32 and 64-bit platforms
Microsoft® Internet Explorer™ 6.0.0 or later
Intel Pentium® III processor or above, AMD Athlon™
512 MB RAM (1 GB RAM recommended)
200 MB free hard drive space

GBM Pro/Home






Windows® XP, Windows® Vista, Windows® 7
Microsoft® Internet Explorer™ 6.0.0 or later
Intel Pentium® III processor or above, AMD Athlon™
512 MB RAM (1 GB RAM recommended)
200 MB free hard drive space

How to: Install Genie Backup Manager
Installing from the downloaded file:
Run the downloaded .exe file and follow the on-screen instructions to install GBM.
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To install from CD:
1. Insert the CD into your CD-ROM drive. Setup.exe will automatically be run. (If this fails
to work, double click the .exe setup file on the CD).
2. Follow the on-screen instructions.

How to: Register Your Copy of GBM
Upon purchasing a GBM license, the user will receive an email containing a serial number for
unlocking the software and removing the trial period limitation.
To register GBM before the end of the trial period:
1. Start GBM.
2. From the toolbar, click Help then select Registration .
3. Type or copy-paste the serial number into its designated field then click OK.

To register GBM at a later date (30+ days after installation):
1. Start GBM.
2. A dialog will appear instructing you to register your software. Select Enter Serial
Number then insert your registration code..

How to: Check for updates
The Genie9 support team regularly post updated builds of GBM with minor enhancements and
fixes for known issues. Registered users of GBM can use the Genie-Update tool to download the
latest updates for the software free of charge.

To check for updates:
1. From the Tools menu in the main screen, select Genie Update.
2. Select Next.
3. Follow the on-screen instructions.

9
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Upgrade to the New Version of Genie Backup Manager
Upgrade to the New Version of Genie Backup Manager
If you already own an older version of Genie Backup Manager and wish to purchase the latest, or
if you wish to upgrade to a more powerful edition, you are entitled to an "upgrade discount".
Please follow the link below for more information about upgrading options and pricing.
http://www.genie9.com/store/upgrades.aspx

How to: Install GBM as an Upgrade
When installing Genie Backup Manager as an upgrade, there is no need to uninstall previous
versions first; GBM files will be copied to a different directory as an independent product,
without causing any conflicts.

How to: Import Backup Jobs from Previous Versions
The First time you run GBM 9.0 it will scan for Backup jobs from older versions and will prompt
the user whether or not would like to import. However, you can manually import from selecting
Import Previous Jobs from the File menu in the toolbar, then follow the on-screen
instructions. This imports job configurations, settings, and unattended scheduled tasks.

How to: Restore Backups Created Using Older Versions
GBM provides backward compatibility with the previous versions. Therefore, you can restore any
backup created in the older version without any problems.

GBM Basics
What Can GBM Do?
Genie Backup Manager is a powerful backup and restore utility designed to backup your personal
files, folders and settings. To recover your entire system, users must create a Disaster Recovery
backup to restore the system to a working state.
Although Genie Backup Manager can reset the archive bit/flag of copied files during backup,
determining which files have been modified since the last backup run is done using the file's last
modified date and time attribute. This ensures that backup jobs are mutually independent, i.e.
backing up a certain file with one backup job does not prevent it from being backed up again by
another.
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Managing Backup Jobs
Copying an Existing Backup Configuration
Duplicate existing backup job and then easily modify its configuration. To do so, click Tools from
the application's toolbar, select Jobs Manager, select a backup job, then click Clone job.

Editing a Backup Job Configuration
You can use the Edit Previous Jobs button in the application's main window, then select a
backup job to modify its configuration. Another possibility would be to click Backup from the
main window, and go to the Job info page, select Edit Job, select a backup job from the list
and click Load.
When the Properties window opens, go to the page with the settings you want to modify.

Deleting a Backup Job
Click Tools from the application's toolbar, select Jobs Manager, select a backup job, then click
Remove. The catalog entries for deleted backup jobs will be removed, but files and folders from
the source and destination will not be deleted.

Rename a Backup Job
Click Tools from the application's toolbar, select Jobs Manager, select a backup job, then click
Rename...

Data Backup Types
There are four basic types of backup supported by GBM. Selecting the best backup type for your
purposes depends on the storage media used, disk space considerations, and file versioning
needs. Note that these backup types do not apply to Microsoft Exchange Server and SQL Server,
both of which have separate backup types of their own. For more information please refer to
SQL Backup Types and Exchange Backup Types.

Full
Backup all selected files and folders every time backup is executed. A new independent backup
set will be created replacing files from older runs, unless the user explicitly opts to keep them by
changing file purging settings.




Full backup takes the longest time among all backup types.
Best used for one-time backups, such as for migrating personal files to a new
computer.
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Incremental
Backup only files that have been added or modified since the last backup. Files that were
deleted, renamed or moved from the source machine will not be deleted from the backup
archive.





The first backup run will automatically backup all selected files and folders (i.e. run as
if full backup was selected).
Incremental backup with the rollback option enabled is best for spanning backed up
data over multiple storage volumes, such as CDs and DVDs, and for FTP backup.
Over time, incremental backup requires less space and time than differential backup,
however, it requires more time during restore, and all volumes containing previous
increment versions and the most recent full backup must be available.

Mirror
Backup only files that have been added or modified since the last backup. Old versions of files
will be replaced with newer ones and missing files will be deleted from the backup set.




The first backup run will automatically backup all selected files and folders.
Mirror backup is best for keeping an exact "mirror" copy of the original data on
external hard disks, or on a file server, and when access to old versions of files is not
required.

Differential
Backup only files that have been added or modified since the most recent normal (full) backup.





The first backup run will automatically backup all selected files and folders.
Over time, differential backup requires more space and time than incremental
backup, however, restore takes less time, and only the volumes containing the last
differential backup and the most recent normal backup are required.
Best for spanning backed up data over multiple storage volumes, such as CDs and
DVDs.

Note:
Home version does not offer Differential Backup type. For a complete list of differences between
versions, please check the Feature Matrix page.
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Data Verification
Verification ensures that backed up data was successfully written on the storage media and that
it can be restored reliably. Genie Backup Manager will by default verify backed up data
immediately after the backup task is completed. Users can also choose to test data integrity of a
backup archive at a later time using the Testing Data Integrity tool.

File Versioning in Genie Backup Manager
Genie Backup Manager is great tool for maintaining numerous versions of backed up files;
selecting incremental backup with rollback or differential backup will ensure that each time the
backup job is run, updated files are appended to the backup set instead of replacing older
versions.
The catalog feature allows users to browse through all versions for any given backup job, sorted
by date, and enables them to restore (rollback) all or some of their files to the state they were
in, at the point in time that backup was executed.
Users can also limit the number of backup versions Genie Backup Manager should keep per
backup job, in order to preserve disk space. This is done by configuring Purging settings.

Security in Genie Backup Manager
Genie Backup Manager offers multiple levels of protection to ensure that backed up data is not
accessible to unauthorized persons. ZIP passwords offer moderate protection for compressed
backups, with the added flexibility of being compatible with most compression utilities, to allow
users to manually restore data from backup archives, while AES (Advanced Encryption Standard)
encryption has the advantage of being highly secure, as it is adopted by NIST(National Institute
of Standards and Technology) as an FIPS-approved (Federal Information Processing Standard)
symmetric encryption algorithm that may be used by U.S. Government organizations (and
others) to protect sensitive information

Compression in Genie Backup Manager
Genie Backup Manager uses non-proprietary ZIP64 compatible compression to reduce backed up
data size and save space, supporting up to 264 -1 files within a zip archive as well as files that
have a size greater than 4GB, for a zip file size that can reach up to about 18 million terabytes
(more precisely, 2^64-1 bytes).
The Genie Backup Manager compression engine offers fast performance and low memory usage.
Speed improvements reach 25%-75% in certain contexts. It also provides 15 to 20% better
compression than other formats on many popular file types, especially XML data.
Users can choose between 10 levels of compression starting from no-compression, which packs
the entire backup neatly within a single file, but without the overhead to the backup speed
added by compression.
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Backup without Compression
Choosing to backup data without compression causes GBM to copy the data to a single folder on
the storage device while preserving the original folder tree structure, this makes data more
accessible and less susceptible to corruption.

Files and Folders Created by GBM
Files Created by GBM Locally
Genie Backup Manager creates a variety of temporary and permanent files and folders on the
machine on which its running during its various operations that are either intended to be used
by the user or for the program's internal use.

Job-related files and folders
When a new backup job is configured, the wizard creates a "JobSettings.dat" file in a folder
carrying the same name as the backup job (usually in C:\Documents and
Settings\<user>\Application Data\Genie-Soft\GBMAPPLICATION).
In addition, GBM also creates subfolders in the same location for each backup execution starting
with a folder named "00000000" for the first backup run, and a new folder with the name
incremented by one for each subsequent execution. Each folder contains catalog information for
the corresponding backup run.

Temporary folders
Genie Backup Manager creates a temporary folder at the start of each session to store transient
files and folders that are created during the program's operations, such as data waiting to be
written to CD or DVD, or data being encrypted or compressed etc.





Temporary session folder will be deleted when the session is closed (upon exiting main
application).
Unless otherwise specified by the user, GBM will look for the local drive with the most
free disk space and select it for storing its temporary folders and files.
Temporary files created during a backup run will be deleted when backup is complete.

Logs
Genie Backup Manager provides a log engine that helps you track backup, restore and test
operations. It also offers advanced logs for tracking and debugging backup operations and
volume shadow copy snapshots. For more information on each of these logs and how to access
them, please refer to the Logs and Reports section.
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Files Created on the Backup Destination
This is a list of the most important files that Genie Backup Manager might create on the backup
destination, along with a description of what each folder/file type signifies:

.gbp

The .gbp file type is associated in Windows with Genie Backup Manager, and it represents the
file that the user needs to select in order to load the backup for restore. This file is recreated at
each backup execution. When backup is executed with compression enabled, the file with the
extension ".gbp" will represent the main backup output file containing the entire backup archive
along with GBM's internal use files. If data was forced to split, such as in the case of multiple
media spanning, this will be the last file in the set.
In case of backup with compression disabled, GBM will create a file called Main.gbp in the
uncompressed backup folder at each backup execution, which will only serve as a link to the
index.gix catalog file, located in the same folder, that holds the necessary information for
restoring the data from the backup archive.

.c00<X>

This file type represents a split in a compressed backup archive; this occurs when a single
compressed archive is divided into multiple linked portions, sequentially numbered starting with
.c000 to c00X, where X is the number of split compressed file parts. The last file in the set is
always the file {backup job name}.gbp.

.n00<x>

This extension represents a source file that has been split during a backup execution with
compression disabled.
.exe

This file is created when the Self-Restorable backup option is selected in the backup job's
configuration. If this file is present, Genie Backup Manager does not need to be installed on the
target machine in order to restore data from the archive.
If compression was enabled, this file will contain the entire backup archive as long as the size of
the data in its compressed form is less than the number specified for the Enable one-file selfrestorable backups option; however if this size limit was exceeded, or if the backup was
uncompressed, Genie Backup Manager will create a file called "Swift_restore.exe", which will
only contain a self-executable version of the restore functionality.
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Using GBM
How to: Start Genie Backup Manager
Before you start, make sure that your backup devices have been detected and are configured
correctly without conflicts.
To start Genie Backup Manager...




Click Start , point to Programs > Genie9, and then click Genie Backup Manager 9.0.
If you have selected the option to add an icon to your Quick Launch bar when you
installed the software, you can click that icon to start Genie Backup Manager.



Double click the Genie Backup Manager system tray icon

.

Shortcuts
The most important functions in GBM are assigned keyboard shortcuts for increased
accessibility.
Backup Wizard Shortcuts

Next
Previous
Ctrl+1
Ctrl+2
Ctrl+3
Ctrl+6
Ctrl+7
Ctrl+4
Ctrl+S
Ctrl+8
Ctrl+5

Alt+Right Arrow
Alt+Left Arrow
Job Info
Where to Backup
What to Backup - My Profile
What to Backup - MY Folders
What to Backup - My Plug-ins
Settings
Save
Schedule the backup job to run unattended
Start Backup

Main Window Shortcuts
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Alt+B
Alt+R
Alt+C
Alt+E
Alt+Q

Backup
Restore
Catalog
Edit
Run Backup

Miscellaneous Shortcuts

F1
Ctrl+P
Ctrl+T
Ctrl+G

Help
Preferences
Test Data Integrity
Update

Selection Panes
Selecting data for backup or restore in GBM is done using a Windows-Explorer-like interface.
Selection panes are used to select or deselect files, folders, and various items and settings.
When an item from the left pane is highlighted its contents will be displayed in the right pane, to
refine the selection if necessary.
A plus sign means that the listing can be expanded to display additional items.
A minus sign means that the listing can be collapsed to hide displayed items beneath it.
An empty check box means that the item can be selected but is currently not.
A check box with a blue or green check mark means that the item is selected with all
its contents.
A gray check mark means that some but not all of the item's contents have been
selected.
A grayed out check box means that the item is not available or not selectable; if the
item has an Expand/Collapse box then the user needs to expand the listing to be able
to select its contents.

My Folders Selection Options
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Right-clicking on any item (file or folder) in the right-hand pane in My Folders tab and selecting
Selection Options presents the user with several options for selecting files and folders, these
are:







Select All: Select all items in the pane
Clear All: Deselect all items in the pane
Select Files Only: Only select files appearing in the current view
Select Folders Only: Only select folders appearing in the current view
Invert Selection: Invert the selection in the current view (unselected items will be
selected, and selected items will be deselected)

Accessibility
Microsoft Windows offers "Accessibility Options" that make it more eye-friendly for people with
visual disabilities. They allow you to modify the display to make it easier to work with the
computer.
GBM supports visual accessibility options; changing Windows appearance will change GBM's user
interface making the software more readable for people with color blindness, weak vision etc...



GBM needs to be restarted before changes in visual accessibility options are applied.

Windows and Dialogs
Most windows and dialogs in Genie Backup Manager can be resized to fit the users preference.
The minimum dimensions for the main window is 740X570, hence it is recommended to set the
display resolution to 800X600 or more in order to be able to see the entire contents of any
window.
When a pane or window is not resizable and part of its contents is hidden, scroll bars will appear
enabling the user to view the concealed parts.
GBM by default remembers the location and size of the main window upon exiting the application
so that these attributes would be retained the next time GBM is started. To disable this feature,
click the Tools menu command, select Global Preferences, select General, then remove the
checkmark next to Save window location on exit.

Job Summary
During the creation or modification of a backup job, the lower-left corner of the backup wizard
will provide a summary of the backup job's settings, this include:
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Job name: Name assigned to the backup job.
Media Type: Media selected for storing the backup.
Backup Type: Full, increment, mirror or differential (backup all selected files or new
and changed files).
Compression: Compression setting (with or without compression).
Security Type: Type of security setting used (None, zip password protection or
encryption).
Estimated size: The total estimated size of selected items.
Estimated items: The estimated number of files selected for backup.

Wizards Overview
GBM adopts wizard-like interfaces for its three main functions: Backup, Restore, and Scheduling
unattended backups. Each of these will be described in details later on.
Each wizard is comprised of a series of dialog boxes guiding the user through the steps required
to perform the task, all the user has to do is choose the appropriate options in each dialog and
then click Next to proceed to the following step. At any point, the user can click the Previous
button to correct or modify selections made in previous dialogs.

Getting Help
GBM users can seek assistance regarding the use of the various functions and features of the
software using several different help resources, which include:



Offline Help
GBM's desktop help documentation provides assistance in using the many
functions of the software in the form of detailed descriptions and step-by-step
tutorials.
To access GBM's help documentation do one of the following:



From the toolbar click Help, then select Contents.
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Press <F1>.

Using Help
The following is an explanation of the help window interface







A book
represents a topic category, you can double-click the book or
click the plus sign box next to it to expand the list of topics it holds.



An open book
represents a topic category with its topic list expanded,
double-click the book or press the minus sign box to hide the topic list.
A page represents a help topic select the page to display the topic in the
right-hand pane.




The Contents tab displays a list of categorized help topics
The Index tab lists help-related keywords alphabetically; enter a
keyword for a help topic, as you type the letters, the highlight will close
in on the closest match, once you reach the desired topic double click it
The Search tab provides a full-text search utility for any word or phrase
in the GBM help window. Enter the string you wish to find and press
search, a list of topics containing that string will be displayed in the pane
below.

Online Technical Support
Although Genie Backup Manager can be effortlessly installed and has
unprecedented user-friendly features, we have a highly-skilled technical support
team, geared up to answer any inquiry users may have.
You can contact the technical support team at Genie9 using the helpdesk call
tracking system. Users must be signed up with My Account in order to send
inquiries (available for free for both registered and non registered users). Sign
up with My Account.
For more information on using Genie9's helpdesk call tracking system, see
Contacting Support.



The Knowledge Base
A growing searchable database of questions and answers about Genie9's
software. The Genie9 support team regularly updates this online database with
new articles.
Click to visit the Genie9 knowledge base page.

Exiting GBM
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To exit GBM do one of the following:





From the File menu in the toolbar select Exit.
Press <ALT + F4>.
Click the X button on the top right corner of the program.

Attempting to exit will open a dialog asking the user to confirm the request

Suppressing the quit confirmation dialog
Registered users can suppress the quit confirmation dialog, to do so:
1. From the toolbar, select Tools, then select Global Preferences.
2. Select General.
3. Remove the checkmark next to Confirm quit dialog box.

The System Tray Agent
The System Tray Agent
The System Tray Agent is a service that runs in the background and displays an icon
in
Windows System Tray to allow quick access to the following Genie Backup Manager functions:



Starting Genie Backup Manager.
Double Click on the System Tray Agent to open Genie Backup Manager



Creating a new backup job.
Right-click the System Tray Agent, Select Create Backup Job... the backup
wizard will appear.



Editing an existing backup job by selecting one from a list.
Right-click the System Tray Agent, point to Edit Job and select the backup job
you wish to edit



Silently running a backup job (Run Backup).
Right-click the System Tray Agent, select Quick Backup, and select the backup
job you wish to run.



Running a backup job and shutdown the computer automatically immediately after
backup is completed.
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Right-click the System Tray Agent, select Shutdown... a list of your backups will
appear Select the backup you wish to run and check "Remember shutdown
settings" if you wish to keep shutdown settings for the backup.



Checking for updates for Genie Backup Manager.
Right-click the System tray Agent and Select Check for Updates

To start the GBM System Tray Agent, click Start, point to Genie9, point to Genie Backup
Manager 9.0 Tools, then click Genie Agent.

How to: Set the Genie System Tray Agent to Run at Startup
1. Go to Start > Genie9 > Genie Backup Manager 9.0 Tools > then click Genie Agent.
2. Right click the Genie Agent icon in the system tray
then select Settings.
3. Make sure Start agent when my computer starts is checked.

System Tray Agent Settings
To open the GBM agent settings dialog right click on the Genie Backup Manager icon in the
system tray then select Settings.




Show notifications: Display GBM agent notifications.
Start agent when my computer starts: Run the GBM system tray agent as a process
at startup.

How to?
Genie Backup Manager
How to: Install Genie Backup Manager
How to: Register Your Copy of GBM
How to: Check for updates
How to: Install GBM as an Upgrade
How to: Import Backup Jobs from Previous Versions
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How to: Restore Backups Created Using Older Versions

How to: Start Genie Backup Manager
The System Tray Agent

How to: Set the Genie System Tray Agent to Run at
Startup
Catalog

How to: Back up the Catalog
Local/LAN

How to: Restore from a Local Drives
How to: Restore Data Stored on Network Locations
FTP/FTPS

How to: Restore Data Backed Up Using FTP
Amazon S3

How to: Backup to Amazon S3

How to: Restore/View Online Backups
How to: Delete Online backups
Optical Media
How

to: Restore from Optical Media

Removable Media
How

to: Restore from Removable Media

System State
How to: Backup System State

23

GBM User Manual

How to: Restore System State
How to: Restart the Domain Controller in Services Restore Mode
Outlook

How to: Backup MS Outlook Data
How to: Backup While MS Outlook is Running
How to: Restore Outlook Data
Outlook Express

How to: Backup Outlook Express
How to: Backup while Outlook Express is running
How to: Restore Outlook Express Data
How to: Synchronize Outlook Express Mail Folders
How to: Synchronize Outlook Express Settings
How to: Extract mail folders directly from a backup
How to: View Backed Up Emails
Windows Mail
How to: Backup Windows Mail Data
How to: Restore Windows Mail Data
Windows Registry

How to: Back Up the Entire Registry
How to: Back Up Selected Registry Keys
How to: Restore Windows Registry
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Desktop

How to: Back up Desktop Items
How to: Restore Desktop Items
My Documents

How to: Back Up My Documents
How to: Restore My Documents Folder
Windows Address Book

How to: Back Up Windows Address Book
How to: Restore Windows Address book
How to: Synchronize Windows Address Book Contacts
Windows Contacts

How to: Backup Windows Contacts
How to: Restore Windows Contacts
Windows Favorites

How to: Back Up Windows Favorites
How to: Restore Windows Favorites
Windows Fonts

How to: Back Up Windows Fonts
How to: Restore Windows Fonts
My Media

How to: Use playlists to backup media files
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How to: Automatically scan for media files
How to: Restore Media Files
My Photos

How to: Back Up Images and Photos
How to: Restore Images and Photos
Windows Settings

How to: Back Up Windows Settings
How to: Restore Windows Settings
My Folders

How to: Create New File Filters
How to: Import and export file filters
How to: Restore Files and Folders
How to: Restore to a Different Location
My Plugins

How to: Back Up Programs and Program Settings
How to: Compile a Plugin Script

Settings

How to: Create a Quick-Backup Shortcuts on the
Desktop
Scheduler
How to: Rotate Backups using Advanced Scheduling
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SQL
How to: Register MS SQL Plugin
How to: Backup SQL Server Data
How to: Connect to the Database
How to: Start the Database in Single-User Mode
How to: Restore a Transaction Log Backup
How to: Restore a Differential Database Backup
Exchange
How to: Register MS Exchange Plugin
How to: Backup Exchange Server Data
How to: Restore an Incremental or Differential Backup
Restore

How to: Load Backup from the Archive
How to: Load Backup from the Catalog
How to: Restore/View Online Backups
How to: Restore Data
Disaster Recovery
How

to: Create Genie Disaster Recovery Bootable
CD/DVD disc
How to: Create Genie Disaster Recovery Backup
How to: Restore Disaster Recovery Job
E-mail Notification

How to: Activate E-mail Notification
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How to: Send Email Notifications
Genie Script
How

to: Create a Plugin using XML tags

How to: Create a Plugin using Plugin Creator
GRunScript

How to: Create a Backup Job Script
How to: Run a Scripted Backup
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Main Window Commands
The main window contains a selection of the most important Genie Backup Manager functions.

Main Commands
Backup
Starts the new backup wizard.

Restore
Starts the restore wizard.

Disaster Recovery
Starts the disaster recovery wizard

Catalog
Starts the backup catalog; a complete index of backups.

Edit Previous Jobs
Opens a list of available backup jobs which the user can choose from to edit a backup
job's configuration.

Tools
Run Backup: Opens a list of available backup jobs which the user can from to quickly
execute a backup.
Global Preferences- Opens Genie Backup Manager's preferences dialog.
Test Data Integrity- Opens the Test Data Integrity window.
Genie Update- Opens the GBM automatic update window.
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Quick Links
Buy Now- Direct link for purchasing GBM online.
My Account-Direct link to My Account for online registered users
Online Registration- Register your copy of GBM online.
Online Support- Contact information for the Genie9 technical support team.
Home Page- Opens the Genie9 home page in your default Internet browser.
Free Plugins- Opens the Genie9 Plugins database page to download free GBM Plugins.

Menu Commands
Menu

Item

Function

File

Backup Wizard
Restore Wizard
Cataloging
Default Backup Folder

Open the backup wizard.
Open the restore wizard.
Open the backup Catalog library.
Browse the default location used by GBM for storing
backups.

Tools

Test Backup

Test a backup set's data integrity to ensure it can be
restored reliably.
Search the catalog library or a backup archive for
previously backed up files.
Open the backup jobs manager window.
View, print and manage your backup logs and
reports.
Run the Genie Backup Manager monitoring agent in
the system tray.
Quick-erase or fully format CD/DVD media.

Advanced Search
Jobs Manager
Logs Manager
Start GBM Agent
Format Re-Writable
CD/DVD
Undo Plugin Restore
GenieScript Compiler
Global Preferences

Help

Contents
Welcome Screen
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Uninstall programs previously restored using My
Plugins.
Open the GenieScript script compiling utility.
Open the Global Preferences window to edit general
and advanced Genie Backup Manager settings.
Open the Genie Backup Manager help
documentation.
Open the welcome screen.

The Main Window

Supported Recorders
Genie9 Home Page
Check for Updates
About
Registration
How to register
Technical Support Contact Us
How-To

Opens your default internet browser to the GenieSoft web site.
Credits and basic information about the product.
Open the Genie Backup Manager registration dialog
to enter your serial number and unlock the software.
Open help page on how to register your copy of
GBM.
Contact information for getting in touch with GenieSoft support team to receive technical assistance.
A list of links to the most important how-to help
pages.

To access a program menu item using the keyboard
1. Press <ALT>. This will highlight the File menu in the toolbar.
2. Use the right and left arrow keys to move horizontally between menus and the up and
down arrow keys to move between items inside each menu.
3. Press <ENTER> to activate the selection.

Backup Summary
The backup summary panel displays a summary report for the most recently performed backup.
It also offers quick access links for viewing the complete backup report as well as re-running the
backup.

The Backup Wizard
Users can create backup jobs in Genie Backup Manager using
These are the steps that you must confirm in the backup wizard:
Backup Category: Choose what type of data you Wish to backup; data, Microsoft SQL, or
Microsoft Exchange Server
Jobs info: Enter the name of the backup in the Backup Job Name field. You can select Edit
existing backup job to select a previously created backup job and modify its configurations.
To create a shortcut on the Desktop area for quickly running a backup job, select Create quick
backup shortcut on desktop. Click Backup Filename Options if you wish to append a time
stamp to the end of the output backup archive. Click Next to go to the following step.
Where to backup: Select the storage device on which you wish to store your backup. Checking
the radio button next to the desired backup destination option will display a group of settings
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related to that destination in the lower box. Click Next to go to the following step. See Backup
Devices.
What to backup: Select the files and folders you wish backup. User data is divided into three
categories to make it more manageable during backup and restore: My Profile, My Folders,
My Plugins, My SQL, and My Exchange. Click Next to go to the following step. See Data,
Microsoft SQL, and Microsoft Exchange Server.
Backup Settings: Sets advanced options, including: data backup type, compression, security,
purging, email notifications, self-restorable backups, pre and post job commands etc. Click
Next to save the configurations and start backup.
Scheduling or CDP: At any point during backup job creation, you can click Schedule step 5, to
schedule the backup job for unattended executions. See Scheduler, CDP for SQL, and CDP for
Exchange.
Backup Progress: In this screen, backup progress displays the status of the backup job. See
Backup Progress
Genie Backup Manager provides a dynamic summary of information about the backup job at the
bottom-left corner of the backup wizard, which can be consulted before the backup execution.
Clicking the Main page button returns the user to the main application window without saving
the backup job configuration progress; a warning message will be displayed to the user..
To save the configuration during backup job creation without exiting the wizard or starting
backup, click Save Job.

Opening the Backup Wizard



From the startup screen click the Backup button.
From the Files menu, select Backup Wizard.

For each backup job you must specify at least the source files, folders, or other data items that
you want to backup (third wizard step), the rest of the options are not mandatory as they are
set to default values, but can be changed by the user.
The user can move between the wizard screens using one of the following ways:
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Clicking the Next button in the lower right corner, to go through all the wizard screens
one at a time. Clicking the Previous button takes the user one step back.
By choosing the desired wizard screen from the Backup Steps menu on the left side of
the screen. This allows the user to skip steps that have been set before.

The Main Window

The Restore Wizard
Using the Restore Wizard you can restore from a backup job. The restore wizard consists of
two steps (pages), from which users can configure what and how to restore. To open the restore
wizard select click the Restore button from the main window, or select the Files menu, then
select Restore Wizard.
These are the steps that you must confirm in the restore wizard:
1. Select a file to restore (loading the backup): Select the backup archive you wish to
restore data from.
2. Data Selection: Select the files and folders you wish restore.
3. Next: On the data selection page, click Next to start restore.

The Disaster Recovery Wizard
Users can create Disaster Recovery in two main steps:
1. Create Disaster Recovery Bootable Disk (One time only)
2. Create Genie Disaster Recovery Backup

Opening the Disaster Recovery Wizard



From the startup screen click the Backup button.
From the Files menu, select Disaster Recovery Wizard.

The user can move between the wizard screens using one of the following ways:




Clicking the Next button in the lower right corner, to go through all the wizard screens
one at a time. Clicking the Previous button takes the user one step back.
By choosing the desired wizard screen from the GDR Steps menu on the left side of the
screen in the Disaster Recovery backup job. This allows the user to skip steps that have
been set before.

Global Preferences
Global Preferences
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The Preferences window houses the settings, preferences and configurations for GBM.
To open the Preferences window, do one of the following:




From the toolbar click Tools, then select Global Preferences.
From the Tools left-hand menu in the main screen, select Global Preferences.

Note: Settings selected from the preferences dialog will apply to all created backup jobs.

Preferences: General
The General page of the Global Preferences window (accessible from the Tools menu, Global
Preferences menu item) contains general settings of the program.

Auto Update
Select the frequency at which GBM should automatically check for software updates. (This option
is only available for registered users). (Settings)

Do not automatically check for updates, the user will do so manually.

Check for updates every week.

Check for updates every month.

Confirm quit dialog box
Causes GBM to prompt the user to confirm before closing the main application. This option is
only available for registered users.
Associate the extension "gbp" with GBM in Windows
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Associate the extension ( .gbp) with Genie Backup Manager in Windows; clicking a file with
".gbp" extension will automatically load the backup and open the restore wizard within Genie
Backup Manager.
Save Window location on exit
Remember the size and location of the GBM main window the next time it is run.

Temporary files folder
Specify a local folder for storing temporary files created by GBM during its various operations,
See Files Created by GBM Locally. (Settings)

Auto select temporary location
GBM will scan local drives for the drive with the most free disk space and select it for
storing temporary files.

Use the following temporary location
Select a custom temporary folder (Make sure the drive contains enough free disk space).

Global Preferences: General - Advanced
The Advanced page of the Global Preferences window (accessible from the Tools menu,
Global Preferences menu item) contains advanced settings for the program.
Backup Performance
Change Backup performance for jobs to either run Faster backups or reduce impact of backup on
your computer
Enable Advanced logging for debugging
Enable advanced logging. Used for trouble shooting purposes by the Genie9 technical support
team.
Open GBM advanced logs folder
Open the folder containing Genie Backup Manager's advanced debugging logs.
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Global Preferences: General - Sound Alerts
The Sound Alerts page of the Global Preferences window (accessible from the Tools menu,
Global Preferences menu item) contains settings related to attaching sounds to various events
in the program.

Enable Sound Alerts: Enable associating sounds with Genie Backup Manager events.
Events: List of GBM events that the user can add sound alerts to.
Attach sound to selected event: Enable sound alert for the selected event.
Browse: Browse your computer to select a sound file to be associated with the selected event.
Play: Listen to selected sound file.

CPU
The CPU page of the Global Preferences window (accessible from the Tools menu, Global
Preferences menu item) contains settings related to CPU utilization management.
When you launch Genie Backup Manager, the system by default enables all processors (CPUs)
for its execution. CPU Affinity allows you to select what CPU(s) Genie Backup Manager can use
while running.
If you notice that Genie Backup Manager uses CPUs a lot, you can limit its execution to only one
processor for example. To do this, select/deselect desired processor(s) with checkboxes in the
dialog. Execution of GBM on all non-selected CPUs will be disabled.
CPU Affinity is available on multiprocessor systems only.

Preferences: Backup Settings
The Backup Settings page of the Global Preferences window (accessible from the Tools
menu, Global Preferences menu item) contains settings related to backup operations.
Always display backup log: Automatically display the backup activity log after each backup
run.
Always display backup summary: Automatically display summary of results after each
backup run.
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Automatically close Outlook Express before backup: Close Outlook Express before each
backup run, to avoid running into locked files during backup. (Settings)

Keep trying for X mins
Specify how long GBM should wait for Outlook Express to close before aborting backup.

Reopen Outlook Express after backup
Reopen Outlook Express when backup is complete.

Automatically close Outlook before backup: Close Outlook before each backup run, to avoid
running into locked files during backup. (Settings)

Keep trying for X mins: Specify how long GBM should wait for Outlook to close before
aborting backup.

Reopen Outlook after backup: Reopen Outlook when backup is complete.

Show hidden files/folders in "My Folders": Display and allow selection of files with
hidden/system attribute in the file selection panes in My Folders.
After verification wait X secs then start backup automatically: After GBM confirms
selections, wait X seconds before starting backup.
Default backup destination: The default folder used for storing backups when a new backup
job is created.

Preferences: Backup Settings - Advanced Settings
The Advanced Backup Settings page of the Global Preferences window (accessible from the
Tools menu, Global Preferences menu item) contains advanced backup-related settings.
Preserve Alternative Data Streams (ADS): Preserve NTFS Alternative Data Streams even
when data is backed up to a non-NTFS partition.
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Enable one file self-restorable backup: When self-restorable backup sets is enabled with
compression and the size of the data after compression is less than the amount specified, the
entire backup set will be contained within a self-executable file (.exe). Otherwise, the self
executable file will be copied as a separate file on the backup destination.
Rename unicode files: When a filename is in unicode, rename the file using a unique GUID, to
avoid problems restoring the data on platforms that do not support unicode character sets. GBM
will rename the file to its original name upon restore.
Backup ACL (Access Control List): Backup Access control list that specifies permissions when
sharing.

Global Preferences: CD/DVD Settings
The CD/DVD Settings page of the Global Preferences window (accessible from the Tools
menu, Global Preferences menu item) contains options pertaining to writing to optical media.
Cache disc image before burning : This option increases the reliability of backup to CD media
by creating a temporary file on the hard disc that is then written at once to disc. Caching,
however, means that GBM will first copy the data to a temporary local drive and then onto the
CD, which adds a few minutes to the total running time for each disc.




Caching is not supported on DVD or blu-ray
If GBM doesn't detect enough space to perform caching, data will be copied directly to
the CD.

Finalize disc (No further writing to the disk is possible): Close the CD/DVD media so that
further writing to it is not possible. This is done by not recording the next writable address in the
last session's lead-in, so that in the next time the recorder attempts to write, it has no way of
knowing where to begin writing. Only finalize CDs if you are sure that you will not be appending
new backup versions to it.
Import previous sessions on disc: If the CD contains more than one session, the most recent
session is automatically imported so that it could be updated with the new data.
Each time data is written to a CD/DVD disk a table of contents is written at the end of the
session in order to make the disk readable. This procedure is called session closing; data can still
be appended to the disk after a session is closed.
Genie Backup Manager will by default import previous sessions on the inserted disc before
writing to it so as not to lose existing data.
Disabling this feature causes GBM to write a new table of contents that does not refer to
previously written data on the disc, rendering that data hidden and inaccessible, but it will not
free the space occupied by it.
If a file with the same name as the backup file already exists on the CD, GBM will rename the
new file by appending a trailing number, that is incremented by one for each new version of the
file that is added.
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Rename archive if a file/folder with the same name exists: This option prevents accidental
overwriting of previous backup jobs stored on the CD/DVD in case a file with a similar file name
already exists on it.
Eject the last backup disk after finishing
When backup to optical media is performed, eject the last disk in the media set to alert user that
backup is finished.

Global Preferences: Open File Backup
The Open File Backup page of the Global Preferences window (accessible from the Tools
menu, Global Preferences menu item) contains options related to handling open files during
backups.
Disable Open File Backup
Disable using Open file backup to handle backing up open files
Use Volume Shadow Copy (fully integrated)
Allow Volume Shadow Copy service to copy open files during backups.

Preferences: Restore Settings
The Restore Settings page of the Global Preferences window (accessible from the Tools
menu, Global Preferences menu item) contains settings related to restore operations.
If a file being restored exists in the destination folder





Do not replace existing file
Replace if restored file is new
Always replace files

Instructs GBM what to do when a file with the same name as the one being restored exists in the
destination folder.
Always display log after restore
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Automatically open the restore log after each restore job.
Restore file modified dates and attributes
Remember each backed up file's attributes (hidden, read-only, system, archived) and modified
date and time stamp, to insure they are retained when files are restored.
Outlook restore settings
Settings to be used when restoring Microsoft Outlook data. (Settings)
Outlook default data files location
Always restore Outlook file to the default Outlook PST storage folder.
(Typically Drive:\Documents and Settings\%User name%\Local Settings\Application
Data\Microsoft\Outlook)
Custom location
Restore Outlook files to a folder selected by the user.
Apply to all backup jobs
Apply selections made in this dialog to all restore jobs.

Global Preferences: Testing Data Integrity
The Testing Data Integrity page of the Global Preferences window (accessible from the
Tools menu, Global Preferences menu item) contains settings defining how Genie Backup
Manager verifies the reliability of produced archives after backup.
Automatically test data after backup
Run data integrity test automatically after backup is complete.
Ask me
Prompt me for action after backup is finished.
Do not test
Do not perform data integrity testing after backup.
Test only new and changed files
When performing increment, mirror or differential backups, verify only files that have been
newly appended to the backup set.
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Global Preferences: Email Notification Settings
The Email Notification page of the Global Preferences window (accessible from the Tools
menu, Global Preferences menu item) contains the mail server settings GBM uses for sending
notifications of performed backups via email.
SMTP Server
SMTP server hostname or IP address.
Port
SMTP port number. Default value is 25.
SSL
SSL (Secure Sockets Layer) is a security protocol that provides communication privacy. Select
this option if your SMTP server supports SSL.
From:
Email address to appear in the sender (From) line.
To:
Email address of the recipient of the notification.
Subject
Text to appear in the Subject line of the notification email
Attach backup log
Select this option to include the backup log with every notification email.
Configuration
Open a dialog for configuring advanced email sending options. (Controls)
Authentication method:
By default, SMTP clients send the password to the server in an insecure format; which
may be undesirable in some cases. GBM provides the following secure login options to
avoid sending the password insecurely:





NONE: Sends the password to the server in an insecure format.
AUTH LOGIN: Most common authentication method.
CRAM MD5: (Challenge Response Authentication Mode), most secure
authentication method.
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LOGIN PLAIN: Moderate security.

Auto connect to internet
If no connection to the internet is already active, automatically connect to the Internet
using the default connection.
Bind to:
If your email server uses IP Binding, select a specific IP from the list. Default setting is
"Any-IP-Address".

Send dummy notification email to test the entered settings

Global Preferences: Auto-Exclude
The Auto-Exclude page of the Global Preferences window (accessible from the Tools menu,
Global Preferences menu item) contains settings for automatically ignoring specific files and
folders during backup.
Some system files and folders on the computer are not made to be moved or copied, and are
accessed only by the Windows system, trying to backup these files will cause an error in GBM.
To avoid running into backup problems, GBM by default skips these files and folders in all the
backup jobs created by the user. This preferences window enables the user to add/remove files
and folders from the 'Auto-Exclude' list.
Enable auto-exclude
Automatically exclude the files and folders specified in the list whenever a backup is performed.
Remove
Remove an item form the list.
Add...
Add an item to the auto-exclude list.

Global Preferences: Cataloging
The Cataloging page of the Global Preferences window (accessible from the Tools menu,
Global Preferences menu item) contains settings related to the cataloging feature of the
program.
Enable Cataloging
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Allow GBM to create a library containing history of backup jobs/runs.
Access restore-wizard even when media set is not loaded
Enable user to choose a backup set from the catalog and open it within the restore
wizard, to browse and select files for restore, even if the media set is still not loaded.
Read index from catalog (Enable changing storage location)
Allow GBM to do an increment, mirror, or differential backup run by referring to the
backup job index saved in the catalog, instead of the one on the storage media. This is
needed when the user is trying to store the data from a new backup run on a new media
volume, other than the one containing the data from the previous run.

The Catalog
The Catalog
The Catalog is a library containing a list of all defined backup jobs and the files backed up
during each job's executions. With this utility, users can keep track of file versions, and run,
view search for and extract files directly from the backup archive without going through the
restore wizard.
For each new execution of a backup job, Genie Backup Manager creates a new subfolder in a
folder carrying the same name as the backup job (usually in C:\Documents and
Settings\<user>\Application Data\Genie-Soft\GBMAPPLICATION\), starting with a folder named
"00000000" for the first backup execution, and a new folder with the name incremented by one
for each subsequent run. Each folder contains catalog information for the corresponding backup
execution, which Genie Backup Manager refers to, to populate the catalog window.
To access the catalog click the Catalog button in the main window, press <Alt+C>, or select
Catalog from the File menu.
Although highly not recommended, users can disable cataloging if they feel that they will not be
benefiting from this feature, and wish to spare the small amount of disk space that would
otherwise be consumed by the catalog files. This can be done by clicking the Tools menu,
selecting Global Preferences, selecting Cataloging, and unchecking the box next to Enable
cataloging. Note that doing so will prevent Genie Backup Manager from writing catalog
information locally, thus loosing all historical data related to backup executions, and the ability
to browse, search, extract, view, or run backed up files, unless restored first.

Using the Catalog
Backup jobs are listed in alphabetical order in the left pane of the catalog window. Expanding the
tree beneath a backup job displays its versions ordered according to the date and time on which
they were executed. Users can expand the tree under any backup version to view detailed
information about the files that were backed up. The following filters can be selected: All files,
New files, Unchanged files, Modified files, and Deleted files. Clicking on one of the filters
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displays the results in the right pane. The following columns are available in the file list view,
which can also be used for sorting:





Filename: name of listed file.
Size: size of listed file -before compression if backup set was compressedDate Modified date of the most recent change made to the file before it was backed up.





GBM Data Type: My Profile, My Folders or My Plugins.
Extension: the filename extension (file type) of the backed up file.
Original Path: the original path in which the backed up files was located.

The user can further refine the list of results by typing a filename mask in the Filter by field
above the results pane. For more advanced file searching options, see Advanced Search.

Right-Click Options
Right clicking an object from the panes in the Genie Backup Manager Catalog will open a menu
with options related to the clicked item.
Right-Clicking a Backup Job:





Delete Job: Delete all catalog entries for the currently selected job.
Expand All: Fully expand the tree beneath the selected backup job.
Collapse All: Collapse the tree of backup runs below the selected backup job.

Right-Clicking a Backup Run:






Restore: open the restore wizard to restore data from the selected backup run.
Show log: Show backup log for the selected backup run.
Delete: Delete the catalog entry for the selected backup run.
Delete All: Delete all catalog entries for the currently selected job.

Right-Clicking a File:








Restore selected file: Extract the selected file to a location specified by the user.
Restore checked files: Restore all files with ticked checkboxes to a location specified
by the user.
Mark all: Mark all files as selected.
Clear all: Deselect all files.
Run selected file: Open selected file using the application associated by Windows with
its file type.
View with Notepad: View selected file using Notepad.

Advanced Search
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The file Search dialog offers the most direct way to locate a backed up file. Use the Search
dialog if you are looking for common file types, if you remember all or part of the name of the
file you want to find, If you recall the size of the file you wish to locate, or if you know when you
last changed a file. The Search dialog can search within all performed backup runs to locate all
revisions of a file or files.
To open the advanced search dialog from the catalog window, click the Advanced Search link
the upper-right corner.
You can write the name of the file you wish to locate directly in the Search for field. If you
know only part of the name, you can use wildcard characters to locate all files that include that
part in the name. For example, *map.* will find "road map.jpg", "tech map.doc", and "tech
map.txt". You can also search for files which names contain a sequence of adjacent letters. For
example, ost will find "most wanted.doc", "host.txt", and "outlook.ost".
You can instruct Genie Backup Manager to look for your file either in a specific backup archive,
or in all the archives created by currently configured backup jobs, by selecting one of the
following options from the Search in drop-down menu.







Selected Backup Run: Search for file within the highlighted backup run.
Selected Backup Job: Search for file within the selected backup job.
All Jobs: Search the entire catalog.
Browse for Backup Job: Open a list of backup jobs/runs to choose from
Browse for Backup File: Specify a backup set to search within, useful when there is no
catalog entry is available for that backup set.

The GBM data type menu enables you to refine your search by specifying whether the file you
are searching for belongs to a My Profile item.
You can use additional search criteria to make your search more specific by clicking the More
choices tab, this will enable you to refine your search according to the size and/or "last
modified date and time" attribute of the file(s) you are looking for.

How to: Back up the Catalog
The catalog allows you to save job preferences, settings, and backup information. The size of the
catalog varies depending on the number files taking from backup
To backup the catalog
1. From the left navigation menu in the backup wizard select What to Backup.
2. Select My Plugins tab.
3. Select GBM 9.0 Preferences, Jobs, Scripts and Catalogs.
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The Where to Backup wizard screen defines where the backup will be stored. To choose a
storage device during backup job creation/editing select Where to backup from the left
navigation menu in the backup wizard. Make sure you can write in the destination and the
selected folder (you have the proper rights and the media is not write-protected).
GBM is the only backup software that grants users the flexibility of choosing between all the
following storage destinations without the need for purchasing and installing extra plugins or
add-ons:









External and Internal hard disks.
Across network (Shared network locations, SAN devices, NAS devices, etc.).
Memory Sticks (Flash memory).
CD/DVD/Blu-ray media (all formats - DVD±RW/DVD±R/DVD-RAM/CD-R/CD-RW, Bluray).
Removable media devices (REV, floppy disks, ZIP disks, JAZ etc ...)
Remote locations using FTP/FTPS service.
Amazon S3 Storage

For each backup run, a new index (".gbp file") is created in the destination folder, containing the
backup job's catalog as well as other information necessary for Genie Backup Manager to be able
to restore data automatically. If this file is lost, GBM will not be able to restore data, and the
user will only be able to manually access the files and folders stored in the archive. The catalog
is also stored locally to enable offline browsing of the data stored in the backup (even if the
storage media is not loaded), as well as file versioning information.
If the backup destination drive/device is missing or disconnected when backup starts, Genie
Backup Manager will display a warning message saying that there is not enough space on the
destination, and backup will be aborted.
Note:
In easy mode, backing up to Local/LAN is only supported

Internal and External Drives
Internal and External Drives
Genie Backup Manager allows users to backup data to hard disk drives of all kinds, whether
internal or external (hard drives, USB drives etc.). In addition, GBM enables users to select more
than one hard disk as a backup destination; if one hard disk gets full, GBM will automatically
continue backup to the next hard disk specified in the multi-drive spanning list. The Local/LAN
option is selected by default when you define a new backup job, and data is backed up to the
default backup destination as specified in the Global Preferences window.
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To backup to an internal or external hard drive during backup job creation or editing, select
Where to Backup from the left-hand menu, then select Local/LAN location.
If the backup destination drive/device is missing or disconnected when backup starts, Genie
Backup Manager will display a warning message saying that there is not enough space on the
destination, and backup will be aborted. Users can avoid this using either the Multi-Drive
Spanning, or the Backup Transfer Method features.
If the desired location is not visible in Windows Explorer, users can also type the backup
destination path directly in the box.
Note:
You can also backup USB attached external drives using Removable media option as it is
automatically detected.

Multi-Drive Spanning
Multi-drive spanning allows Genie Backup Manager to treat multiple disk drives as one during
backup.
Many people have more than one partition defined on their hard drive, others have more than
one drive that they use to store backups on. Most backup solutions allow the user to select only
one partition/drive as a target for storing data for each backup job, when that drive is full,
backup will cease to run, unless the user manually frees more disk space, or automatically sets
the software to erase the contents of the media. Genie Backup Manager offers a novel way for
handling these scenarios, using multi-drive data spanning.
Multi-drive spanning is a feature that enables users to divide backed up data onto more than one
local/LAN location, this includes multiple partitions, hard disks, shared and mapped networked
locations, SAN and NAS devices etc.
Multi-drive spanning locations can either be preset, i.e. the user gets to predefine an ordered list
of storage locations for GBM to use. Or, the user can set GBM to prompt him for a new location,
once the drive currently being used is full. This feature is disabled by default.
Selecting Repeat, causes Genie Backup Manager to cycle through the list of backup devices,
such that when the last destination in the list is full, GBM will re-attempt to backup on the first
destination, and then the second, and so on.
Enabling multi-drive data spanning:
To allow GBM to span backed up data onto more that one local/LAN location:
1.
2.
3.
4.
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Select Allow multi-drive spanning.
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Use all available Space: Write until current location is full before moving on to
the next one.
 Use fixed split size: Use a fixed amount of disk space from the current location
then move on to the next one, even if the previous one still has free disk space.
6. Click Auto spanning drive List to create a list of predefined locations for GBM to use.
If no list is defined, GBM will prompt the user to enter a new backup location once the
one currently being used is full.

Tip:
Use Read index from catalog to enable GBM to perform incremental or differential backups without
the need to reload the previous backups

Splitting Backup Files
Using the new 64-bit Zip compression, Genie Backup Manager compresses backed up data to
one file that can reach up to about 18 million terabytes in size ( more precisely, 264 -1 bytes) provided that this is supported by the file system being used - However, the user might want to
split the compressed backup file into multiple smaller chunks, for instance in order to copy them
later to removable media, or when the file system, such as FAT 16, does not allow creation of
large files etc.
GBM can split the backup set into multiple linked files with sequentially numbered extensions
(e.g. .001 .002 .003 etc ...) with the last file in the series assigned the main (.gbp) extension.

To split backup files:
1.
2.
3.
4.

From the left navigation menu in the backup wizard select Where to Backup.
Select Local/LAN Location.
Select Enable multi-drive spanning.
Select Use fixed split size, then enter the desired split size value.

How to: Restore from a Local Drives
Restoring data from backups stored on local hard drives is straight forward.
1. Make sure that the drive on which your backup is stored is attached to the computer and
accessible from Windows Explorer.
2. Open the folder holding the backup on your device.
3. Double click the main "gbp" file corresponding to the backup set you wish to restore data
from.
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Network locations
Backup to Network Locations
Genie Backup Manager allows backing data to LAN-connected devices (Local Area Networks),
these include shared network folders, mapped networked drives, SAN devices, NAS devices
etc...
To backup to a networked device or location during backup job creation or editing, select Where
to Backup from the left-hand menu, select Local/LAN location, click Browse, then select My
Network Places or type the full path to the backup destination.
If the backup destination drive/device is missing or disconnected when backup starts, Genie
Backup Manager will display a warning message saying that there is not enough space on the
destination, and backup will be aborted. Users can avoid this using either the Multi-Drive
Spanning, or the Backup Transfer Method features.
If the desired location is not visible in Windows Explorer, users can also type the backup
destination path directly in the box, e.g. "\\Server\shared documents".

Backup from Network Locations
Genie Backup Manager users can backup data from shared folders on networked devices. To do
so select What to Backup from the backup wizard, click My Folders tab, from the folders view
pane select My Network Places, then select the folder(s) you wish to backup. If the desired
location is not visible in My Folders, use the manual files selection feature to enter the path to
the data location manually.
If the desired network location is a mapped drive/folder, simply browse to the drive letter
assigned to it from the folders view pane to select the data for backup.

Tip
On a Microsoft Windows Network if you share a folder that has a dollar sign '$' at the end of its
name, then it is considered to be hidden and other machines cannot see it, unless you explicitly
enter its name in the address bar or the command prompt. Users can add this kind of sources by
manually typing the complete path in the Manual File Selection panel. To add a new item, click Add,
then type the full path to file or folder. Select Include sub-folders if you wish child folders to be
included in backup.
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How to: Restore Data Stored on Network Locations
1. In the main screen click Restore.
2. Click Select Backup Set.
3. Browse to the location of the backup set and select the ".gbp" file corresponding to the
backup version you wish to restore, then click Open.
4. Click Next.
5. Continue with restore.

Remote Locations Using FTP/FTPS
FTP/FTPS Servers
Genie Backup Manager allows users to perform backup operations to any FTP server connected
to the Internet by simply entering the server's address and authentication. Genie Backup
Manager will create a local temporary copy of the backup, then "push" a data stream that can be
compressed and/or encrypted to the designated FTP server. This feature will allow you to easily
store data offsite or perform centralized backups for remote client data.
To perform FTP/FTPS backup, select Remote Location Using FTP/FTPS from the Where to
Backup page in the backup wizard. Available space on FTP server will not be
calculated/displayed during backup. You will need to make sure the FTP account you are using
has enough disk space.

If the connection is dropped or interrupted, or if there was no upload activity for a considerable
period of time during backup to a remote FTP server, GBM will pause the upload and retry to
reestablish connection (if possible) then resume from the broken point; GBM repeats these steps
until the entire backup is uploaded or the number of retries specified by the user are exceeded.
Users can modify the number of auto-resume retries from the Advanced Settings dialog.
Users can restrict the transfer rate at which GBM uploads data to the FTP server during backup,
so as not to "hog" the connection's bandwidth from the Advanced Settings dialog.

Limitations of FTP Backup
When FTP backup is selected, the following GBM features are not supported.






Purging old backup files.
Incremental backup without rollback.
Mirror backup.
Extracting from Catalog

Tip:
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You can rotate backup types via scheduling, for more information, please refer to How to: Schedule
Rotating Backup Jobs

FTP/FTPS Backup Settings
The FTP backup settings dialog allows access to advanced FTP connection settings that users can
customize for optimized performance and compatibility with the FTP server.
To open the advanced FTP Backup settings dialog, select Where to Backup from within the
backup wizard, select Remote location using FTP/FTPS, then click Advanced Settings.








Protocol: Select whether to use FTP, Secure FTP (FTPS) Implicit mode, or explicit mode.
Address: Name or IP address of FTP server.
Port: FTP server port number. Default value is 21 for non-secure transmission.
User: Username for the FTP access account.
Password: FTP access account password.
Backup Directory: Path to which the backup should be stored on the server. If path
does not exist, GBM will create it.

Test Connection: Perform a test connection to the server, to check that the entered settings
are correct.
Advanced Settings: Advanced FTP settings. (Controls)
Passive mode:In passive mode, your computer establishes the connection. This may be
necessary with some firewalls that don't allow establishing a connection from outside.
Use pre-configured settings:Get settings from the machine, for example: "proxy
settings" from the control panel.
Limit Speed (Kb/s): Used to throttle bandwidth during upload. enter 0 for GBM to
utilize maximum available bandwidth.
Connection Timeout: Idle time (no activity) before connection is dropped . Default
value is 30 seconds.
Use FTP Proxy: Enable connecting to FTP server through a proxy. The FTP proxy server
is an application level gateway that sits between a computer and the Internet. They are
used by companies to provide security and/or restrict access.
Address: Host name or IP address of proxy server.
Port: FTP Proxy server port.
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Server requires authentication: Enable passing a username and a password to
the proxy server for authentication.

How to: Restore Data Backed Up Using FTP/FTPS
GBM currently does not support direct data restore from FTP/FTPS sites. In order to restore
backed up data, the user needs to first download the backup files from the FTP/FTPS server
using either an Internet browser, or a third party FTP software. It is recommended to use third
party FTP software to download the backup set for better reliability and speed.

Restoring from FTP Using the Default Internet Browser
1. Open your default Internet browser.
2. Login to the FTP site containing your backed up data by entering its URL into the address
bar in the following format:
ftp://[username]:[password]@[ftpsiteaddress]
Where:





[username] is the username of the FTP account used for uploading files.
[password] is the password for the FTP account used for uploading files.
[ftpsiteaddress] is the address for the FTP site used for uploading files, including
the complete path to the location of the backup set.

E.g.
ftp://sam:mypassword@my.ftp.site.com/genie/monday/
3. Locate the backup set and then Copy/Paste it onto your hard disk.
4. Follow the local restore procedure.

Restoring from FTP Using Third Party Software
1. Use a third-party FTP software to download the complete backup set onto your hard
disk.
2. Follow the local restore procedure.

Amazon S3
Amazon S3
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GBM allows you to backup online to the robust cloud infrastructure of Amazon's Simple Storage
Server (Amazon S3). To use this feature you will need to purchase an account from Amazon
Amazon S3 Settings:
Access Key ID: An alphanumeric text string that uniquely identifies user who owns account.
This information is listed under Security Credentials under your amazon account
Secret Access Key: This serves as your password. This information is listed under Security
Credentials under your amazon account
Bucket Name: It can be any directory created at the root level of your online storage.
Backup Directory: Where you would like to store your backups. Please make sure that you
have enabled access permissions to the folder
Test Connection: Perform a test connection to the server, to check that the entered settings
are correct.
Advanced Settings: To limit bandwidth, backup to Reduced Redundancy Storage, and for
Server Side Encryption support. (Controls)
Limit Speed (KB/s): Used to throttle bandwidth during upload. enter 0 for GBM to
utilize maximum available bandwidth.
Enable Amazon Server Side Encryption (SSE): Used to enable AES encryption on
Amazon's cloud storage
Use Reduce Redundancy Storage (RRS): A cheaper alternative that provides
99.99% durability and to sustain the loss in a single facility instead of
99.999999999% durability and to sustain the loss in 2 facilities.
Notes:






To backup to Amazon S3, you will need to purchase an account. To do so, please visit
http://aws.amazon.com/s3/
You will need to create a bucket at the root directory and add the backup directory inside
of it
Purging is not supported, to rotate backup types, please use the advanced scheduler.
Mirror and increment with rollback disabled is not supported with Amazon S3 backup.

Backup to Amazon S3
Setting Genie Backup Manager to perform backup:
1. Make sure you have an Amazon S3 account.
2. From the backup wizard, select Where to Backup.
3. Select Amazon S3.
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4. Enter your Amazon S3 credentials
 Access Key ID: An alphanumeric text string that uniquely identifies user who
owns account. This information is listed under Security Credentials under your
amazon account
 Secret Access Key: This serves as your password. This information is listed
under Security Credentials under your amazon account
 Bucket Name: It can be any directory created at the root level of your online
storage.
 Backup Directory: Where you would like to store your backups. Please make
sure that you have enabled access permissions to the folder.
5. For secure data transmission, check SSL
6. To limit upload bandwidth, backup to Reduced Redundancy Storage, and for Server Side
Encryption support, click Advanced Settings
7. Click Next to proceed with the Wizard
Notes:






To backup to Amazon S3, you will need to purchase an account. To do so, please visit
http://aws.amazon.com/s3/
You will need to create a bucket at the root directory and add the backup directory inside
of it
For secure data transfer, please enable SSL
Purging is not supported, to rotate backup types, please use the advanced scheduler.

How to: Restore/View Backups from Amazon S3
Genie Backup Manager currently supports backing up to Amazon S3 storage. To restore:
1. Download the backup using any third party application.
2. Open the Restore Wizard and browse for the last .gbp file created in the backup set
3. Proceed with the wizard

How to: Delete backups off Amazon S3
GBM currently does not support deleting Amazon S3 backups. However, if you wish to delete
backups manually, please make sure to delete the entire backup set (full backups +
incrementals). In addition, please make sure to delete its corresponding backup information
using "Delete job" option in the catalog
To learn more on how to delete backup sets, go to Understanding Backup Sets and Purging

Optical Media
Optical Media
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Genie Backup Manager can write to CD/DVD media of any format (DVD±RW/DVD±R/DVDRAM/CD-R/CD-RW), including double layer DVDs and Blu-ray, using both built-in burning
capability and packet writing - with the aid of third party software -.
To set Genie Backup Manager to backup to a CD/DVD drive, select Where to Backup from the
left-hand menu, select CD/DVD media, then select the drive letter of the recorder you wish to
use.
You can backup an unlimited amount of data to CD/DVD media even if one disc does not have
sufficient space to hold all the data, since GBM will by default divide your backup into several
discs (automatic disk spanning), and all you need to do is to replace discs when prompted to do
so.
Genie Backup Manager will by default use the entire amount of empty space available on each
inserted disk during backup, you can select Use fixed split size to instruct GBM to only fill up a
fixed amount of space on each inserted disc. Make sure to leave some space as a safety margin
for the table of contents that will be written to close the disc session.
If GBM fails to write to disc or is interrupted during the process, the user will be given the option
to retry by inserting a new disc, or to cancel the operation.
Genie Backup Manager checks the integrity of data written on each disc in the backup set
immediately after the disc's session is closed. If the data is corrupt, GBM will ask the user
whether to proceed with backing up the rest of the data (in the case of automatic disc spanning)
or cancel the backup task.
To prevent GBM from verifying data integrity after writing to a CD/DVD, uncheck the option
Verify data after backup in the disc burning progress dialog that appears during backup.
GBM by default uses the maximum speed supported by both the recorder drive and the inserted
media for burning, however, for trouble shooting purposes the user can select a custom writing
speed by clicking Advanced Settings. If no disk is inserted in the drive, GBM will load the list of
speeds supported by the recorder drive, inserting a disk in the drive would cause GBM to load
the list of speeds supported by both the recorder and inserted media.
Note
Blu-ray is only supported on Windows Vista and Windows 2008 Server and above

Disc Recording Options
Disc Recording Options
Genie Backup Manager uses two methods for writing a CD/DVD disc: The built-in burner and
Incremental Writing (AKA Packet Writing) using third party software.
Track-at-Once recording is what most recorders and software support today, and is the built-in
default CD/DVD recording method used in Genie Backup Manager, which means that you do not
need to use third party software to use it for writing data to optical media. Track-at-once
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burning does not allow manipulation of individual files after they have been written to disc, and
thus, only supports full, incremental with rollback, and differential backup types. Purging old
backups is also not supported.
Packet writing on the other hand lets you treat an optical disc as though it were a big floppy
disk, allowing in the process for the deletion and replacing of individual files, thus supporting all
backup types, including incremental without rollback and mirror (as long as data is not divided
over multiple discs). However, Genie Backup Manager supports this recording method only
through the use of third party software.

Built-in burner vs. packet writing.
Issue

Track-at-Once

Packet Writing

Speed

Slower.

Faster (Except when backup without
compression is used).

Compatibility

Readily readable on most drives.

In most cases the packet writing
software used to write the data must
be installed in order to read from the
disk.

Incremental &
Mirror Backup

Rollback forced. Mirror backup not
supported.

Backup with rollback option disabled
is supported (new versions of files
overwrite old versions). Mirror
backup supported.

Purging old
backups files

Not supported.

Supported as long as data is not
divided over more than one disk.

Availability

Built in.

Must use third party packet writing
software.
Note: Default Windows XP writing
component does not use packet
writing.

Disk space
utilization

More disk capacity.

Pre-use formatting Blank disks need not be formatted
before usage. Disks previously
written to using packet writing
software must be fully erased:
Tools > Format Re-writable CD
> Full Format.

Less disk capacity; Packet Writing
consumes more space on disc.
All disks must be formatted at least
once using the third party software,
to become compatible with packet
writing.
Note: Disks formatted using one
packet writing software must be
reformatted before being used with
another.

Using the Built-in Burner
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The built-in CD/DVD burner in Genie Backup Manager can write to almost all optical media
formats, including the new dual-layer DVD and Blu-Ray technologies; no third party software is
required.
To set GBM to backup to optical media using the built-in burner:
1. From within the backup wizard select Where to Backup.
2. Select CD/DVD media
3. Make sure Use packet writing Software is not selected.

Incremental Writing (Packet Writing)
If your CD/DVD device is not compatible with Genie Backup Manager, or if you wish to use
backup types not supported by GBM's built-in burner, you can use third party packet writing
software.
Packet writing is a term for software that lets you record data onto an optical disc directly from
Windows Explorer, My Computer, or from the File/Save As section of any computer program.
Simply put, it lets you treat a CD as though it were a big floppy disk.
When backup using third party packet writing software is selected, Genie Backup Manager will
still control what and how much data is written to each inserted disc.




CD/DVDs written with this method can only be recognized on other computers if the
same third party packet writing software is installed there too.
Free Packet-Writing software are available for download on the Internet, please refer to
the following knowledgebase article for more information:
http://www.genie9.com/asp/community/KnowledgeArticle.asp?KBID=128

To set GBM to write to CDs and DVDs using third party packet writing software:
1. From within the backup wizard select Where to Backup.
2. Select CD/DVD media .
3. Select Use third party packet writing Software.

Formatting Optical Media
GBM comes with a CD/DVD formatting tool that can perform both quick erase and full disc
format.
This feature can only be used with re-writable optical media.
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New blank discs need not be formatted before using them with Genie Backup Manager.
However, if the disk has been written to previously using a packet writing software then
it needs a full format before GBM can use it for backup.
When using packet writing, make sure the disc you wish to backup to has been
formatted using the third party packet writing software.

Setting a backup job to automatically erase CD/DVD discs before backup:
1. From the left navigation menu in the backup wizard select Where to Backup.
2. Select CD/DVD media ( DVD±RW/DVD±R/DVD-RAM/CD-R or CD-RW).
3. Make sure Automatically erase disc before backup is selected.



Automatic disc erase uses quick erase, not full format.

Manually erasing CD/DVD discs:
1. From the toolbar click Tools, then select Format Re-Writable CD/DVD.
2. Select the drive letter of the recorder containing the disk you wish to erase.
3. Select one of the following options:






Quick Erase: Quickly delete the contents of the disk (takes around 1-2 minutes
to complete)
Format: Fully format disc (might take around 30 minutes or more to complete).

Quick erasing re-writable disks might render them ’r;stubborn’ after a number of erases,
it is recommended to perform a format every 7-10 quick erase sessions to revitalize the
disk.

Global Preferences: CD/DVD Settings
The CD/DVD Settings page of the Global Preferences window (accessible from the Tools
menu, Global Preferences menu item) contains options pertaining to writing to optical media.
Cache disc image before burning : This option increases the reliability of backup to CD media
by creating a temporary file on the hard disc that is then written at once to disc. Caching,
however, means that GBM will first copy the data to a temporary local drive and then onto the
CD, which adds a few minutes to the total running time for each disc.



Caching is not supported on DVD or blu-ray
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If GBM doesn't detect enough space to perform caching, data will be copied directly to
the CD.

Finalize disc (No further writing to the disk is possible): Close the CD/DVD media so that
further writing to it is not possible. This is done by not recording the next writable address in the
last session's lead-in, so that in the next time the recorder attempts to write, it has no way of
knowing where to begin writing. Only finalize CDs if you are sure that you will not be appending
new backup versions to it.
Import previous sessions on disc: If the CD contains more than one session, the most recent
session is automatically imported so that it could be updated with the new data.
Each time data is written to a CD/DVD disk a table of contents is written at the end of the
session in order to make the disk readable. This procedure is called session closing; data can still
be appended to the disk after a session is closed.
Genie Backup Manager will by default import previous sessions on the inserted disc before
writing to it so as not to lose existing data.
Disabling this feature causes GBM to write a new table of contents that does not refer to
previously written data on the disc, rendering that data hidden and inaccessible, but it will not
free the space occupied by it.
If a file with the same name as the backup file already exists on the CD, GBM will rename the
new file by appending a trailing number, that is incremented by one for each new version of the
file that is added.
Rename archive if a file/folder with the same name exists: This option prevents accidental
overwriting of previous backup jobs stored on the CD/DVD in case a file with a similar file name
already exists on it.
Eject the last backup disk after finishing
When backup to optical media is performed, eject the last disk in the media set to alert user that
backup is finished.

How to: Restore from Optical Media
To restore data stored on CD or DVD discs:
1.
2.
3.
4.
5.

Insert the last disc in the backup set into the drive.
Open the Restore wizard.
Click Select backup set.
Browse to the CD/DVD drive and select the catalog ".gbp file".
Click Open.

CD/DVD Backup Strategies
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GBM offers flexibility and reliability when backing up to CD/DVD. Here are some strategies to
make your backup reliable and more flexible:
1. Use blank CD/DVDs: For reliable backups it is recommended that you use blank (new)
CD/DVDs to ensure that the CD/DVD does not contain scratches from extensive use.
2. Simulate Backup: GBM offers simulating capabilities to ensure successful burning of
backup so you know that your backup will burn correctly on the CD/DVD before it
actually backs up. To can enable this option from Tools> Global Preferences>
CD/DVD Settings> Simulate backup before committing backup to disc
3. Create full backup on high capacity media: Backing up to CD/DVD is much slower
than backing up to a hard drive. Also DVD's even if dual layered cannot compare with
the high capacity Hard drives. In GBM you can create your full backup on an external
drive, edit your job, select incremental or differential on CD/DVD. Please make sure
Read index from catalog (Enable changing storage location) is selected from
Tools> Global Preferences> Cataloging
4. Rotate backup types via scheduling: Purging is disabled when burning backups to
CD/DVD media. However, you can rotate backup types using Advanced schedule in
Scheduler. for more information, see Advanced Schedule
5. Use packet writing software to purge backups: you can enable purge option (fully
supported if the backup does not span to multiple disks) using packet writing software as
it enables writing to CD/DVD as if you were backing up to a hard drive. Packet writing
also allows you to perform mirror backups and incremental backups with rollback
disabled.

Copyright (c) 2012 Genie9, Inc. All rights reserved.

Removable media
Removable Media
Removable media devices include floppy disks, JAZ drives, ZIP drives, memory sticks, etc.
Removable media is a practical backup destination, because it allows automatic media spanning,
i.e. GBM would backup to the inserted volume until all available space has been consumed then
prompt the user to insert a new disk, and so on, until all data has been written.
To set Genie Backup Manager to backup to a removable media device, open the backup wizard,
select Where to Backup, then select Multiple Disks (Removable Media Devices). A list of all
attached removable media devices will be displayed to choose from. External hard disk drives
are now detected under removable media; however, you may backup external harddisk under
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Local/LAN option to enable multi-drive spanning. For more information, see Backup to Internal
and External Drives.
You can backup an unlimited amount of data removable media even if one volume does not have
sufficient space to hold all the data, since GBM will divide your backup into several discs, and
you only need to replace discs when the program prompts you to do so.
Select Automatically erase contents of disk before backup if you wish to save time by
allowing GBM to quick-format each inserted volume during backup.

How to: Restore from Removable Media
To restore data stored on removable media:
1.
2.
3.
4.
5.

Make sure the last storage volume from the backup set is inserted/connected.
Open the Restore wizard.
Click Select backup set.
Browse to removable media drive and select the catalog ".gbp file".
Click Open.

The Default Backup Destination
When a new backup job is created, the backup destination option (where to backup) will be set
to a default local folder, typically "My Documents\My Backups", which can be later changed by
the user.
To change GBM's default backup folder select Tools from the toolbar, select Global
Preferences, select Backup Settings, and enter a new path in the Default backup
destination box. Note that the default backup destination can only be set to point to a local or
networked location.
To view the contents of the default backup folder click File from the toolbar then select Default
Backup Folder.

Backup Transfer Method
Disconnections during backup (network failure, faulty disks etc.) can lead to corrupt backups. To
avoid having to redo backup when such an event occurs, users can activate this feature to make
a temporary local copy of the data before copying it to its final destination; this way, Genie
Backup Manager can resume backup from where it was interrupted.
To activate Backup Transfer Method for a backup job, select Settings from the backup wizard,
click on the More Settings link, select Backup Transfer Method, and make sure the option
Backup to local temporary location before copying to backup destination is checked.

Media ID
During backup to removable or optical media, Genie Backup Manager will assign a different id
(label) to each disc/volume for identification. It is recommended to mark the media with this
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label, since GBM will refer to it as it prompts the user to replace disks during restore or when
attempting to add new versions to a backup.
GBM names each disk using the following naming scheme:
<Backup Job Name> - <Volume Number>
Where:




Backup Job Name: is the name assigned to the backup job.
Volume Number: indicates the disk's number according to the sequence in which
volumes where inserted during backup.

To change the Media ID:
1.
2.
3.
4.

From the left navigation menu in the backup wizard select Settings.
Click Advanced Settings.
Make sure Change media ID is selected.
Type a new label to be used instead of the backup job name.
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Data
User data is divided into three categories to make it more manageable during backup and
restore. Data selection is the third screen in the backup wizard.
My Profile
This user data group contains various built-in plugins that you can use to backup some of the
most important items on your computer; this includes Emails, Favorites, Windows Settings,
Desktop files and folders etc&ldots;
Plugins are system independent, i.e. one can backup his favorites, for instance, from a Windows
XP machine and restore them on a Windows 2000 machine, without having to worry about the
changed Windows environment, and GBM would know exactly where to copy the files.
The items in this group were selected to include the most commonly backed up data types
during system formats.
My Folders
This user data group allows you to backup files and folders from any location readily accessible
from My Computer using an easy to use Windows-Explorer-like interface.
Use this group when you know where your files and folders are located and need to be able to
access/restore files individually.
My Plugins
This group lists plugins that can be used to back up various items, such as programs, program
settings, saved games, databases etc ...
These plugins are different from those in My Profile in that users can download free plugins to
extend the capabilities of GBM, or create their own custom plugins and share them with other
users.

Personal Data and Settings (My Profile)
Profile Data
This user data group contains various built-in plugins that you can use to backup some of the
most important items on your computer; these include Emails, Favorites, Windows Settings,
Desktop files and folders etc. The items in this group were selected to include the data types
most commonly backed up during system formats.
My Profile items can be migrated between different computers or different versions of Windows
safely; one can backup his favorites, for instance, from a Windows XP machine and restore them
on a Windows 2000 machine, and GBM would know exactly where to copy the files.
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Selecting an item from the left pane displays a list of selection refinements in the right pane,
along with item-specific settings.

System State
System State
Genie Backup Manager provides an easy, secure and reliable way to backup System State.
System state backup includes all system state data as a unit; you cannot choose to backup
individual components due to dependencies among the system state components and to insure a
stable system after restoration.

System State Items That GBM Can Backup










Boot files, including system files and performance counter configurations
COM+ Class registration database: A store of registration information for COM objects in
the Windows system. COM is a standard for binary interoperability of registered software
components.
Windows Registry: A database that Windows uses to store hardware and software
configuration information, user preferences and setup information
System Files under Windows File protection: A system service that protects special
operating system files. In the event that one of these files is deleted or overwritten,
System File Protection will replace the file with the original from its cache.
Active Directory Service: Stores Information about the network resources across a
domain and is only created on systems that are domains
SYSVOL Directory: Contains Group Policy data this folder is only created on systems
that are domain controllers
Certificate Services database including private keys. This databases are only created on
certification authority systems
Cluster Database: Contains information about all physical and logical elements in a
cluster, including cluster objects, their properties, and configuration data. It is created
on systems that are a node of a Windows cluster
The Metadirectory for The Microsoft Internet Information Services if IIS is installed on
the computer

How to: Backup System State
1. From the left navigation menu in the backup wizard select What to Backup.
2. Select My Profile tab.
3. In the left-hand pane Select the checkbox next to System State.

How Restore to System State?
1.
2.
3.
4.
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Open the restore wizard.
Load a backup, then click Next.
Make sure the My Profile tab is selected.
From the left-hand pane, select System State

Data

Important Notes







When Restoring System State with active directory, you must Restart the domain
controller in Directory Services Restore Mode
It is recommended to Restore Active Directory, which is part of System State, before
restoring MS Exchange. This will save time instead of manually configuring you storage
groups, mail boxes, etc...
Aborting System State Restoration may cause your system to become unstable.
It is Recommended to restore System State data to the same Windows version due to
variation in components on each version
If you have more than one domain controller in your organization and Active Directory is
replicated to any of these other servers, you might have to authoritatively restore any
Active Directory data that you want to restore.

Restart the Domain Controller in Directory Services Restore Mode
Restoring your Active directory requires your Domain Controller to be offline. Therefore you
must restart your domain controller in Directory Services Mode
To perform this procedure, you must provide the Administrator password for Directory Services
Restore Mode.

To restart the domain controller in Directory Services Restore Mode

1.
2.
3.
4.

Restart the domain controller.
When the screen for selecting an operating system appears, press F8.
On the Windows Advanced Options menu, select Directory Services Restore Mode.
When you are prompted, log on as the local administrator.

Email Clients
Backing up Email Clients Data
Genie Backup Manager offers backup options for of the most commonly used email clients: Ms
Outlook (2000-2007, Windows Mail, and Outlook Express. Backup of other email clients' data is
also supported through Genie9's free plugins project.

MS Outlook
MS Outlook
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Genie Backup Manager can help you to backup all your Outlook data or transfer your existing
Outlook profile(s) from one computer to another. Using Genie Backup Manager you can migrate
your Outlook profile between different versions of Windows.

MS Outlook Data Items that GBM Can Backup:












Main data files (Outlook.pst, Archive.pst) and additional data files created by the user.
Extensions (addins).
Settings and preferences, including customized toolbar settings, contacts and
nicknames, send and receive settings, navigation pane settings, rules etc ...
Signatures: The blocks of formatted text and/or graphics that appear at the end of emails send that identify yourself and your contact information.
Stationery: Stationery and themes are a set of unified design elements and color
schemes you want to apply to messages. They specify fonts, bullets, background color,
horizontal lines, images, and other design elements you want to include in outgoing email message
Custom Forms: Custom forms created by outlook users. Forms are an easy way to
distribute and collect information electronically.
E-mail accounts: POP3, IMAP and HTTP e-mail accounts
Miscellaneous options set by the user while using Microsoft Outlook such as:
notifications, displays, read receipts, sending options and formats, maintenance
preferences, etc...
Categories: Any Microsoft Outlook item can be assigned to one or more categories.
Consistent use of categories makes it easier to locate specific items.

Outlook Data Files
The following is a list of MS Outlook files that GBM can backup.

Description

Stored in

Typical File Location

Outlook data files

(.pst)

drive:\Documents and Settings\<user>\Local
Settings\Application Data\Microsoft\Outlook

Offline Folders
file

(.ost)

drive:\Documents and Settings\<user>\Local
Settings\Application Data\Microsoft\Outlook

Personal Address
Book

(.pab)

drive:\Documents and Settings\<user>\Local
Settings\Application Data\Microsoft\Outlook

Offline Address
Books

(.oab)

drive:\Documents and Settings\<user>\Local
Settings\Application Data\Microsoft\Outlook

Command bar
and menu
customizations
(.dat)

(.dat)

drive:\Documents and Settings\<user>\Application
Data\Microsoft\Outlook
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Navigation Pane
settings.
This file includes
Shortcuts,
Calendar, and
Contact links.

(.xml)

drive:\Documents and Settings\<user>\Application
Data\Microsoft\Outlook\Outlook.xml

Outlook contacts
nicknames

(.nk2)

drive:\Documents and Settings\<user>\Application
Data\Microsoft\Outlook

Rules

(.pst)

drive:\Documents and Settings\<user>\Application
Data\Microsoft\Outlook
Note: If you upgraded from a version of Outlook prior to
Outlook 2002, you may have a .rwz file on your computer hard
disk drive. The file is no longer needed and the rules
information is now kept on the server for Microsoft Exchange
e-mail accounts, and within the personal folders file (.pst) for
POP3 and IMAP e-mail accounts. You can delete the file.

Print styles

(Outlprnt
with no
extension)

drive:\Documents and Settings\<user>\Application
Data\Microsoft\Outlook

Signatures

(.rtf, .txt,
.htm)

drive:\Documents and Settings\<user>\Application
Data\Microsoft\Signatures

Stationery

(.htm)

drive:\Documents and Settings\<user>\Application
Data\Microsoft\Stationery

Custom forms

drive:\Documents and Settings\<user>\Local
Settings\Application Data\Microsoft\Forms

Dictionary

(.dic)

drive:\Documents and Settings\<user>\Application
Data\Microsoft\Proof

Templates

(.oft)

drive:\Documents and Settings\<user>\Application
Data\Microsoft\Templates

Send/Receive
settings

(.srs)

drive:\Documents and Settings\<user>\Application
Data\Microsoft\Outlook

Message

(.msg, .htm,
.rtf)

drive:\Documents and Settings\<user>\My Documents

How to: Backup MS Outlook Data
1.
2.
3.
4.
5.
6.

Log in to the Windows account using the Outlook profile(s) you wish to backup.
From the left navigation menu in the backup wizard select What to Backup.
Select My Profile tab.
Expand the Outlook tree to view available profiles.
Select the checkboxes next to the profiles you wish to backup.
From the right-hand pane select the desired Outlook data items for each profile.
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How to: Backup While MS Outlook is Running
GBM may not properly backup Outlook data files if Outlook is running. To avoid files being
skipped during backup if the Open File Backup service is disabled, the user can set GBM to
automatically close Outlook before backup starts and then reopen it when backup is complete.
For a better solution to avoid this and all similar open-file problems, see Managing open files.

To set GBM to automatically close Outlook before backup:
1.
2.
3.
4.

From the toolbar, click Tools, then select Global Preferences.
Select Backup Settings.
Select Automatically close Outlook before backup.
If you wish to let GBM run outlook again after backup, select Reopen Outlook after
backup.
5. Enter the number of minutes GBM should wait for Outlook to close before aborting
backup; GBM will not be able to close Outlook if one of its dialogs or internal messages is
open.

How to: Restore Outlook Data
Although Genie Backup Manager can backup multiple Outlook profiles simultaneously, each
profile must be restored separately.
1.
2.
3.
4.
5.
6.

Open the restore wizard.
Load a backup, then click Next.
Make sure the My Profile tab is selected.
From the left-hand pane, expand the tree under Outlook, then select a profile.
From the items list pane select the Outlook Data Items you wish to restore.
Choose one of the following options:





Create a new profile: create a new profile, and restore data to it.
Overwrite existing profile: overwrite existing profile with the one being
restored.
Append to Existing profile: merge restored profile with an existing one. PST
files will be appended as additional data files, not synchronized.

7. If you wish to restore another Outlook profile, run Outlook once, then close it and repeat
steps 1 through 6

Outlook Express
Outlook Express
Genie Backup Manager can help you to backup all your Outlook Express data or transfer your
existing Outlook Express identity from one computer to another. Using Genie Backup Manager
you can also migrate your Outlook Express emails and settings between different versions of
Windows.
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GBM is also the first and ONLY Outlook Express backup utility to allow users to view, read, print,
and extract emails directly from the backup without restoring them first.





Outlook Express makes it easy for two or more users on the same PC to keep their mail
separate using identities. GBM can backup multiple Outlook Express identities
simultaneously.
Selecting an Outlook Express mail folder will automatically select all its subfolders.
To select an Outlook Express mail folder without its subfolders or to deselect a folder
without un-selecting its subfolders, right-click on the checkbox next to it.

How to: Backup Outlook Express
1.
2.
3.
4.
5.

From the left navigation menu in the backup wizard select Where to Backup.
Select My Profile tab.
Expand the Outlook Express tree to view identities available for backup.
Select the checkboxes next to the identities you wish to backup.
From the right-hand pane select the desired Outlook Express data items for each
identity.

How to: Backup While Outlook Express is Running
GBM may not properly backup Outlook Express data if Outlook Express is running and if Open
File Backup (OBF) is disabled. To avoid files being skipped during backup, the user can set GBM
to automatically close Outlook Express before backup and then reopen it when backup is
complete.
For a better solution to avoid this and all similar open-file problems, see Managing open files.

To set GBM to automatically close Outlook Express before backup:
1.
2.
3.
4.

From the toolbar, click Tools, then select Global Preferences.
Select Backup Settings.
Select Automatically close Outlook Express before backup.
If you wish to let GBM run outlook Express again after backup, select Reopen Outlook
Express after backup.
5. Enter the number of minutes GBM should wait for Outlook Express to close before
aborting backup. GBM will not be able to close Outlook Express if one of its dialogs or
internal messages is open

How to: Restore Outlook Express Data
Although Genie Backup Manager can backup multiple Outlook Express identities simultaneously,
each identity must be restored separately.
1. If you are restoring to a new Windows installation, you must start Outlook Express once
before attempting to restore.
2. Open the restore wizard.
3. Load the backup, then click Next.
4. Make sure the My Profile tab is selected.
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5.
6.
7.
8.
9.
10.
11.

From the left-hand pane, select the identity you wish to restore.
From the items list pane select the Outlook Express data items you wish to restore.
Click Select identity.
Choose an identity from the list and click Select.
Click Back to Restore.
Finish selecting other backup items and click Next to start restore.
Repeat steps 2 through 10 to restore additional Outlook Express identities.

How to: Synchronize Outlook Express Mail Folders
Genie Backup Manager isn't an Outlook Express synchronization tool per se', however, GBM
offers a work around, by restoring data to a dummy temporary identity, from there the user can
use Outlook Express import functionality to synchronize emails form the existing identity with
emails from the restored identity.
To synchronize Outlook Express Emails:
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11.
12.
13.
14.

Open the restore wizard.
Load a backup, then click Next.
Make sure the My Profile tab is selected.
From the left-hand pane, select the identity you wish to restore.
From the items list pane select the Outlook Express data items you wish to restore.
Click Select identity.
Choose an identity from the list, then click Select.
Select Synchronize my emails.
Click Ok and complete the restore process.
When restore is complete, run Outlook Express.
From the File menu select Import then select Messages.
Select Microsoft Outlook Express.
Select Genie Backup Identity and click Next until you reach the Select Folders page.
Choose one of the following options:




Import all.
Selected Folders.

How to: Synchronize Outlook Express Settings
To synchronize settings and email accounts from a backed up Outlook Express identity with an
existing Outlook Express identity do the following:
1.
2.
3.
4.
5.

Open the restore wizard.
Load the backup, then click Next.
Make sure the My Profile tab is selected.
From the left-hand pane, expand the Outlook Express list, then select an identity.
From the item list pane, make sure Outlook Express Root is not selected, and select
Outlook Express Data.
6. Click Select identity.
7. Choose an identity from the list, then click Select.
8. Click Back to Restore.
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How to: Extract Mail Folders Directly from a Backup
This features allows you to extract an Outlook Express mail folder directly from backup without
having to restore the entire identity.
1.
2.
3.
4.
5.

Open the restore wizard.
Load the backup, then click Next.
Make sure the My Profile tab is selected.
From the left-hand pane, select an identity.
From the items list pane, expand the Outlook Express Root tree, and select an email
folder.
6. Click Extract.
7. Select a folder then click Ok.

How to: View Backed Up Emails
GBM is the first Outlook Express backup utility to allow users to view, read, print, and extract
emails directly from the backup without restoring them first.
1.
2.
3.
4.
5.

Open the restore wizard.
Load the backup, then click Next.
Make sure the My Profile tab is selected.
From the left-hand pane, select an identity.
From the items list pane, expand the Outlook Express Root tree, then select an email
folder.
6. Click View Emails.

Windows Mail
Windows Mail
Windows Mail is the successor to Outlook Express. Windows Mail builds on the foundation of
Outlook Express, adding a variety of new features designed to make your e-mail experience
more productive and fun, while helping to reduce risks and annoyances such as phishing and
junk e-mail. With GBM, users can backup and restore Windows Mail emails, accounts, rules, and
stationary simply and easily with a click of a button.
Windows Mail Data Items that GBM Can Backup:







Mail: Inbox, Outbox, drafts, Deleted Items, Junk email folders, and all user defined
folders for emails
Accounts: Email accounts, Internet news accounts and Directory Service accounts.
Rules: Message rules created in Windows Mail
Settings: This includes the options the user selects and sets while using Windows Mail
such as: notifications, displays, send/receive message options, read receipts, sending
options and formats, maintenance preferences, etc...
Stationery: Stationery and themes are a set of unified design elements and color
schemes you want to apply to messages. They specify fonts, bullets, background color,
horizontal lines, images, and other design elements you want to include in outgoing
email messages.
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How to: Backup Windows Mail Data
1. From the left navigation menu in the backup wizard select Where to Backup
2. Select My Profile tab
3. Select Windows Mail

How to: Restore Windows Mail Data
1.
2.
3.
4.
5.

Open the Restore wizard.
Load the backup, then click Next.
Make sure the My Profile tab is selected.
From the left-hand pane, select Windows Mail
Select one of the following options:




Overwrite:This option will overwrite all items with what is in backup.
Merge:This option enabled GBM to add missing emails, stationery to your current
configuration. This method is recommended even if you are restoring to a new
installation.

Backing Up Other Email Clients
Backup of email clients other than MS Outlook and Outlook Express is supported through
Genie9's free Plugins project. The Genie9 plugins database contains hundreds of downloadable
free plugins that extend Genie Backup Manager's capabilities to support backup of extra items,
such as email clients, that are not already listed in the My Profile section. Users can also create
custom plugins to backup additional items not included in the database, by writing XML-based
scripts (for more information see Scripting).

Windows Registry
Windows Registry
Windows Registry is a database that holds the settings and options in your windows system.
Whenever you make changes to your hardware configurations, software, users settings or PC
preferences on your computer these changes are reflected in and stored in windows registry.
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If you are the kind of person who likes to fiddle with registry to tweak settings or if you're a
software experimenting fan, then backing up your registry is a necessity. Using Genie Backup
Manager, you can backup your entire registry or just a few selected keys.

How to: Back Up the Entire Registry
1.
2.
3.
4.

From the left navigation menu in the backup wizard select What to Backup.
Select My Profile tab.
In the left-hand pane Select the checkbox next to Registry.
Select Backup Entire Registry.

How to: Back Up Selected Registry Keys
1.
2.
3.
4.
5.
6.

From the left navigation menu in the backup wizard select What to Backup.
Select My Profile tab.
In the left-hand pane Select the checkbox next to Registry.
Select Backup selected registry keys.
Click Add Registry Keys
Select a registry key then hit Add. Repeat this step until all desired registry keys are
selected.
7. Click Done.

How to: Restore Windows Registry
Restoring the entire registry must NOT be performed except on the same machine and under the
same Windows installation. Restoring the registry under a different Windows installation (for
example after a system format) or to another machine WILL corrupt your system.
Arbitrary restoring registry keys may have unpredictable consequences and cause your system
to crash or corrupt installed programs. It is recommended not to restore registry keys unless the
user knows exactly what the keys are for.
To restore Windows Registry
1.
2.
3.
4.
5.

Open the restore wizard.
Load the backup then click Next.
Select My Profile tab.
Select the checkbox next to Registry.
From the right-hand pane, select the registry key(s) you wish to restore.

Desktop Items
The Desktop
The Desktop area is the preferred location for storing files that the user needs to be readily
available and accessible, however, the actual Desktop folder is nested in the drive in a location
not obvious to most people. Genie Backup Manager will backup and restore Desktop items to
their correct locations on the target computer regardless of the Windows version installed or the
user account under which you are logged on.

How to: Back up Desktop Items
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1.
2.
3.
4.

From the left navigation menu in the backup wizard select What to Backup.
Select My Profile tab.
Select Desktop.
From the right-hand pane select one of the following two options:




All desktop: backup the entire Desktop area with all its files and subfolders. The
desktop area will be automatically re-scanned each time backup is performed to
include newly added files and folders.
Selected files and folders: backup only a selected set of files and folders.
Selection will not be re-scanned for new files in subsequent backups.

Note:
Shortcuts (*.lnk) are excluded from the backup job as they are linked to different locations that
may not be restored in the original location causing broken and unused links.

How to: Restore Desktop Items
Genie Backup Manager allows you to migrate your Desktop area items between different
machines, Windows, and user accounts.
1.
2.
3.
4.
5.
6.

Open the restore wizard.
Load the backup then click Next.
Select My Profile tab.
From the left-hand pane, select Desktop.
From the right-hand pane, select the Desktop items you wish to restore.
Select one of the following options:
 Restore to Desktop to restore to the desktop area of the currently logged on
user.
 Restore to alternate location to restore to a different folder.

My Documents Folder
My Documents Folder
Most applications, including VS.NET, and the Microsoft Office suite etc. consider 'My Documents'
as the default location for any user's work. However, this folder is mapped differently for each
user on the same computer.
Genie Backup Manager enables you to backup 'My Documents' folder quickly and easily, over
and over again, each time making sure that new and changed files are always backed up.
Moreover, GBM will always restore 'My Documents' to its correct path on the target computer
regardless of the Windows version installed or the user account under which you are logged on.

How to: Back Up My Documents
1. From the left navigation menu in the backup wizard select What to Backup.
2. Select My Profile tab.
3. Select My Documents.
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4. From the right-hand pane, select one of the following two options:
 All My Documents: Backup the entire 'My Documents' folder. Genie Backup
Manager will automatically re-scan the 'My Documents' folder for newly added
files before each backup run.
 Selected Files/Folders: Select specific files and folders to be backed up from
within the 'My Documents' folder. Genie Backup Manager will only backup the
original set of selected files each time, newly added files and folders will be
ignored.

How to: Restore My Documents Folder
1.
2.
3.
4.
5.
6.

Open the restore wizard.
Load the backup, then click Next.
Make sure the My Profile tab is selected.
From the left-hand pane, select My Documents.
From the right-hand pane, select the Desktop items you wish to restore.
Select one of the following options:
 Restore to My Documents: to restore to the My Documents folder of the
currently logged on user.
 Restore to alternate location to restore to a different folder.

Windows Address Book
Windows Address Book
Windows Address Book is where contact information is stored. This information is used by
programs such as Microsoft Outlook, Microsoft Outlook Express, Microsoft Internet Explorer,
Microsoft NetMeeting, and Microsoft Phone System.

How to: Back Up Windows Address Book
1. From the left navigation menu in the backup wizard select What to Backup.
2. Select My Profile tab.
3. Select Windows Address Book.

How to: Restore Windows Address book
1.
2.
3.
4.

Open the restore wizard.
Load the backup, then click Next.
Make sure the My Profile tab is selected.
From the left-hand pane, select Windows Address Book.
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Windows Address Book contacts are listed according to Outlook Express identities, to be
able to view the restored Windows Address Book contacts properly make sure restored
Outlook Express identities keep their old names. Otherwise synchronize your Windows
Address Book data.

How to: Synchronize Windows Address Book Contacts
Restoring Windows Address Book will replace the existing WAB file on the machine. The user can
manually synchronize the existing address book with the backed up version by doing the
following:
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11.

Open the restore wizard.
Select the backup set, then click Next.
Make sure the My Profile tab is selected.
From the left-hand pane, select Windows Address Book.
Click View Backed Up Windows Address Book.
From the toolbar click File, then select Export.
Select WAB Address Book, and save the WAB file in a temporary location.
Run Outlook Express.
From the toolbar click File, then select Import.
Select Address Book.
Browse to the location of the saved WAB file and select it then click Ok.

Windows Contacts
Windows Contacts
Microsoft Windows Vista provides a new mechanism and user interface for storing and retrieving
information about people (contacts) who are important to the users of Microsoft Outlook and
Windows Mail (formerly Outlook Express)

How to: Backup Windows Contacts Data?
1.
2.
3.
4.

From the left navigation menu in the backup wizard select What to Backup
Select My Profile tab
Select Windows Contacts
Select Include Windows Live Contacts (if available) if you wish to backup Windows
Live contacts.

How to: Restore Windows Contacts
1.
2.
3.
4.

Note:
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Open the restore wizard.
Load the backup, then click Next.
Make sure the My Profile tab is selected.
From the left-hand pane, select Windows Contacts

Data

This option is used to restore Windows contacts backed up originally via GBM, restoring windows
contacts will only restore missing contacts and will not delete newly created contacts that were
not originally backed up via GBM.

Windows Favorites
Windows Favorites
In Microsoft Internet Explorer you can tell the program to remember a list of your "favorite" Web
pages, so that you can go back to them easily, without having to type in the address (URL)
again. Genie Backup Manager allows you to backup your Favorites, transfer them from one
computer to another, or migrate them between different versions of Windows.

How to: Back Up Windows Favorites
1. From the left navigation menu in the backup wizard select What to Backup.
2. Select My Profile tab.
3. Select Favorites.

How to: Restore Windows Favorites
1.
2.
3.
4.

Open the restore wizard.
Load the backup, then click Next.
Make sure the My Profile tab is selected.
Select Favorites.

Windows Fonts
Windows Fonts
Windows Fonts are the files used by your operating system to display and print text. These fonts
come in many different styles and types, and their location is usually unknown to users. Genie
Backup Manager allows you to backup your Fonts, transfer them from one computer to another,
or migrate them between different versions of Windows.

How to: Back Up Windows Fonts
1. From the left navigation menu in the backup wizard select What to Backup.
2. Select My Profile tab.
3. Select Windows Fonts.

How to: Restore Windows Fonts
1.
2.
3.
4.
5.

Open the restore wizard.
Load the backup, then click Next.
Make sure the My Profile tab is selected.
From the left-hand pane, select Windows Fonts.
From the right-hand pane select the fonts you wish to be restored.
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Media Files
Media Files
Genie Backup Manager can be set to automatically backup music and video playback files of all
formats including: MP3, MPEG, DAT, WAV, RealPLayer files, MediaPlayer files, QuickTime files
etc...
Genie Backup Manager offers two easy methods for locating and backing up media files on your
computer: using playlists, and scanning for media files.

How to: Use Playlists to Backup Media Files
A media playlist is a table of your favorite media files -or more commonly, mp3s- that you have
currently loaded into a media player to play in a specific order, by saving this list to file you can
reuse it to play the same songs without having to re-select them each time.
Since most users already have their favorite songs on their machines organized in playlists, GBM
offers a novel way of backing up media files using these playlists to locate favorite songs and
movie clips and copy them to the backup destination.
GBM will also backup the playlist itself and regenerate it in the same original order at restore
time so as to play the same songs even if they were restored to a different location.



GBM supports 3 playlist formats: m3u, pls and wpl.

How to use playlists to backup media files?
1.
2.
3.
4.
5.

From the left navigation menu in the backup wizard select What to Backup.
Select My Profile tab.
Click the plus sign next to My Media to expand the lest beneath it.
From the right-hand pane click Add Playlist.
Select a media playlist file then click Open.

How to: Automatically Scan for Media Files
You can set Genie Backup Manager to automatically locate and backup media files scattered on
your hard drive. By default, when this option is selected, GBM will search for media files under
the 'My Media' folder located in 'My Documents', however, the user can include new
folders/drives to be scanned each time the backup job is run. The supported formats GBM scans
for are the following:
*.au,*.snd,*.asf,*.wm,*.wmx,*.wmd,*.wma,*.wax,*.wmv,*.wvx,*.avi,*.wav,*.mpeg,*.mpg,*.
mpe,
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*.m1v,*.mp2,*.mpv2,*.mp2v,*.mpa,*.mp3,*.mid,*.midi,*.rmi,*.aif,*.aifc,*.aiff,*.rt,*.rm,*.ram
,*.ra,
*.rmvb,*.rp,*.rv,*.mov,*.qt,*.m4a,*.m4p,*.mp1,*.mpga,*.ssm,*.sdp,*.3gp,*.mp4,*.swa,*.3g
pp,
*.mpa,*.m1a,*.m1v,*.mqv, and *.bwf

Genie Backup Manager will automatically re-scan the default media folders, defined in Genie
Backup Manager, for new media files each time the backup job is run. However, new custom
folders added by the user won't be re-scanned, unless the user clicks the Scan button in backup
job editing mode.
Using Automatic Scan to Back Up Media Files?
1.
2.
3.
4.

From the left navigation menu in the backup wizard select What to Backup.
Select My Profile tab.
Select My Media.
If you wish to let GBM scan your entire computer for media files, click Scan, make sure
Local drives minus program files is selected, then click Search.
5. If you wish to scan for media files only in certain folders of your choice, click Add
Folder, select the folder you wish to scan, then click Ok. Repeat this step until all
folders are selected.
6. When the media files list is populated, expand the three, to view a list of all detected
media files, and select the ones that you wish to backup.

How to: Restore Media Files
1.
2.
3.
4.

Open the restore wizard.
Load the backup, then click Next.
Make sure the My Profile tab is selected.
Depending on the media backup method you selected, select Media Playlist or My
Media Files.
5. From the right-hand pane, select the media files you wish to restore.
6. From the Restore files to list box select one of the following options:
 Original location: restore each media file to the original path from which it was
backed up.
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Alternate location: restore all media files under a user-specified folder,
maintaining the original folder structure.
 Single folder: restore all media files to the root of a user-selected folder.
7. If you're restoring media files backed up using the playlist method, select Regenerate
playlist to generate a new playlist based on the new locations to where your files were
copied.

Images and Photos
Images and Photos
You can set Genie Backup Manager to automatically locate and backup image files scattered all
over your hard drive. By default, when this option is selected, GBM will search for images under
the 'My Pictures' folder located in 'My Documents', however, the user can include new
folders/drives to be scanned for images.

How to: Back Up Images and Photos
1.
2.
3.
4.

From the left navigation menu in the backup wizard select What to Backup.
Select My Profile tab.
Select My Photos.
If you wish to let GBM scan your entire computer, click Scan, make sure Local drives
minus program files is selected, then click Search.
5. If you wish to scan only in certain folders of your choice, click Add Folder, select the
folder you wish to scan, then click Ok. Repeat this step until all folders are selected.
Genie Backup Manager will automatically re-scan the default media folders, defined in
Genie Backup Manager, for new image files each time the backup job is run. However,
new custom folders added by the user won't be re-scanned, unless the user clicks the
Scan button in backup job editing mode before backup.
6. When the photos list is populated, expand the three, to view a list of all detected image
files, and select the ones that you wish to backup. GBM will display a thumbnail preview
of any highlighted image in the upper-right corner of the program.

How to: Automatically Scan for Photos and Images
You can set Genie Backup Manager to automatically locate and backup media files scattered on
your hard drive. By default, when this option is selected, GBM will search for photos and images
files under the 'My Pictures' folder located in 'My Documents', however, the user can include new
folders/drives to be scanned each time the backup job is run. The supported formats GBM scans
for are the following:
*.bmp, *.dib,*.jpg, *.jpeg, *.jpe, *.jfif, *.gif, *.tif, *.tiff, *.raw and *.png
Genie Backup Manager will automatically re-scan the default media folders, defined in Genie
Backup Manager, for new media files each time the backup job is run. However, new custom
folders added by the user won't be re-scanned, unless the user clicks the Scan button in backup
job editing mode.
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Using Automatic Scan to Back Up Images and Photos
1.
2.
3.
4.

From the left navigation menu in the backup wizard select What to Backup.
Select My Profile tab.
Select My Photos.
If you wish to let GBM scan your entire computer for media files, click Scan, make sure
Local drives minus program files is selected, then click Search.
5. If you wish to scan for media files only in certain folders of your choice, click Add
Folder, select the folder you wish to scan, then click Ok. Repeat this step until all
folders are selected.
6. When the media files list is populated, expand the three, to view a list of all detected
media files, and select the ones that you wish to backup.

How to: Restore Images and Photos
1.
2.
3.
4.
5.
6.

Open the restore wizard.
Load the backup, then click Next.
Make sure the My Profile tab is selected.
Select My Photos.
From the right-hand pane, select the image files you wish to restore.
Select one of the following options:
 Restore to original location: to restore each image to the same path from
which it was originally backed up.
 Restore to alternate location to restore all image files under a different folder.

Internet Explorer
Internet Explorer
GBM enables the user to backup the following items that define the way Internet Explorer
functions:




Internet Explorer Settings: Home page, security, privacy, content, connections,
programs, and advanced settings.
Internet Explorer Cookies: Cookies are small text files that some web sites use to
store information on your PC, among other reasons they are used sometimes to grant
you access next time around to the web site or for customization features.

How To: Backup Internet Explorer
1. From the left navigation menu in the backup wizard select What to Backup
2. Select My Profile tab
3. Select Internet Explorer
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4. In the right-hand pane, select one of the following options:




Internet Explorer Settings: Home page, security, privacy, content,
connections, programs, and advanced settings.
Internet Explorer Cookies: Cookies are small text files that some web sites
use to store information on your PC, among other reasons they are used
sometimes to grant you access next time around to the web site or for
customization features.

How to: Restore Internet Explorer Settings
1.
2.
3.
4.

Open the Restore wizard
Select the backup set, then click Next
Make sure the My Profile tab is selected
From the left-hand pane, select Internet Explorer Settings

Windows Settings
Windows Settings
GBM gives users the ability to backup the following selection of personalized Windows settings
and configurations:












Desktop Wallpapers: Desktop wallpaper settings and background image.
Visual Appearance: Shapes, sizes and colors of windows, buttons and fonts.
International settings: Regional settings, Time, Date, Currency and Number formats.
Mouse Preferences: Mouse pointer behavior settings.
Mouse Cursors: Preferred mouse cursor scheme.
Connections Settings: Network connection accounts. Backing up Dialup Preferences
will only backup network connection settings; needed protocols should already be
installed and the modem should already be configured.
Power Settings: PC power options properties located in the control panel.
Consol Settings: Windows command prompt settings, options, colors, font and layout.
Multimedia: For storing favorite sound, audio, and video settings plus the sounds
scheme; sounds associated with events in the windows system.
Advanced Settings: Saves Windows Explorer advanced view settings, such as hide
extensions, show system files etc...

How to: Back Up Windows Settings
1.
2.
3.
4.

From the left navigation menu in the backup wizard select What to Backup.
Select My Profile tab.
Select Windows Settings.
Select the individual Windows settings items that you want to backup.

How to: Restore Windows Settings
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1.
2.
3.
4.
5.

Open the restore wizard.
Load the backup, then click Next.
Make sure the My Profile tab is selected.
From the left-hand pane, select Windows Settings.
From the items list pane select the individual items you wish to restore.

Files and Folders
Files and Folders
This user data group allows you to backup files and folders from any location readily accessible
from My Computer using an easy to use Windows-Explorer-like interface.
Use this group when you know where your files and folders are located and need to be able to
access/restore files individually.
Selecting My Documents or items from the Desktop area for backup from My Folders does not
guarantee that they will be restored properly, since the paths to these folders might differ on a
other computers, new Windows installations or a different Windows versions. To avoid this, it is
recommended to backup these items from My Profile.

A plus sign means that the listing can be expanded to display additional items.
A minus sign means that the listing can be collapsed to hide displayed items beneath it.
An empty check box means that the item can be selected but is currently not.
A check box with a blue or green check mark means that the item is selected with all
its contents.
A gray check mark means that some but not all of the item's contents have been
selected.
A grayed out check box means that the item is not available or not selectable; if the
item has an Expand/Collapse box then the user needs to expand the listing to be able
to select its contents.

My Folders Selection Options
Right-clicking on any item (file or folder) in the right-hand pane in My Folders tab and selecting
Selection Options presents the user with several options for selecting files and folders, these
are:









Select All: Select all items in the pane
Clear All: Deselect all items in the pane
Select Files Only: Only select files appearing in the current view
Select Folders Only: Only select folders appearing in the current view
Invert Selection: Invert the selection in the current view (unselected items will be
selected, and selected items will be deselected)
Run: Will execute the selected file
Open: Opens selected File/Folder
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Open in Windows Explorer: Opens the path of the file/folder in Windows Explorer
Properties: Displays the File/Folder properties

Selecting Files and Folders for Backup
The My Folders window is divided into two panes; the left-hand pane lists drives and folders,
where as, the right-hand pane lists the contents of the highlighted drive or folder form the lefthand pane.
Selecting files and folders for backup:
1. From the left navigation menu in the backup wizard select What to Backup.
2. Select My Folders tab.
3. Click in the checkbox next to each individual folder or file that you wish to backup.

When running repetitive backup tasks, especially scheduled unattended backups, the user would
normally want files that are newly created in, or moved to a selected folder to be included in the
backup automatically, without having to manually select them each time before running the
backup task.
Genie Backup Manager automatically detects files and subfolders that have been added to a
selected folder after the date of most the recent backup, provided that the parent folder was
originally selected, i.e. the check box next to the folder was ticked when the backup job was
created (or edited).
Example:
Lets assume Jack has a folder called Week that has three files, Saturday, Sunday, and Monday.
Jack first creates a backup job, and selects the contents of the folder Week for backup. The next
day, Jack adds several new files and folders to the folder Week.







Scenario: When Jack created the backup job he selected folder Week for backup by
ticking its check box, marking all its files for backup.
Result: All new files and folders will be appended to the backup.
Scenario: Jack selected the three files by ticking folder Week's check box, but before
saving the backup job he deselected files Sunday and Monday.
Result: All new files and folders will be appended to the backup.
Scenario: Jack selected the three files by ticking each file's checkbox individually.
Result: New files and folders won't be appended to backup.
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Hidden and System files are made selectable in GBM only if they were visible in Windows
Explorer. You can set GBM to always hide files with hidden or system attributes so that they
would not to be included in the backup, regardless of their status in Windows Explorer. To do so,
click Tools, then select Global Preferences, select Backup Settings, then remove the check
mark next to Show hidden files/folders in My Folders.
On a Microsoft Windows Network if you share a folder that has a dollar sign '$' at the end of its
name, then it is considered to be hidden and other machines cannot see it, unless you explicitly
enter its name in the address bar or the command prompt. Users can add this kind of sources to
the backup selection by manually typing the complete path in the Manual File Selection panel.
To add a new item, click Add, then type the full path to file or folder. Select Include subfolders if you wish child folders to be included in backup.

File Filtering
File Filtering
Users can filter selected files in My Folders based on filename, date, and size criteria. For
instance users can choose to backup only .doc files in a certain folder or exclude all files that
start with the letters (sa), backup files created between May and June this year, and/or not to
include files/folders larger than 2GB.
Filters are applied to sources through rules consisting of an include filter or an exclude filter.
Only one restriction type (include or exclude) can be assigned per rule. During backup, Genie
Backup Manager processes only files that match the include filter and do not match the exclude
filter. If a file satisfies both an include filter rule and an exclude filter rule, the exclude filter
takes precedence and the file is not processed.
Rules are composed from restrictions created with one or more filename masks separated by a
semicolon. If a file satisfies at least one restriction, the rule will apply.





Filters are not reflected in the file/folder selection tree, they are only processed during
backup.
A rule can be attached to any folder but is only processed if the folder was selected for
backup.
If a rule is created for a folder "m1" and another rule is created for one of its decedents
(sub folders) "\m1\m2", Genie Backup Manager will process the subfolder (m2)'s distinct
rule regardless of the rule of parent folder (m1).

How to: Create New File Filters
1.
2.
3.
4.
5.

From the navigation menu of the backup wizard select What to Backup.
Select My Folders tab.
Click File Filters.
Click Create Rule.
Select one of the following options:
 All data: Apply created filter to all selected files and folders in the backup job.
 Selected folder: Apply created filter to the folder that was highlighted prior to
opening the File Filters dialog.
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 Browse for folder: Select a folder to attach the created filter to.
6. Click Ok to return to the main dialog.
7. Select one of the following two options:



Include only file with the following mask: Only files matching the specified
file mask will processed during backup.
Exclude files with the following mask: File matching the specified file mask
will not be processed.

8.
Type the name or part of the name of files you wish to filter. You can use wildcard
characters to filter files that include a certain part of the name. For instance *.doc will filter all
files with the extension doc. You can add more than one file mask per rule, use a semicolon (;)
as a separator.
9.
If you wish to apply the created rule to the decedents of the selected folder, select
Include Sub folder
10.
Click More options to enable filtering by size and date.



Filtering by Size
You can create individual filtering by size or add them to existing rules by
the following steps:
1. In the File Filters... dialog, click More Options
2. Click Enable filtering by size and select one of the following
options:






Between: Backs up files/folders between specified file
size range
Less: Backs up files/folders less than the specified size
More: Backs up files/folders larger than the specified
size

Filtering by Date
You can create individual filtering by date or add them to existing
rules by the following steps:
1. In the File Filters... dialog, click More Options
2. Click Enable filtering by Date and select one of the
following options:





Between: Backs up files/folders between
specified dates
Before: Backs up files/folders older than the
specified date
After: Backs up files/folders newer than the
specified date

Quickly Adding a File Extension to a Previously Created Filter
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From the My Folders tab in the What to Backup wizard screen right-click on
the folder then choose Add rule to this folder.

How to: Import and Export File Filters
File filter rules can be exported from one backup job so as to be imported and used again in
another.
Exporting File Filtering Rules to File
1.
2.
3.
4.

Open the File Filters dialog.
Select Export.
Choose a location to save the file to.
Click Ok.

Importing File Filtering Rules from File
1. Open the File Filters dialog.
2. Select Import, then select Import from File.
3. Browse to the location of the filters ".gix" file and select it, then press OK.

Importing Filters from Another Backup Job:
1. Go to My Folders.
2. Click File Filtering Rules.
3. Select Import, point to Import from Backup Job, then choose a backup job from the
list.

Auto-Exclude
Some system files and folders on the computer are not intended to be moved or copied, and are
accessed only by the Windows system, trying to backup these files will cause an error in GBM,
so, to avoid running into backup problems, GBM does not process these sources during backup
in any of the defined backup jobs. You can add custom Auto exclude rules to treat specific files
and folders in the same manner.
Adding an Auto Exclude rule:
1.
2.
3.
4.
5.
6.
7.

Click Tools in the toolbar, then select Global Preferences.
Select Auto Exclude.
Click Add.
Type the full path of the file/folder to be excluded. You can use wildcards here.
Type a description for the added item.
Click Ok.
Restart GBM.
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To disable all Auto-Exclude rules uncheck the option Enable Auto Exclude.
To remove and Auto-Exclude rule, select it from the Auto-Exclude list then click
Remove.

Using Wild Cards
A wildcard character is a keyboard character such as an asterisk (*) or a question mark (?) that
is used to represent one or more characters when referring to files and folders.

Wildcard
Characters
Usage

Use the asterisk as a substitute for zero or more characters. If you
are looking for a file that you know starts with "gloss" but you cannot
remember the rest of the file name, type the following:

Asterisk (*)

gloss*
This locates all files of any file type that begin with "gloss" including
Glossary.txt, Glossary.doc, and Glossy.doc. To narrow the search to a
specific type of file, type:
gloss*.doc
This locates all files that begin with "gloss" but have the file name
extension .doc, such as Glossary.doc and Glossy.doc.

Question mark
(?)

Use the question mark as a substitute for a single character in a
name. For example, if you type gloss?.doc , you will locate the file
Glossy.doc or Gloss1.doc but not Glossary.doc.

Restore
How to: Restore Files and Folders
1.
2.
3.
4.

Open the restore wizard.
Load the backup, then click Next.
Select the My Folders tab.
Choose the files and folders you wish to restore.

File Attributes
During backup, files attributes, including the modified date and time stamp, might change
depending on factors such as the storage device being used, file splitting, file system etc ... GBM
saves this information during backup and reassigns each file its correct attributes during restore.
To disable restoring file attributes:
1. Open the restore wizard.
2. Load the backup, then click Next.
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3. Select My Folders tab.
4. Click Advanced.
5. Uncheck the option Restore file attributes.

How to: Restore to a Different Location
By default, restore returns each file and folder selected for restore to the original path from
where it was backed up. Genie Backup Manager can be set to restore the data to a different
user-specified path.
1.
2.
3.
4.

Open the restore wizard.
Load the backup, then click Next.
Select My Folders tab.
From the Restore file to combo box, choose one of the following options:





Original location: restore each file and folder to its original path.
Alternative: restore data to the specified path, while maintaining the original
folder tree structure.
Single folder: restore data to the specified path, after collapsing the original
folder tree structure (no subfolders).

Restoring Existing Files
By default, when a file being restored already exists in the destination folder, GBM will compare
the two files' modified date and time stamps and overwrite the existing file only if it was older
than the one being restored.
To change this behavior:
1.
2.
3.
4.
5.

Open the restore wizard.
Load the backup, then click Next.
Select My Folders tab.
Click Advanced.
Choose one of the following options:
 Do not replace existing files.
 Replace older files.
 Always replace files.

Programs and Program Settings
Programs and Program Settings
Other backup software charge users extra for downloading plugins that allow them to extend the
software's capabilities and automatically backup additional items, such as email clients data,
application settings, instant messengers, etc... Genie Backup Manager, however, offers its users
unrestricted access to hundreds of plugins from the constantly growing Genie9 add-ins database
free of charge.
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Genie Backup Manager comes bundled with several popular plugins, which users can select for
backup from the My Plugins tab in the backup wizard. Extra plugins can be downloaded by
typing the name of an application in the Easy plugin search and download box then clicking
Go; GBM will search the database and return a table of downloadable plugins matching that
keyword.
My Plugins lists all installed plugins, but only those connected to applications detected on the
system will be selectable.
Users can also use GBM's XML-based scripting to create new plugins, and share them with
friends, colleague, and other GBM users.

How to: Back Up Programs and Program Settings
1. From the left navigation menu in the backup wizard select What to Backup.
2. Select My Plugins tab.
3. Select items you wish to backup.

Adding and Removing Plugins
Extra GBM plugins can be obtained and installed using the following methods:





Searching for new plugins in the Genie9's database and downloading them.
Creating custom plugins using GenieScript.
Visiting the Genie9 community forums, and requesting a new script to be written for the
program/item you wish to backup, Genie9 support team and other GBM users will do
their best to help you.

How to Search for Plugins?
1. From the left navigation menu in the backup wizard select What to Backup.
2. Select My Plugins tab.
3. In the Easy plugin Search and download field, type the name, or part of the name, of
the application or item you wish to be able to backup, then click Go.
4. Click the Download button next to the plugin you wish to install.

Installing a plugin:
Simply double-click the plugin file to install it.

Removing a plugin:
Right-click the plugin, then select Remove selected.
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How To: Restore Plugins
1.
2.
3.
4.
5.

Open the Restore wizard.
Load the backup, then click Next.
Select the My Plugins tab.
Choose the Plugins you wish to restore.
Select Restore Destination (Per Plugin)
 Restore to Default Location: Restores data to the currently installed program
location.
 Restore to Alternate Location (if applicable): If the plugin is a full
application backup, the user can specify a new location to restore the data as if
you are installing the program in a new location.

Tip
To undo plugin restoration, see Plugin Rollback

Plugin Rollback
Restoring of data backed using plugins can be reversed with the help of the GBM restore-undo
utility.
1. From the toolbar, click Tools, then select Undo Plugin Restore. A list of all restored My
Plugins items will open.
2. Select an item from the list and click Uninstall.
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Backup Types
Backup Types
There are four types of backups supported by GBM that depend on whether the user wants to
backup all the selected data, or just new and changed files. Backup types are: Full, Incremental,
Differential, and Mirror.
The first run always backs up all selected files and folders, and a backup catalog (.gbp file) is
stored on the destination media. On subsequent runs, Genie Backup Manager searches for the
catalog ".gbp file" in the destination. If the media is empty or it does not contain the catalog file,
GBM will start with a new full backup. If the catalog file is found, GBM will make a new version,
with a new version of the catalog file, depending on the selected backup type and versioning
settings.





Genie Backup Manager also stores a local copy of the catalog file on the computer on
which the backup is performed. If you do not wish GBM to look for the file in the
destination media - for instance, to store different versions on separate media volumes you can set GBM to read the index from the local catalog.
You can disable reset archive bit, if you do not want GBM to reset archives. This option
will not affect on the backup jobs ran on GBM

Notes:
Differential, incremental, and mirror backups are not supported in Easy mode

Full Backup
When a user selects Full backup, GBM will back up all the selected files and folders each time the
backup job is run. New files will also be appended to the selection. On consecutive runs, in
general, this backup type is more time and space consuming than the other three backup types,
but is more user friendly.
To set GBM to always run a full backup, select Full, from the Settings screen in the backup
wizard.



This backup type is best for one-time backups to migrate data between computers.

Incremental Backup
In incremental backup, the first run always backs up all selected files and folders, and a backup
catalog (.gbp file) is stored on the destination media. On subsequent runs, Genie Backup
Manager searches for the catalog ".gbp file" in the destination. If the media is empty or it does
not contain the catalog file, GBM will start with a new full backup. If the catalog file is found,
GBM will create a new backup version, containing only files that have been added or modified
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since the previous run. A new version of the catalog file will be appended to the media, and files
that were deleted, renamed or moved from the source machine will not be deleted from the
backup archive, but they will not be included in the last version of the catalog.
To set GBM to use incremental backup, select Increment, from the Settings screen in the
backup wizard.



Incremental backup, by default, uses the files' "modified date and time" attribute to
determine which files have been modified since the previous backup run.

Rollback
Enabling rollback during increment backup will cause GBM to keep old versions of modified files
backed up in previous runs; this way the user can still restore (rollback to) any backed up older
version of a certain file to protect against losing data by mistake.
With rollback enabled, each backup run will create a new file on the destination media - or a new
folder if compression was disabled - containing new and changed files, and a new catalog ".gbp
file" will be added to the root backup folder, with a trailing number appended to the filename;
this number will be incremented by one for each new version, starting with zero (0) on the
second run.
Example:

Backup Job.gbp ... First run.
Backup Job.0.gbp ... Second version.
Backup Job.1.gbp ... Third version.
Backup Job.2.gbp ... Fourth version.

Disabling rollback means that GBM will append new files to the original backup file/folder, while
modified files will overwrite older versions.
When backup using compression is selected, if the data after compression exceeds 2GB in size,
rollback will be forced.
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The catalog will only contain one entry during incremental backup with rollback disabled.
Each new version catalog will replace the previous one.
Disabling rollback is not supported when FTP or Amazon S3 Media types are selected.
Backup without rollback is not supported when media is not re-writable, or if the user
does not have delete permission on the destination.
To backup to CD/DVD with rollback disabled, media needs to be re-writable and packet
writing enabled.
Backup without rollback is not supported when spanning to more than one location
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Differential Backup
In differential backup, the first run always backs up all selected files and folders, and a backup
catalog (.gbp file) is stored on the destination media. On subsequent runs, Genie Backup
Manager searches for the catalog ".gbp file" in the destination. If the media is empty or it does
not contain the catalog file, GBM will start with a new full backup. If the catalog file is found,
GBM will create a new backup version, containing only files that have been added or modified
since the most recent full backup. A new version of the catalog file will be appended to the
media, and files that were deleted, renamed or moved from the source machine will not be
deleted from the backup archive, but they will not be included in the catalog.
To set GBM to use differential backup, select Differential, from the Settings screen in the
backup wizard.
Each backup run will create a new file on the destination media - or a new folder if compression
was disabled - containing new and changed files, and the new catalog ".gbp file" will be added to
the root backup folder, with a trailing number appended to the filename; this number will be
incremented by one for each new version, starting with zero (0) on the second run.
Example:

Backup Job.gbp First run.
Backup Job.0.gbp Second version.
Backup Job.1.gbp Third version.
Backup Job.2.gbp Fourth version.



Differential backup, by default, uses the files' "modified date and time" attribute to
determine which files have been modified since the previous backup run.

Mirror Backup
In mirror backup, the first run always backs up all selected files and folders, and a backup
catalog (.gbp file) is stored on the destination media. On subsequent runs, Genie Backup
Manager searches for the catalog ".gbp file" in the destination. If the media is empty or it does
not contain the catalog file, GBM will start with a new full backup. If the catalog file is found,
GBM will create a new backup version, in which new files will be appended to the original
archive, modified files will replace older versions, and files that are missing from the source
machine will be removed from the backup archive. The catalog ".gbp file" will be replaced with a
new version. The resulting backup archive consists of either one compressed file or one folder.
To set GBM to use mirror backup, select Mirror, from the Settings screen in the backup wizard.
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Limitations of Mirror Backup









When backup using compression is selected, if the data after compression exceeds 2GB
in size
The catalog will contain only one entry when mirror backup is enabled, with new
versions of the catalog replacing old ones.
Mirror backup is not supported when FTP backup is selected.
Mirror backup is not supported when Amazon S3 backup is selected.
Mirror backup is not supported when media is write protected, not rewritable, or if user
does not have delete permission on the destination.
To use mirror backup to CD/DVD, the media needs to be re-writable with packet writing
enabled, and limited to only one disc.
Not supported when spanning to more than one location

Security in GBM
Security in Genie Backup Manager
Genie Backup Manager offers multiple levels of protection to ensure that backed up data is not
accessible to unauthorized persons. ZIP passwords offer moderate protection for compressed
backups, with the added flexibility of being compatible with most compression utilities, to allow
users to manually restore data from backup archives, while AES encryption has the advantage of
being highly secure, as it is adopted by NIST as an FIPS-approved (Federal Information
Processing Standard) symmetric encryption algorithm that may be used by U.S. Government
organizations (and others) to protect sensitive information

Zip Password Protection
Genie Backup Manager uses standard zip format compression, and thus can add a standard zip
compression password to the created archive; using this protection method would still allow
users to access their data using ZIP-compatible compression utilities. Users will not be able to
browse or restore files and folders stored inside a ZIP-password-protected backup until they
enter their passwords.




This method only offers moderate protection; it is not recommended for securing
sensitive data.
ZIP passwords cannot be less than 6 characters long.

To add zip password protection to a backup job:
1. From the left navigation menu in the backup wizard select Settings.
2. From the Security box select Password Protection.
3. Type a password twice in the Password and Confirm Password fields
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Encryption
Encryption
Encryption is encoding data to prevent any non-authorized party from reading or changing it.
The level of protection provided by encryption is determined by an encryption algorithm. The
contents of the data that you want to protect are encrypted based on a password that you
specify. In order for GBM later restore the original contents of the encrypted files, the correct
password must be supplied

AES Encryption
GBM uses AES encryption. AES is the Advanced Encryption Standard. This encryption method,
has been adopted by NIST as an FIPS-approved (Federal Information Processing Standard)
symmetric encryption algorithm that may be used by U.S. Government organizations (and
others) to protect sensitive information
GBM supports AES encryption in 3 different strengths: 128-bit AES, 192-bit AES and 256-bit
AES. These numbers refer to the size of the encryption keys that are used to encrypt the data;
the higher the number the stronger the encryption, at the expense of being slightly slower. All
three methods can provide significantly greater security than the password protection method.
The strength of encryption does not depend only on the length of the encryption key used but
also on the password supplied by the user. Please read more about Encryption Passwords



GBM requires that the correct password be supplied before the contents of an encrypted
backup set can be viewed or restored to its original unencrypted form. The password is
not required, however, for actions that do not require access to the unencrypted
contents of the file. In particular, encrypted files can be deleted from backup set, or can
be replaced within the backup set, without a password

Notes on encryption safety
Encryption can be a very effective measure for protecting your sensitive data; however, even
encrypted documents can be compromised . The following is a list of some of the ways in which
the safety provided by encryption can be compromised. Note that these are not GBM related
risks but rather risks that arise from mishandling the password or a file in its unencrypted form
If a keystroke monitor (key-logger) or other malicious code (such as a trojan horse) is running
on your computer, your password may be recorded when you type it. Be sure to check
frequently for viruses and follow other recommended computer safety procedures
If you extract an encrypted file and then delete it, it may be possible for someone to later
"undelete" the file using file recovery software or the Recycle Bin. You can use the Genie Wipe
tool to irreversibly delete sensitive files
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When you extract, open or view a file directly from the backup set (using Catalog or from the
Restore Wizard), GBM must extract the file to a temporary location so that the associated
program can open it. If you subsequently close GBM without first closing the program that is
using the file, GBM may not be able to delete the temporary copy of the file, thereby leaving it
on disk in unencrypted form. The associated program may also make one or more backup copies
of the decrypted file, and GBM will not be able to delete these
After backing up or restoring encrypted files, some or all of the unencrypted file contents may
remain in your computer's memory or the page swap files on disk. A malicious user may be able
to retrieve this unencrypted information

Using Encryption in Backup
GBM can protect backed up data from being accessed by unauthorized people using AES
encryption. GBM encrypts data on-the-fly, meaning that it encrypts files as they are being copied
to the backup storage device instead of first encrypting the entire data then backing it up.
To add AES encryption protection to a backup job:
1.
2.
3.
4.
5.

From the left navigation menu in the backup wizard select Settings.
Select AES Encryption.
Type a password twice in the Password and Confirm Password text input boxes.
Click Encryption Strength.
Choose an encryption level.

Note





Encryption applies only to the contents of backed up files. Information about an
encrypted file, such as its name, date, size, and attributes, can be viewed, without a
password, by anyone who has access to the backup set.
Encryption is not supported in Easy Mode
Please store the password in a safe place. If lost, the backed up data is irretrievable.

Decrypting data during restore
Upon selecting a backup set with encryption protection for restore, GBM will request the
encryption password. The user will not be allowed to browse, view, extract or restore data
unless the correct password is supplied.

Encryption Passwords
The security of your data depends not only on the strength of the encryption method but also on
the strength of your password, including factors such as length and composition of the
password, and the measures you take to ensure that your password is not disclosed to
unauthorized third parties.
You should keep the following considerations in mind when choosing passwords for your files:
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Encryption password cannot be less than 6 characters long









In general, longer passwords are more secure than shorter passwords. To take
maximum advantage of the full strength of AES encryption passwords lengths must be
approximately:
 15 characters for 128-bit encryption.
 23 for 192-bit encryption.
 31 characters for 256-bit encryption.
Passwords that contain a combination of upper and lower case letters, digits, and
punctuation are more secure than passwords containing only letters.
Because you can use spaces and punctuation, you can create "pass phrases" that are
long enough but still easy to remember and type.
Avoid using easily guessed passwords such as names, birthdays, Social Security
numbers, addresses, telephone numbers, etc...
Avoid storing the password on the same volume on which the encryption data is located.
Keep a record of the passwords you use and to keep this record in a secure place. GBM
has no way to access the contents of an encrypted file unless you supply the correct
password.

Pre and Post Job Commands
To run commands before or after backup is completed, users can use the Pre and Post Job
Commands option.
These are some of the helpful tasks that a user can accomplish using pre, pre-backup and post
commands...
Task

Command(s)

Checking disk drives for errors before backup.
Copying, moving, deleting and replacing files and folders.

CHKDSK
COPY, XCOPY, RENAME,
REPLACE, MOVE, DEL

Defragmenting a drive before or after backup.
Temporally disabling real-time antiviral software to speed up
backup.

DEFRAG
Refer to the command line
options section of your
anti-virus help
documentation.
PRINT

Printing documents (such as the activity log when backup is
done).
Shutting down, logging off or restarting the computer.

SHUTDOWN

For a complete list of Windows system commands that can be used, open the Start menu, click
Run, type CMD and click Ok, then type help and press enter. for more information on using a
specific command type "<command> /?" in the command prompt then press enter.

To attach pre/post job commands to a backup job:
1. From the left navigation menu in the backup wizard select Settings.
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2. Click More Settings then select Pre & Post Job Commands.
3. Make sure the Enable Pre & Post Job Commands option is checked
4. From the Events list select whether to attach a pre, post, or pre-data confirmation job
command.
5. Make sure Enable Command is selected.
6. In the Command Line box, type the command you wish to be executed or browse for a
.batch, .cmd or script file you wish to execute for multiple commands
7. If you do not wish for one process to run until the previous one in the sequence has
finished, make sure the Wait until previous process ends option is selected. Other
wise the command and the backup job will run almost simultaneously.

Environmental Variables
Output files from backup jobs have varying names, depending on the backup job name and the
number of the backup run. Using special environmental variable strings, you can write
commands and pass the backup job's output files as parameters without having to worry about
their changing names:
$BACKUPOUTPUT$
$LOGFILE$

Resolves to the complete path of the main backup file/folder.

Resolves to the complete path of the backup log file.

$BACKUPPRFOLDER$
backup set.

Resolves to the complete path of the parent folder containing the

$BACKUPFILENAME$

The name of the output backup file, without the path.



Environmental variables passed to commands must be enclosed in quotations, such as
"$BACKUPOUTPUT$".

Built-In Commands
When using the following commands, Genie Backup Manager will open a dialog displaying the
progress of the command execution. Each one of these commands takes two parameters:





Copy: Copy a file or folder to a new location.
Move: Move a file or folder to a new location. The file/folder in the original location will
be deleted.
Rename: Rename a file or folder.

Understanding Backup Sets and Purging
When the storage media is re-writable, and the user has the right folder privileges, Genie
Backup Manager can be set to delete old backup files created by the backup job, to save space.
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The way purging old backups works varies depending on the backup type used. Purging is not
supported when Mirror Backup is used .

To set GBM to purge old backup files created by a backup job:
1. From the left menu in the Backup Wizard, select Settings.
2. Click Purge Settings.
3. Select one of the following options:





Keep old backups: Do not delete old backups
Keep only last X backups: Keep only the last X backup files and delete files
produced by older backups
Keep old backups for a period of X days: Delete any backup file older than X
days

Backup Sets
To understand how purging works in Genie Backup Manager, the user needs to be familiar with
the concept of Backup Sets. For the purpose of this help documentation, a backup set is the
minimum collection of backup files - or folders, in the case of backup without compression - that
are needed to successfully perform a restore. For example, if the user wishes to restore files that
were backed up using an incremental backup job on March 23rd, then every backup file created
by this backup job since that date and back to the most recent full backup before that date
should be present and are considered a backup set.
Purging works with backup sets and not backup runs. if the user chooses to "keep the last 5
backups", that means that Genie Backup Manager will always keep the most recent 5 backup
sets created by that job.

Purging with Full Backup
Full backup copies all the selected files each time the backup is performed. Each time a full
backup is performed, a new backup set is created, and a bracketed number after the backup job
name is incremented by one, to denote the backup run number.
Since each backup run creates a backup set, keeping the last X backup sets means keeping the
backup files produced by the most recent X backup runs.
Ex:
A full backup is performed, job name is "My_backup", and purging option selected is "keep only
last 4 backups".
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1st run My_backup.gbp is created
2nd run My_backup(1).gbp is created
3rd run My_backup(2).gbp is created
4th run My_backup(3).gbp is created
5th run My_backup(4).gbp is created and My
backup.gbp is deleted
6th run My_backup(5).gbp is created and My
Backup(1).gbp is deleted
7th run My_backup(6).gbp is created and My
Backup(2).gbp is deleted

Purging with Incremental Backup
During incremental backups, the first backup run performed after the backup job is created is a
Full backup, subsequent backup runs are all incremental until the user elects to reset the backup
job to full, either manually or automatically using the "Limiting increments" feature. GBM treats
each full backup and all subsequent increments until the next full run as a complete backup set.
For each backup run that is performed, a number after the backup job name is incremented by
one, when backup is switched to full, that number is reset and another bracketed number is
incremented by one to denote the number of full backups performed since the backup job was
created.
When purging is selected, backup rotation is forced, which means that after a certain number of
incremental backups, Genie Backup Manager will automatically reset the backup type to full for
one backup run, then performs another set of incremental backup runs, then resets to full again,
and so on.
If the user enables purging with the option to "Keep only last X backups", Genie Backup Manager
will reset backup type to full "full" X time, and on the X+1 run, it will delete the oldest backup
set.
Example
An incremental backup is performed.




Job name: "My_backup"
Purging option: "keep only last 3 backups"
 Backup rotation: 2 increments.

* Bold denotes the creation of a new backup set.

1st run
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My_backup.gbp is created (Full backup) .
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2nd run

My_backup.0.gbp is created (increment).

3rd run

My_backup.1.gbp is created (increment).

4th run

My_backup(1).gbp is created (Full backup) .

5th run

My_backup(1).0.gbp is created (increment).

6th run

My_backup(1).1.gbp is created (increment).

7th run

My_backup(2).gbp is created (Full backup) .

8th run

My_backup(2).0.gbp is created (increment).

9th run

My_backup(2).1.gbp is created (increment).

10th run

My_backup(3).gbp is created (Full).
My_backup.gbp, My_backup.0.gbp &
My_backup.1.gbp are deleted

11th run

My_backup(3).0.gbp is created (increment).

12th run

My_backup(3).1.gbp is created (increment).

13th run

My_backup(4).gbp is created (Full).

Backup Set

Backup Set

Backup Set

My_backup(1).gbp, My_backup(1).0.gbp &
My_backup(1).1.gbp are deleted

Purging with Differential Backup
During differential backups, the first backup run performed after the backup job is created is a
full backup, subsequent backup runs are all differential until the user elects to reset the backup
job to full, either manually or automatically using the "Limiting increments" feature. Each
differential backup along with the most recent full backup combined form a standalone backup
set. Backup files produced in between those two backups can be deleted safely.
Purging with "Limit increments" option enabled
If purging was selected and the "Limit increments" option was enabled for X increments.
Genie Backup Manager will automatically reset the backup type to full after every X
differential backup runs. Purging in this case will treat each full backup run with all
subsequent consecutive differential runs as a backup set, and purging will work exactly
like in the case of incremental backup.
Purging with "Limit increments" option disabled
If purging is selected with the "limit increments" option disabled, Genie Backup Manager
will treat each differential backup run along with the most recent full backup as a
standalone backup set. Thus, the option to "Keep only last X backups" means that only
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the full backup run, the last differential backup, and the most recent X intermediate
backups are kept.

Example
An incremental backup is performed.





Job name: "My_backup"
Purging option: "keep only last 3 backups"
Limit increments: disabled.

1st run

My_backup.gbp is created (Full backup) .

2nd run

My_backup.0.gbp is created (Differential).

3rd run

My_backup.1.gbp is created (Differential).

4th run

My_backup.2.gbp is created (Differential).

5th run

My_backup.3.gbp is created (Differential).
My_backup.0.gbp is deleted.

6th run

My_backup.4.gbp is created (Differential).
My_backup.1.gbp is deleted.

7th run

My_backup.5.gbp is created (Differential).
My_backup.2.gbp is deleted.

8th run

My_backup.6.gbp is created (Differential).
My_backup.3.gbp is deleted.

Rotating Backups
When increment or differential backup is used, the user can set GBM to automatically switch to
full backup after a specific number of increments. Each full backup and its subsequent
increments are treated by GBM as one backup set, enabling the user to purge old backup sets
safely.
To set GBM to limit the number of increments for each backup set:
From the left menu in the Backup Wizard, select Settings
1. Click Purge Settings.
2. Select the Limit increments option.
3. In Number of increments, type the number of increments you wish GBM to perform
before switching to full backup .
Note
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Purging is not supported in the following cases:





When the backup is spanned to multiple locations
Backing up using the built-in CD/DVD burner
FTP and Amazon S3 backups

Understanding Archive Bit and Backup Types
The archive bit is a file attribute that is set whenever a file is modified. For backups that use
archive bits, this bit is turned off after the backup completes, indicating to the system that the
file has been backed up. If the file is changed again before the next backup, the bit will be
turned on and Genie Backup Manager will back up the file.
Whenever a file is created or changed, the operating system activates the Archive Bit or
modified bit . By default, unless you specifically select to use the archive bit, Genie Backup
Manager uses the last modified date and time stamp to determine whether a file has been
backed up.
Using the archive bit in determining changed files, however, can cause confusion if the user is
not careful, if the data selection for more than one backup job overlap. To explain this, consider
this scenario: Jack has two backup jobs that he has scheduled to run consecutively, named
Documents and Work . The folder Monthly Reports was selected to be backed up by both backup
jobs. Come backup time, the job Documents, will backup the folder the turn off the archive bit.
When its time for the job Work to run, it will find that the folder has already been backed up and
skips the folder.
When the archive bit method is used with full, increment or mirror backup, GBM will turn off the
archive bit after each backup run. However, when used with differential backup, GBM will only
reset the bit in the first full backup, but not in subsequent differential runs, this way, GBM will
always keep backing up files that have changed since the first full backup.
To set GBM to reset the archive bit after backup:
1. From the left menu in the backup wizard Select Settings.
2. Click More Settings then select Advanced Settings.
3. Select Reset the Archive Bit.

To use the archive bit in determining changed files:
1. Click the Start menu in the Windows toolbar, then select Run.
2. Type regedit.
3. Browse the registry until you reach the following key:
HKEY_CURRENT_USER\Software\Genie-Soft\GBMAPPLICATION\Main\
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4. Double-click the value CompareMethod.
5. Set the value to 0 (zero).

Adding a Timestamp to the Backup File
A timestamp is a combination of date + time that is appended at the end of the backup filename
to indicate when the backup run was performed
To attach a timestamp to the backup set:
1.
2.
3.
4.
5.

From the left navigation menu in the backup wizard select Job Info.
Click Backup Filename Options.
Select Attach timestamp to backup set.
From the Timestamp format combo-box choose preferred date/time format.
Click Ok.

Timestamp formats
Timestamp formats are:










Month dd, yyyy@hh:mm:ss AM/PM
Day of the week, Month dd, yyyy
Month dd, yyyy
yyyy-mm,dd
Month dd
mm-dd-yyyy@hh-mm AM/PM
mm-dd-yyyy@hh-mm-ss AM/PM
hh.mm.dd AM/PM

Rotating Backup Types
When increment or differential backup is used, the user can set GBM to automatically switch to
normal backup after a specific number of increments. Each full backup and its subsequent
incremental or differential executions are treated by GBM as one backup set, enabling the user
to purge old backup sets safely.
To set GBM to limit the number of increments for each backup set:
1.
2.
3.
4.

Notes:
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From the left menu in the backup wizard, select Settings.
Click Purge Settings.
Select the Limit increments option.
In Number of increments, type the number of increments you wish GBM to perform
before switching to full backup.
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Since purging is not supported on FTP, Amazon S3, backups spanned to multiple drives/media,
and CD/DVD using buring method,use Advanced Schedule to rotate backup types.
If Advanced schedule is enabled and the backup is running via schedule, it will overwrite purge
settings. To avoid conflicts only use purge settings with Basic scheduler else, use advanced
scheduler and disable purging.

Compression
Genie Backup Manager uses non-proprietary ZIP64 compatible compression to reduce backed up
data size and save space, supporting up to 264 -1 files within a zip archive as well as files that
have a size greater than 4GB, for a zip file size that can reach up to about 18 million terabytes (
more precisely, 2^64-1 bytes).
The Genie Backup Manager compression engine offers fast performance and low memory usage.
Speed improvements reach 25%-75% in certain contexts. It also provides 15 to 20% better
compression than other formats on many popular file types, especially XML data.
Users can choose between 9 levels of compression ranging form no-compression, to best.
To set GBM to compress backed up data:
1. From the left navigation menu in the backup wizard select Settings.
2. Select Use Compression.
3. Select the desired compression level from the combo box.

Backup without Compression
Selecting to backup data without compression would cause GBM to copy the data to a folder on
the storage device while preserving the original file/folder structure, this makes data more
accessible and less susceptible to corruption.

Power Management Options
Users can set Genie Backup Manager to trigger a power-saving event after a backup job has
been executed. Allowed options are:







Exiting Genie Backup Manager.
Shutting down computer.
Setting computer on Hibernate mode.
Logging off computer.
Setting computer on Stand-by mode.

To configure power-saving options for a backup job, select the Settings screen from the backup
wizard, click More Settings, then select Advanced Settings. Selected power-saving options
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must be supported by the computer. To configure power management settings for your
computer, double-click Power Options in the Control Panel.

How to: Create Backup Shortcuts on the Desktop
Users can create shortcuts on the desktop area for created backup jobs for easy access.
Shortcuts also run backup jobs without the need to go through the backup wizard.
To create a shortcut for a backup job:
1. Open Jobs Manager.
2. Select a backup job.
3. Click Create Shortcut.

How to: Create Self-Restorable Backups
Genie Backup Manager offers users a feature that enables them to restore their backed up data
to any machine regardless of whether GBM is installed on it. Choosing Enable Self-Restorable
backup option creates a standalone self-executable .exe file on the storage media, which can be
used to browse backed up data and restore it on any machine, even if GBM is not installed on it.

How to Create a Self-Restorable Backup Archive?
1. Open the backup wizard.
2. From the left navigation select Settings.
3. Select Enable Self-Restorable Backup.

One-File SwiftRestore
If the data is backed up using compression, and is less than 200MB after compression, Genie
Backup Manager will turn the entire backup set into one self-executable file. Otherwise, the
software will create a separate .exe file in the same folder as the backup set; However, the user
can specify to create a larger one file swift restore file by the following steps:
1.
2.
3.
4.

Notes
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Go to Tools, then select Global Preferences.
Click the plus icon next to Backup Settings then select Advanced Settings.
Make sure Enable one-file self-restorable backups is selected.
Select a preferred size from the drop-down menu, or type a custom value (maximum 2
GB).
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One-file self-executable backups is not supported when backup data is spanned over
multiple volumes or forced to split.

Extracting the Backup Archive from a SwiftRestore File
If the SwiftRestore .exe file got corrupted, users can extract the backup archive from the selfexecutable file:
1. From the toolbar click Tools, then select Extract archive from .exe file.
2. Click Browse to locate and select the desired self-executable backup file.
3. Click Extract. The extracted backup set will be stored in the same folder as the original
SwiftRestore .exe file

Command Line Parameters
Genie Backup Manager can be started with various command line parameters to execute
different actions on a particular backup job, such as loading and running a backup job, running
the application minimized, alternating between backup types, shutting down the computer after
backup etc. The parameters can be used to create shortcuts which start backup tasks
automatically.
Syntax

GBM9 [-e] [-job "backup job name"] [-h] [-noexit] [-showlogfile] [-novalidate] [-bt|1 2 3 4] [-shutdown|
1 2 3 4]

Parameters

Command

Result

-e

Activate the Command Line engine.

-job "job name" Name of the backup job to be performed.
-novalidate

Do not verify backed up data after backup.

-h

Run the backup monitor minimized when backup starts.

-showlogfile

Display backup log when backup is complete.

-noexit

Do not exit Genie Backup Manager after backup.

-bt

Specify backup type to be used with this backup run.
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-shutdown

-bt1

Force running the backup job in full mode (backup all selected
files).

-bt2

Force running the backup job in increment mode.

-bt3

Force running the backup job in mirror mode.

-bt4

Force running the backup job in differential mode.

Choose power saving option to be executed when backup is complete.
-shutdown1
-shutdown2
-shutdown3
-shutdown4
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Shutdown computer.
Hibernate.
Logoff.
Standby.

Data Scheduler
Data Scheduler
Backing up data can take a lot of time depending on the size of the data intended for backup,
during which a large portion of the machine's resources are consumed by the backup application.
To avoid interrupting work or slowing down the machine while it is being actively used, users can
schedule backup tasks to run unattended at times that guarantee no interruptions to their work.
Scheduling also insure that the data is being backed up on a regular basis without user
interaction.
Scheduling Backups are Step 5 in the Backup Wizard. GBM enables users two modes of backup
scheduling in normal mode:
Basic Schedule: Schedule your backup Daily, Weekly, Monthly, Once, or at Windows login
Advanced Schedule: This option enables the user to schedule backups, rotate backup types,
and limit backup sets in one simple step.

Basic Schedule
Scheduling is step 5 of the backup process in the backup wizard, in this step you can select how
often you wish the backup job to be executed. Available options are: Every few hours, Daily,
Weekly, Monthly, Once, and At Windows login.

How to schedule backup jobs in Basic Schedule?
1. From the left navigation menu in the backup wizard select Schedule
2. Check Enable Schedule, to enable schedule options.
3. Select how frequent you wish to run the backup:
 Run Every Few Hours: runs backup every few hours, in this option you can
also specify the days you wish the task to run
 Run Daily: Runs backup daily at a specific time
 Run Weekly: Specify the time and days you wish the backup to run
 Run Monthly: Specify the time and day of the month
 Run Once: Run this backup one time on a specific time
 Run at Windows logon: Runs every time you logon into your computer
4. Under Security Settings, you can specify if you wish to run the backup whether the
user is logged on or not. If you select Run whether user is logged on or not, you
must enter the Windows login username or password; otherwise your backup will not
run if Windows is logged out.
5. In More Settings, you can specify the following options:
 Minimize backup window when running job: Selecting this option runs the
backup job while scheduled backup window is minimized
 Do not start backup if the computer is running on batteries: You can set
this option that tells the task to run only if the computer is on AC power (not
battery power)
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Do not wait 10 seconds before starting backup: By default the scheduled
backup has a 10 second delay counter before actually running the backup.
Choosing this option will enable to run the task without this 10 second delay.
Wake up computer to run this task (if supported): If you computer is set to
sleep at the time of backup, you can choose to wake up the computer to run the
task. This option is enabled if Run whether user is logged on or not is
enabled.

Advanced Schedule
Advanced Schedule
A common practice in scheduling backups is to set the task to run backup in normal mode (all
selected files) on a weekly or monthly basis, and in increment or differential mode daily or
weekly, the recurrence of backups depends on how critical the data is and how frequently it
changes. This all can be achieved in Advanced Schedule mode

How to schedule backup jobs in Advanced Schedule?
1.
2.
3.
4.

From the left navigation menu in the backup wizard select Schedule
Check Enable Schedule, to enable schedule options.
Choose Advanced Schedule
By default, Full Backup Scheduling is always enabled as you cannot perform a
incremental/differential backup without a full backup. Select how frequent you wish to
run the backup as full backup type:
 Run Every Few Hours: runs backup every few hours, in this option you can
also specify the days you wish the task to run
 Run Daily: Runs backup daily at a specific time
 Run Weekly: Specify the time and days you wish the backup to run
 Run Monthly: Specify the time and day of the month
 Run Once: Run this full backup one time on a specific time
 Run at Windows logon: Runs every time you logon into your computer
5. Select Differential/Incremental Backup (optional) and select how frequent you wish to
run incremental/differential backup:
 Run Every Few Hours: runs backup every few hours, in this option you can
also specify the days you wish the task to run
 Run Daily: Runs backup daily at a specific time
 Run Weekly: Specify the time and days you wish the backup to run
6. Under Security Settings, you can specify if you wish to run the backup whether the
user is logged on or not. If you select Run whether user is logged on or not, you
must enter the Windows login username or password; otherwise your backup will not
run if Windows is logged out.
7. In More Settings, you can specify the following options:
 Limit Number of backup sets to (if supported by media): This option enables
GBM to keep the most recent "X" number of full backups with its
incremental/differential backups
 Minimize backup window when running job: Selecting this option runs the
backup job while scheduled backup window is minimized
 Do not start backup if the computer is running on batteries: You can set
this option that tells the task to run only if the computer is on AC power (not
battery power)
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Do not wait 10 seconds before starting backup: By default the scheduled
backup has a 10 second delay counter before actually running the backup.
Choosing this option will enable to run the task without this 10 second delay.
Wake up computer to run this task (if supported): If you computer is set to
sleep at the time of backup, you can choose to wake up the computer to run the
task. This option is enabled if Run whether user is logged on or not is
enabled.

To learn more about how to rotate backups using advanced schedule, see How to: Rotate
Backups using Advanced Scheduling
Notes:





Advanced Scheduling is not supported in easy mode
Limiting backup sets is not supported on FTP, Amazon S3, CD/DVD using burning
technology, and when the backup is spanned to multiple locations
Advanced scheduling overwrites purge settings and backup types specified in the
settings page when schedule runs. If you backup manually, it will take backup settings
from the Backup Settings page.

How to: Rotate Backups using Advanced Scheduling
Rotating backup types is recommended for more reliable backups. The following examples will
demonstrate how to perform this practice easily in advanced scheduler.
Example 1:
Perform full backups on the first Sunday of the month and differential backups weekly on
Fridays:






In the advanced schedule, under Full backup, select Run Monthly
Set the time you wish the backup to run, and then select on the first Sun of the
month
Mark the checkbox next to Differential Backup (optional) to enable differential
backup schedule
Select Run Weekly and set the time for the backup to run and under on the following
days select Fri

Example 2:
Perform full backups weekly on Sunday, incremental backups daily every 5 hours the rest of the
week, and on the beginning of a new week, delete the backups of the last week





In the advanced schedule, under Full backup, select Run Weekly
Set the time you wish the backup to run, and under on the following days select Sun
Mark the checkbox next to Incremental Backup (optional) to enable incremental
backup schedule
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Select Run Every Few Hours, in Run Every set it to 5 hours, and under on the
following days select Mon, Tue, Wed, Thurs, Fri, and Sat
Under More Settings, change Limit number of backup sets to (if supported by
media) from unlimited to 01

The Backup Monitor
When running a backup job as a scheduled backup task or from a desktop shortcut the task will
be run in a small window called the Backup Monitor.

The Backup Monitor Controls:
Help: Opens the Help documentation
Show Log...: Displays the backup log, this option is only enabled after backup completes
Abort: Aborts backup progress
Status bar: This window will display the status of the backup task along with a bar indicating
progress.
Pause: Pauses the backup, this option is enabled during the backup process
Stop Timer: Cancels the 10 second timer before backup starts, to start the backup manually,
click Start Backup
Snooze: Postpones the backup and runs it later specified in the Click Snooze to be reminded
again in. You can choose the to snooze for:








10 minutes: after 10 minutes run backup
30 minutes: after 30 minutes, run backup
1 hour: after an hour run backup
2 hours: after 2 hours run backup
8 hours: after 8 hours, run backup
1 day: run this backup the next day at the same time

Computer power options: Set or change the computer power options to be performed after
backup completes. These options are:
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No Power option: do not perform anything after backup completes
Shutdown: Shutdown computer after backup completes
Logoff: Logoff computer after backup completes
Hibernate: Hibernate computer after backup completes

Data Scheduler



Suspend: Suspend computer after backup completes

For more information about power options, see Power Management Options
Note:
You can only snooze before backup starts

117

Microsoft SQL
SQL Server
The need to back up databases on a regular basis is a major component of managing any
production system. Without proper backup of your Microsoft SQL databases, your company's
data is just one administrator's error away from disappearing permanently. Genie Backup
Manager offers quick, easy and reliable backup of your SQL Server data, without the need for
elaborate scripts.
Genie Backup Manager does NOT require disconnecting from the SQL Server in order to create a
window for backup. Administrators and users can still connect to the SQL Sever and perform
queries on the database while GBM takes a point-in-time copy of the various tables.

How to: Register MS SQL Plugin
Upon purchasing the SQL plugin, the user will receive an email containing a serial number for
unlocking the SQL Backup.
To register MS SQL plugin:
1.
2.
3.
4.

Start GBM.
Click Backup.
Under SQL Backup in Backup Category, click Register SQL plugin
Type or copy-paste the serial number into its designated field then click OK.

How to: Backup SQL Server Data
Please refer to the SQL Server Backup Strategies page for more information on the best backup
plan to adopt for your SQL Server databases.
1.
2.
3.
4.
5.
6.

From the Main Page, select Backup
In Backup Category, Select SQL Backup
From the left navigation menu in the backup wizard select What to Backup
Expand the SQL Server list, select the server instance you wish to backup from.
Mark the checkbox next to each database you wish to backup.
Click Next to continue

Important note:



Under the full or bulk-logged recovery model, before you can restore a database, you
must back up the active transaction log.
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SQL Databases
When you install SQL Server 7.0, the setup program automatically creates four system
databases along with two sample user-defined databases i.e. Pubs and Northwind. The four
system databases that play a vital role in the successful operation of SQL Server are Master,
Model, Msdb and Tempdb database.

Master Database
This database stores all critical information such as server specific configuration information,
user login accounts, running processes, system error messages, system stored procedures etc.
It also records the existence of other databases and the location of the primary files that contain
the initialization information for the user databases. So it's always preferable to have a recent
backup of this database.

Model Database
This database acts as a template for the new databases i.e. whenever you create a new
database the database objects present in this database get copied onto the new database. If you
want to perform some common operations on all user databases then you can include those
objects such as tables, procedures etc so that the new database also contains them.

Msdb Database
This is one of the system databases that play an important role in SQL server's management and
maintenance. It contains some system defined tables that are specific to this database only. The
Msdb database contains task-scheduling, exception handling, alert management and system
operator information i.e. it holds the information of all the operators such as email addresses or
pager numbers and history information about all the backups and restore operations.

Tempdb Database
As the name suggests this database stores all the temporary tables and the temporary results
generated by group by, order by, distinct clause etc. The temporary data resides on the tempdb
database till the user is connected to the SQL server. All the temporary data and tables related
to the user get dropped once the user logs out from the SQL Server. All the global variables lose
their values after SQL Server shuts down or SQL Server crashes. Tempdb auto grows as needed
and each time the system is started; tempdb is reset to its default size (i.e. 8.0 MB for data file
and 0.5MB for log file). Because Tempdb is created every time SQL Server is started, the model
database must always exist on a SQL Server system.
Important Note:
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Before attempting to restore a System database (Master, MSdb, model, or Pubs) you must
start SQL Sever in single user mode.

SQL Recovery Models Overview
In order to make backups easier to implement, Microsoft has grouped the various strategies that
can be employed into three stereotypes or models: simple, full, and bulk-logged. These SQL
Server-specific models not only help you think about your needs, but also simplify the
implementation of the appropriate strategy. The recovery models are implemented per
database, and determines how much data loss is acceptable in case of a failure and what types
of backup and restore functions are allowed.

Simple Recovery Model
This model minimizes administrative overhead for the transaction log, because the transaction
log is not backed up. The simple recovery model risks significant work-loss exposure if the
database is damaged. Data is recoverable only to the most recent backup of the lost data.
Therefore, under the simple recovery model, the backup intervals should be short enough to
prevent the loss of significant amounts of data. However, the intervals should be long enough to
keep the backup overhead from affecting production work. Including differential backups in the
backup strategy can help reduce the overhead.
Select Simple if:







Your data is not critical.
Losing all transactions since the last full or differential backup is not a problem.
Data is derived from other data sources and is easily recreated.
Data does not change often.
Space is limited to log transactions. (This may be a short-term reason, but not a good
long-term reason.)

Full Recovery Model
Provides the normal database maintenance model for databases where durability of transactions
is necessary. Log backups are required. This model fully logs all transactions and retains the
transaction log records until after they are backed up.
Select Full if:






Data is critical and you cannot afford to lose any data.
You always need the ability to do a point-in-time recovery.
Bulk-logged activities are intermixed with normal transaction processing.
You are using replication and need the ability to re-synchronize all databases involved in
replication to a specific point in time.

121

GBM User Manual

Bulk-Logged Model
This recovery model bulk logs most bulk operations. It is intended solely as an adjunct to the full
recovery model. For certain large-scale bulk operations such as bulk import or index creation,
switching temporarily to the bulk-logged recovery model increases performance and reduces log
space consumption. Log backups are still required. Like the full recovery model, the bulk-logged
recovery model retains transaction log records until after they are backed up.
Select Bulk-Logged if:





Data is critical, but logging large data loads slows down the system.
Most bulk operations are done off hours and do not interfere with normal transaction
processing.
You need to be able to recover to a point in time.

Changing Recovery Models in SQL
1. After connecting to the appropriate instance of the Microsoft SQL Server Database
Engine, in Object Explorer, click the server name to expand the server tree.
2. Expand the Databases.
3. Right-click a database, and then click Properties, which opens the Database
Properties dialog box.
4. In the Select a Page pane, click Options.
5. The current recovery model is displayed in the Recovery model list box. Optionally, to
change the recovery model select a different one from the list.
Or from the terminal, run this command ...



ALTER DATABASE {database name} SET RECOVERY {FULL | SIMPLE | BULK_LOGGED}

SQL Backup Settings
Security Options
Security in Genie Backup Manager
Genie Backup Manager offers multiple levels of protection to ensure that backed up data is not
accessible to unauthorized persons. ZIP passwords offer moderate protection for compressed
backups, with the added flexibility of being compatible with most compression utilities, to allow
users to manually restore data from backup archives, while AES encryption has the advantage of
being highly secure, as it is adopted by NIST as an FIPS-approved (Federal Information
Processing Standard) symmetric encryption algorithm that may be used by U.S. Government
organizations (and others) to protect sensitive information
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Zip Password Protection
Genie Backup Manager uses standard zip format compression, and thus can add a standard zip
compression password to the created archive; using this protection method would still allow
users to access their data using ZIP-compatible compression utilities. Users will not be able to
browse or restore files and folders stored inside a ZIP-password-protected backup until they
enter their passwords.




This method only offers moderate protection; it is not recommended for securing
sensitive data.
ZIP passwords cannot be less than 6 characters long.

To add zip password protection to a backup job:
1. From the left navigation menu in the backup wizard select Settings.
2. From the Security box select Password Protection.
3. Type a password twice in the Password and Confirm Password fields

Encryption
Encryption
Encryption is encoding data to prevent any non-authorized party from reading or changing it.
The level of protection provided by encryption is determined by an encryption algorithm. The
contents of the data that you want to protect are encrypted based on a password that you
specify. In order for GBM later restore the original contents of the encrypted files, the correct
password must be supplied

AES Encryption

GBM uses AES encryption. AES is the Advanced Encryption Standard. This encryption method,
has been adopted by NIST as an FIPS-approved (Federal Information Processing Standard)
symmetric encryption algorithm that may be used by U.S. Government organizations (and
others) to protect sensitive information
GBM supports AES encryption in 3 different strengths: 128-bit AES, 192-bit AES and 256-bit
AES. These numbers refer to the size of the encryption keys that are used to encrypt the data;
the higher the number the stronger the encryption, at the expense of being slightly slower. All
three methods can provide significantly greater security than the password protection method.
The strength of encryption does not depend only on the length of the encryption key used but
also on the password supplied by the user. Please read more about Encryption Passwords
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GBM requires that the correct password be supplied before the contents of an encrypted
backup set can be viewed or restored to its original unencrypted form. The password is
not required, however, for actions that do not require access to the unencrypted
contents of the file. In particular, encrypted files can be deleted from backup set, or can
be replaced within the backup set, without a password

Notes on encryption safety

Encryption can be a very effective measure for protecting your sensitive data; however, even
encrypted documents can be compromised . The following is a list of some of the ways in which
the safety provided by encryption can be compromised. Note that these are not GBM related
risks but rather risks that arise from mishandling the password or a file in its unencrypted form
If a keystroke monitor (key-logger) or other malicious code (such as a trojan horse) is running
on your computer, your password may be recorded when you type it. Be sure to check
frequently for viruses and follow other recommended computer safety procedures
If you extract an encrypted file and then delete it, it may be possible for someone to later
"undelete" the file using file recovery software or the Recycle Bin. You can use the Genie Wipe
tool to irreversibly delete sensitive files
When you extract, open or view a file directly from the backup set (using Catalog or from the
Restore Wizard), GBM must extract the file to a temporary location so that the associated
program can open it. If you subsequently close GBM without first closing the program that is
using the file, GBM may not be able to delete the temporary copy of the file, thereby leaving it
on disk in unencrypted form. The associated program may also make one or more backup copies
of the decrypted file, and GBM will not be able to delete these
After backing up or restoring encrypted files, some or all of the unencrypted file contents may
remain in your computer's memory or the page swap files on disk. A malicious user may be able
to retrieve this unencrypted information

Using Encryption in Backup
GBM can protect backed up data from being accessed by unauthorized people using AES
encryption. GBM encrypts data on-the-fly, meaning that it encrypts files as they are being copied
to the backup storage device instead of first encrypting the entire data then backing it up.
To add AES encryption protection to a backup job:
1.
2.
3.
4.
5.

Note
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From the left navigation menu in the backup wizard select Settings.
Select AES Encryption.
Type a password twice in the Password and Confirm Password text input boxes.
Click Encryption Strength.
Choose an encryption level.

Microsoft SQL





Encryption applies only to the contents of backed up files. Information about an
encrypted file, such as its name, date, size, and attributes, can be viewed, without a
password, by anyone who has access to the backup set.
Encryption is not supported in Easy Mode
Please store the password in a safe place. If lost, the backed up data is irretrievable.

Decrypting data during restore

Upon selecting a backup set with encryption protection for restore, GBM will request the
encryption password. The user will not be allowed to browse, view, extract or restore data
unless the correct password is supplied.

Encryption Passwords
The security of your data depends not only on the strength of the encryption method but also on
the strength of your password, including factors such as length and composition of the
password, and the measures you take to ensure that your password is not disclosed to
unauthorized third parties.
You should keep the following considerations in mind when choosing passwords for your files:
Encryption password cannot be less than 6 characters long









In general, longer passwords are more secure than shorter passwords. To take
maximum advantage of the full strength of AES encryption passwords lengths must be
approximately:
 15 characters for 128-bit encryption.
 23 for 192-bit encryption.
 31 characters for 256-bit encryption.
Passwords that contain a combination of upper and lower case letters, digits, and
punctuation are more secure than passwords containing only letters.
Because you can use spaces and punctuation, you can create "pass phrases" that are
long enough but still easy to remember and type.
Avoid using easily guessed passwords such as names, birthdays, Social Security
numbers, addresses, telephone numbers, etc...
Avoid storing the password on the same volume on which the encryption data is located.
Keep a record of the passwords you use and to keep this record in a secure place. GBM
has no way to access the contents of an encrypted file unless you supply the correct
password.

Compression
Genie Backup Manager uses non-proprietary ZIP64 compatible compression to reduce backed up
data size and save space, supporting up to 264 -1 files within a zip archive as well as files that
have a size greater than 4GB, for a zip file size that can reach up to about 18 million terabytes (
more precisely, 2^64-1 bytes).
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The Genie Backup Manager compression engine offers fast performance and low memory usage.
Speed improvements reach 25%-75% in certain contexts. It also provides 15 to 20% better
compression than other formats on many popular file types, especially XML data.
Users can choose between 9 levels of compression ranging form no-compression, to best.
To set GBM to compress backed up data:
1. From the left navigation menu in the backup wizard select Settings.
2. Select Use Compression.
3. Select the desired compression level from the combo box.

Backup without Compression
Selecting to backup data without compression would cause GBM to copy the data to a folder on
the storage device while preserving the original file/folder structure, this makes data more
accessible and less susceptible to corruption.

Power Management Options
Users can set Genie Backup Manager to trigger a power-saving event after a backup job has
been executed. Allowed options are:







Exiting Genie Backup Manager.
Shutting down computer.
Setting computer on Hibernate mode.
Logging off computer.
Setting computer on Stand-by mode.

To configure power-saving options for a backup job, select the Settings screen from the backup
wizard, click More Settings, then select Advanced Settings. Selected power-saving options
must be supported by the computer. To configure power management settings for your
computer, double-click Power Options in the Control Panel.

Command Line Parameters
Genie Backup Manager can be started with various command line parameters to execute
different actions on a particular backup job, such as loading and running a backup job, running
the application minimized, alternating between backup types, shutting down the computer after
backup etc. The parameters can be used to create shortcuts which start backup tasks
automatically.
Syntax
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GBM9 [-e] [-job "backup job name"] [-h] [-noexit] [-showlogfile] [-novalidate] [-bt|1 2 3 4] [-shutdown|
1 2 3 4]

Parameters

Command

Result

-e

Activate the Command Line engine.

-job "job name" Name of the backup job to be performed.
-novalidate

Do not verify backed up data after backup.

-h

Run the backup monitor minimized when backup starts.

-showlogfile

Display backup log when backup is complete.

-noexit

Do not exit Genie Backup Manager after backup.

-bt

Specify backup type to be used with this backup run.

-shutdown

-bt1

Force running the backup job in full mode (backup all selected
files).

-bt2

Force running the backup job in increment mode.

-bt3

Force running the backup job in mirror mode.

-bt4

Force running the backup job in differential mode.

Choose power saving option to be executed when backup is complete.
-shutdown1
-shutdown2
-shutdown3
-shutdown4

Shutdown computer.
Hibernate.
Logoff.
Standby.

Adding a Timestamp to the Backup File
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A timestamp is a combination of date + time that is appended at the end of the backup filename
to indicate when the backup run was performed
To attach a timestamp to the backup set:
1.
2.
3.
4.
5.

From the left navigation menu in the backup wizard select Job Info.
Click Backup Filename Options.
Select Attach timestamp to backup set.
From the Timestamp format combo-box choose preferred date/time format.
Click Ok.

Timestamp formats
Timestamp formats are:










Month dd, yyyy@hh:mm:ss AM/PM
Day of the week, Month dd, yyyy
Month dd, yyyy
yyyy-mm,dd
Month dd
mm-dd-yyyy@hh-mm AM/PM
mm-dd-yyyy@hh-mm-ss AM/PM
hh.mm.dd AM/PM

Pre and Post Job Commands
To run commands before or after backup is completed, users can use the Pre and Post Job
Commands option.
These are some of the helpful tasks that a user can accomplish using pre, pre-backup and post
commands...
Task

Command(s)

Checking disk drives for errors before backup.

CHKDSK

Copying, moving, deleting and replacing files and folders.

COPY, XCOPY, RENAME,
REPLACE, MOVE, DEL

Defragmenting a drive before or after backup.

DEFRAG

Temporally disabling real-time antiviral software to speed up
backup.

Refer to the command line
options section of your
anti-virus help
documentation.
PRINT

Printing documents (such as the activity log when backup is
done).
Shutting down, logging off or restarting the computer.
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For a complete list of Windows system commands that can be used, open the Start menu, click
Run, type CMD and click Ok, then type help and press enter. for more information on using a
specific command type "<command> /?" in the command prompt then press enter.

To attach pre/post job commands to a backup job:
1.
2.
3.
4.

From the left navigation menu in the backup wizard select Settings.
Click More Settings then select Pre & Post Job Commands.
Make sure the Enable Pre & Post Job Commands option is checked
From the Events list select whether to attach a pre, post, or pre-data confirmation job
command.
5. Make sure Enable Command is selected.
6. In the Command Line box, type the command you wish to be executed or browse for a
.batch, .cmd or script file you wish to execute for multiple commands
7. If you do not wish for one process to run until the previous one in the sequence has
finished, make sure the Wait until previous process ends option is selected. Other
wise the command and the backup job will run almost simultaneously.

Environmental Variables
Output files from backup jobs have varying names, depending on the backup job name and the
number of the backup run. Using special environmental variable strings, you can write
commands and pass the backup job's output files as parameters without having to worry about
their changing names:
$BACKUPOUTPUT$
$LOGFILE$

Resolves to the complete path of the main backup file/folder.

Resolves to the complete path of the backup log file.

$BACKUPPRFOLDER$
backup set.

Resolves to the complete path of the parent folder containing the

$BACKUPFILENAME$

The name of the output backup file, without the path.



Environmental variables passed to commands must be enclosed in quotations, such as
"$BACKUPOUTPUT$".

Built-In Commands
When using the following commands, Genie Backup Manager will open a dialog displaying the
progress of the command execution. Each one of these commands takes two parameters:
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Copy: Copy a file or folder to a new location.
Move: Move a file or folder to a new location. The file/folder in the original location will
be deleted.
Rename: Rename a file or folder.

SQL Continuous Data Protection
SQL Data Protection

Protecting your mission critical databases strongly rely on understanding the SQL backup types
and recovery models. GBM gives the users and easy to use, Continuous Data Protection (CDP)
for ultimate SQL database protection . Users can also perform single backups from the Single
Level Protection (SLP) page.

SQL Backup Types
SQL Backup Types
Choose between different backup methods, for SQL Backup. The first run in all times must be
Full or The backup will fail or its restore will be unreliable. SQL backups are not like other
backups in GBM, as each backup done on SQL backup, even if it is a different job, depends on
previous runs. It is recommended that your SQL backups are created in separate backup jobs
from your other data.





Database-complete: Backup all data in the database including the transaction log
Database-differential: Backup all data in the database, including the transaction logs,
since the last full backup
Transaction Log: Backup all items in the transaction log.

Note:



Transaction logs can only be backed up in Full Recovery mode

Database-Complete
When a user selects Complete backup, GBM will back up all the data in the database. Every
table, stored procedure and all other objects in the database are placed into a single backup file.
Complete backup must be done before backing up via Database-Differential or Transaction Log.
To set GBM to perform a complete backup:
1. From the left navigation menu in the backup wizard select CDP.
2. Go to Single Level Protection (SLP)

130

Microsoft SQL

3. From the SQL Backup Type group select Database-Complete.

Database-Differential
Database differential backup will gather all changes since the last full backup into a backup file.
If you are using Simple Recovery model, it is recommended that you do differential backup at
least once a day.
To set GBM to perform Database differential backup:
1. From the left navigation menu in the backup wizard select CDP.
2. Go to Single Level Protection (SLP)
3. From SQL Backup Type select Database Differential.

Important Note:
When choosing Database differential Backup, you must make sure that you have performed a
database complete backup run either in the same job or a different job

Job naming in database differential
If all the SQL backup is done in the same job, your output files will look as follows:
Backup Job.gbp ... Database-complete backup
Backup Job.0.gbp ... First Database-differential backup run
Backup Job.1.gbp ... Second Database-differential backup run
Backup Job.2.gbp ... Third Database-differential backup run

If your differential runs are separate from the complete backup your output files will be as
follows:
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complete.gbp ... Database-complete backup
differential.gbp ... First Database-differential backup run
differential.0.gbp ... Second Database-differential backup run
differential.1.gbp ... Third Database-differential backup run

You can also make each operation in separate jobs as well and the naming will be as follows:
complete.gbp ... Database-complete backup
first run.gbp ... First Database-differential backup run
second.gbp ... Second Database-differential backup run
third.gbp ... Third Database-differential backup run

Transaction Log
When choosing Transaction Log backup, you must make sure that you have performed a
database complete backup run either in the same job or a different job or the backup will fail.
The backup will also fail if you are not in full recovery model, to learn about recovery models,
click here.
Transaction log will backup the transaction log and it is recommended to backup very frequent
depending on the database traffic.
To set GBM to perform Transaction log backup:
1. From the left navigation menu in the backup wizard select CDP.
2. Go to Single Level Protection (SLP)
3. From SQL Backup Type select Transaction log.

Job naming in Transaction log
If all the SQL backup are performed in the same job, your output files will look as follows:
Backup Job.gbp ... Database-complete backup
Backup Job.0.gbp ... First transaction log run
Backup Job.1.gbp ... Second transaction log run
Backup Job.2.gbp ... Third Transaction log run
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If your differential runs are separate from the complete backup your output files will be as
follows:
complete.gbp ... Database-complete backup
transaction.gbp ... First transaction log run
transaction.0.gbp ... Second transaction log run
transaction.1.gbp ... Third Transaction log run

You can also make each operation in separate jobs as well and the naming will be as follows:
complete.gbp ... Database-complete backup
first run.gbp ... First transaction log run
second.gbp ... Second transaction log run
third.gbp ... Third transaction log run

Continuous Data Protection (CDP)
Continuous Data Protection
A common practice in protecting SQL Data is to run Database complete with differential and/or
transaction logs backup to ensure latest data recovery, for more information, please view SQL
Server Backup Strategies

How to protect SQL databases?
1. From the left navigation menu in the backup wizard select CDP
2. Select Continuous Data Protection (CDP)
3. Database Complete should be performed as you cannot perform a
differential/transaction log backup without a full backup. Select how frequent you wish
to run the backup as full backup type:
 Run Every Few Hours: runs backup every few hours, in this option you can
also specify the days you wish the task to run
 Run Daily: Runs backup daily at a specific time
 Run Weekly: Specify the time and days you wish the backup to run
 Run Monthly: Specify the time and day of the month
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Run Once: Run this full backup one time on a specific time
Run at Windows logon: Runs every time you logon into your computer
4. Select Differential/transaction log Backup (optional) and select how frequent you wish
to run differential/transaction log backup:
 Run Every Few Hours: runs backup every few hours, in this option you can
also specify the days you wish the task to run
 Run Daily: Runs backup daily at a specific time
 Run Weekly: Specify the time and days you wish the backup to run
5. Under Security Settings, you can specify if you wish to run the backup whether the
user is logged on or not. If you select Run whether user is logged on or not, you
must enter the Windows login username or password; otherwise your backup will not
run if Windows is logged out.
6. In More Settings, you can specify the following options:
 Limit Number of backup sets to (if supported by media): This option enables
GBM to keep the most recent "X" number of database-complete backups with its
differential/transaction log backups
 Minimize backup window when running job: Selecting this option runs the
backup job while scheduled backup window is minimized
 Do not start backup if the computer is running on batteries: You can set
this option that tells the task to run only if the computer is on AC power (not
battery power)
 Do not wait 10 seconds before starting backup: By default the scheduled
backup has a 10 second delay counter before actually running the backup.
Choosing this option will enable to run the task without this 10 second delay.
 Wake up computer to run this task (if supported): If you computer is set to
sleep at the time of backup, you can choose to wake up the computer to run the
task. This option is enabled if Run whether user is logged on or not is
enabled.
 Run Database- Complete backup now (Recommended): Choose this option
if you wish to run a database-complete backup after saving CDP settings.

Notes:



Limiting backup sets is not supported on FTP,Amazon S3, CD/DVD using burning
technology, and when the backup is spanned to multiple locations

CDP Examples
Example 1:
Perform Database-Complete backups on the first Sunday of the month and differential backups
weekly on Fridays:
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In CDP, under Database-Complete Backup, select Run Monthly
Set the time you wish the backup to run, and then select on the first Sun of the
month

Microsoft SQL




Mark the checkbox next to Differential Backup (optional) to enable differential
backup schedule
Select Run Weekly and set the time for the backup to run and under on the following
days select Fri

Example 2:
Perform Database-Complete backups weekly on Sunday, Transaction log backups daily every 5
hours the rest of the week, differential daily, and keep only 1 backup set









In the CDP, under Full backup, select Run Weekly
Set the time you wish the backup to run, and under on the following days select Sun
Mark the checkbox next to Differential (optional) to enable database-differential
backup schedule
Select Run Daily
Mark the checkbox next to Transaction log Backup (optional) to enable transaction
log backup schedule
Select Run Every Few Hours, in Run Every set it to 5 hours, and under on the
following days select Mon, Tue, Wed, Thurs, Fri, and Sat
Under More Settings, change Limit number of backup sets to (if supported by
media) from unlimited to 01

Single Level Protection
Using single Level protection enables users to create fast SQL backup using single backup type.
When performing SQL Backup using GBM, you must perform a Database-Complete Backup
before any Transaction log and Incremental backup.

Using Single Level Protection:
1. From Backup choose Microsoft SQL
2. Go to CDP and under Single Level Protection choose one of the following backup
types:





Database-complete: backs up all the data in the database including the transaction log
Database-differential: Backup all data in the database, including the transaction logs,
since the last full backup
Transaction Log: Backup all items in the transaction log.

SQL Server Backup Strategies
When planning your SQL Server backup strategy, select the backup method that is the best
tradeoff between backup and restore time, depending on the size of your database. For
example, full backups take the longest to perform, but are the fastest to restore. Differential
backups are overall faster than full backups, but take longer to restore. Incremental (transaction
log) backups are the fastest, but are generally the slowest to restore.
Generally, it is faster to restore differential backups (with few, if any transaction logs) than it is
to restore a full backup (with many transaction logs). This is because the restoration of
transaction logs have to play back each transaction when restored. If a transaction took 5
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minutes to run, it will also take about 5 minutes to run again when the transaction log is
restored.
For fastest backups, we recommend performing a disk backup to a local drive/drive array, then
moving the backup file(s) remotely.
The selected database recovery model should also play a role in your choice of backup method
and frequency. If you are using the Simple Recovery model:





Use only Database-Complete backups.
Depending on how frequently the data changes and how critical it is, you should execute
at least one full backup a day.
This should occur during off-hours when there is minimal database use.

If you are using the Full or Bulk-Logged Recovery model:









Option 1 -- use Database-Complete and Transaction.
Option 2 -- use Database-Complete, Differential and Transaction.
A full backup should be created at least once a day.
Transaction log backups should occur every 15 minutes.
Differential backups should occur every three hours.
The full backup should occur during off-hours when there is minimal database use.
The transaction and differential backups should be on a set schedule based on when
your full backup occurs.

Restore
Restoring SQL Server Data
Although GBM has the ability to backup multiple databases, you can only restore one at a time.
GBM can restore your database whether it is online or offline.
SQL Server data differs from other data in GBM in terms of restore in that backups must be
restored in the order in which they were created, whereas with other GBM data, restoring the
last backup will recover the latest versions of all files and folders.
If you are restoring a non-Database-Complete backup, please refer to the specific help pages on
Restoring a transaction log backup or a Restoring a differential database backup.

Important notes
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If Leave database non-operational is selected on the last restore run, it will leave the
database unusable. To reverse this effect, repeat the restore process for the last run and
make sure that Leave database non-operational is not selected.
Under the full or bulk-logged recovery model, before you can restore a database, you
must back up the active transaction log.

Microsoft SQL

When you wish to restore databases you have the following two options and each option slightly
differs in the restoration process:




Restoring to a new database.
Restoring over existing database.

Restoring to a New Database
GBM enables the user to restore the data to a newly created database, as opposed to restoring
over an existent one, please refer to the following steps:
1.
2.
3.
4.

Open the Restore wizard.
Load a backup, then click Next.
In the Available Databases list, select Create new Database.
Under Set Restore Settings, Select Move database location and specify the paths of
the database location and logs location in the DB Location and Logs Location fields
respectively.
5. Select Leave database non operational if there are still other differential or
transaction runs that you wish to restore after this run.
6. Click Next to start restore.

Restoring Over an Existing Database
Before attempting to restore a system database (Master, MSdb, model, or Pubs) you must
start SQL Sever in single user mode.
1.
2.
3.
4.
5.

Open the Restore wizard.
Load a backup, then click Next.
From the Available Databases list, select the database you wish to restore to.
Under Settings, select Restore over existing database.
If you wish to change the location of the database and log; under Settings, select Move
Database location then specify the new paths for the Database and logs in the DB
Location and Logs Location fields respectively. Keep unchecked if you wish to restore
to original location.
6. Select Leave database non operational if there are still other differential or
transaction runs that you wish to restore after this run.
7. Click Next to start restore.

How to: Connect to the Database
To connect to the server via GBM, please refer to the following steps:
1. Open the restore wizard.
2. Load the backup set then click Next. If you are restoring multiple runs, see Restoring
SQL Database from Multiple Runs,

137

GBM User Manual

3. From the left pane select an SQL Server Instance, the databases backed up under that
instance will appear in the right pane.
4. Select the SQL database you wish to restore. You are only allowed to restore one
database at a time.
5. Click Set Restore Settings.

How to: Start the Database in Single-User Mode
Under certain circumstances, such as before recover a damaged system database, you may have
to start an instance of Microsoft SQL Server in single-user mode. To do so ...
1. In SQL Server Configuration Manager, click SQL Server Services.
2. In the right pane, right-click SQL Server <instance_name>, then click Properties.
3. On the Advanced tab, in the Startup Parameters box, type "-m" separated from other
parameters by a semicolon (;).
4. Click OK.
5. Restart the database engine.

When you start an instance of SQL Server in single-user mode, note the following:




Only one user can connect to the server.
The CHECKPOINT process is not executed. By default, it is executed automatically at
startup.

ow to: Restore a Transaction Log Backup
Backups must be restored in the order in which they were created. Before you can restore a
particular transaction log backup, you must first restore the following previous backups without
rolling back uncommitted transactions:




The full database backup and the last differential backup, if any, taken before the
particular transaction log backup.
All transaction log backups taken after the full database backup or the differential
backup (if you restore one) and before the particular transaction log backup.

To restore previous backups as stated above the Leave database non operational option
must be checked during restore from the Settings dialog, which can be accessed from the right
pane when SQL Server is selected in the restore wizard. This option tells the database that there
is still additional data to be restored. The following scenarios illustrate when this option should
be selected.

Scenario
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Restoring a backup set consisting of a database-complete backup followed by two transaction log
backups.
Restore sequence
Database-complete
First transaction log
Second transaction log

Leave database non
operational
Enabled
Enabled
Disabled

Scenario
Restoring a backup set consisting of a Database-Complete backup followed by two differential
database backups, and a transactional log backup .
Restore sequence
Database-complete
Second differential database
Transaction log

Leave database non
operational
Enabled
Enabled
Disabled

Scenario
Backup sequence
1st
2nd
3rd
4th
5th
6th

Backup type
Database-complete
Differential database (first)
Transaction log (first)
Differential database (second)
Transaction log (second)
Transaction log (third)

Restore sequence

Leave database non
operational
Enabled
Enabled
Enabled
Disabled

Database-complete
Second differential database
Second transaction log
Third transaction log

Important note
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If Leave database non-operational is selected on the last restore run, it will leave the
database unusable. To reverse this effect, repeat the restore process for the last run and
make sure that Leave database non-operational is not selected.

How to: Restore a Differential Database Backup
Backups must be restored in the order in which they were created. Before you can restore a
particular Differential Database backup, you must first restore the most recent DatabaseComplete backup before it.
To restore the previous Database-Complete backup as stated above the Leave database non
operational option must be checked during restore from the Settings dialog, which can be
accessed from the right pane when SQL Server is selected in the restore wizard. This option tells
the database that there is still additional data to be restored.
Important note
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If Leave database non-operational is selected on the last restore run, it will leave the
database unusable. To reverse this effect, repeat the restore process for the last run and
make sure that Leave database non-operational is not selected.

Microsoft Exchange Server
Microsoft Exchange Server
Genie Backup Manager provides an easy, secure and reliable way to backup the MS Exchange
Server databases using advanced API technology. You do not need to stop the MS Exchange
Server service while taking a backup. GBM is designed to backup the MS Exchange Server
database without interrupting MS Exchange Server operations.
Note:
To enable backing up Microsoft Exchange Server, GBM automatically copies "esebcli2.dll" from
the program folder Microsoft Exchange is currently installed in to X:/WINDOWS/System32/,
where X is the drive you have windows installed on. However, if GBM fails to do so, it must be
copied manually.

How to: Register MS SQL Plugin
Upon purchasing the Exchange plugin the user will receive an email containing a serial number
for unlocking the Exchange Backup.
To register MS Exchange Plugin:
1.
2.
3.
4.

Start GBM.
Click Backup.
Under Exhange Backup in Backup Category, click Register Exchange plugin
Type or copy-paste the serial number into its designated field then click OK.

How to: Backup Exchange Server Data
To enable backing up Microsoft Exchange Server, GBM automatically copies "esebcli2.dll" from
the program folder Microsoft Exchange is currently installed in to X:/WINDOWS/System32/,
where X is the drive you have windows installed on. However, if GBM fails to do so, it must be
copied manually.

Backing Up Exchange Server Data
1.
2.
3.
4.
5.
6.

From the Main Page, select Backup
In Backup Category, Select Exchange Backup
From the left navigation menu in the backup wizard select What to Backup
Expand the Exchange list, then select the Exchange Server you wish to backup from.
In the right pane expand the Microsoft Information Store list.
If you want to backup the entire Information Store on the selected server you can simply
check the box next to Microsoft Information Store, or you can expand the tree
beneath it and select a particular Storage Group.
7. Click Next to continue configuring the backup job.
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Exchange Backup Settings
Security Options
Security in Genie Backup Manager
Genie Backup Manager offers multiple levels of protection to ensure that backed up data is not
accessible to unauthorized persons. ZIP passwords offer moderate protection for compressed
backups, with the added flexibility of being compatible with most compression utilities, to allow
users to manually restore data from backup archives, while AES encryption has the advantage of
being highly secure, as it is adopted by NIST as an FIPS-approved (Federal Information
Processing Standard) symmetric encryption algorithm that may be used by U.S. Government
organizations (and others) to protect sensitive information

Zip Password Protection
Genie Backup Manager uses standard zip format compression, and thus can add a standard zip
compression password to the created archive; using this protection method would still allow
users to access their data using ZIP-compatible compression utilities. Users will not be able to
browse or restore files and folders stored inside a ZIP-password-protected backup until they
enter their passwords.




This method only offers moderate protection; it is not recommended for securing
sensitive data.
ZIP passwords cannot be less than 6 characters long.

To add zip password protection to a backup job:
1. From the left navigation menu in the backup wizard select Settings.
2. From the Security box select Password Protection.
3. Type a password twice in the Password and Confirm Password fields

Encryption
Encryption
Encryption is encoding data to prevent any non-authorized party from reading or changing it.
The level of protection provided by encryption is determined by an encryption algorithm. The
contents of the data that you want to protect are encrypted based on a password that you
specify. In order for GBM later restore the original contents of the encrypted files, the correct
password must be supplied

142

Microsoft Exchange Server

AES Encryption

GBM uses AES encryption. AES is the Advanced Encryption Standard. This encryption method,
has been adopted by NIST as an FIPS-approved (Federal Information Processing Standard)
symmetric encryption algorithm that may be used by U.S. Government organizations (and
others) to protect sensitive information
GBM supports AES encryption in 3 different strengths: 128-bit AES, 192-bit AES and 256-bit
AES. These numbers refer to the size of the encryption keys that are used to encrypt the data;
the higher the number the stronger the encryption, at the expense of being slightly slower. All
three methods can provide significantly greater security than the password protection method.
The strength of encryption does not depend only on the length of the encryption key used but
also on the password supplied by the user. Please read more about Encryption Passwords



GBM requires that the correct password be supplied before the contents of an encrypted
backup set can be viewed or restored to its original unencrypted form. The password is
not required, however, for actions that do not require access to the unencrypted
contents of the file. In particular, encrypted files can be deleted from backup set, or can
be replaced within the backup set, without a password

Notes on encryption safety

Encryption can be a very effective measure for protecting your sensitive data; however, even
encrypted documents can be compromised . The following is a list of some of the ways in which
the safety provided by encryption can be compromised. Note that these are not GBM related
risks but rather risks that arise from mishandling the password or a file in its unencrypted form
If a keystroke monitor (key-logger) or other malicious code (such as a trojan horse) is running
on your computer, your password may be recorded when you type it. Be sure to check
frequently for viruses and follow other recommended computer safety procedures
If you extract an encrypted file and then delete it, it may be possible for someone to later
"undelete" the file using file recovery software or the Recycle Bin. You can use the Genie Wipe
tool to irreversibly delete sensitive files
When you extract, open or view a file directly from the backup set (using Catalog or from the
Restore Wizard), GBM must extract the file to a temporary location so that the associated
program can open it. If you subsequently close GBM without first closing the program that is
using the file, GBM may not be able to delete the temporary copy of the file, thereby leaving it
on disk in unencrypted form. The associated program may also make one or more backup copies
of the decrypted file, and GBM will not be able to delete these
After backing up or restoring encrypted files, some or all of the unencrypted file contents may
remain in your computer's memory or the page swap files on disk. A malicious user may be able
to retrieve this unencrypted information

Using Encryption in Backup
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GBM can protect backed up data from being accessed by unauthorized people using AES
encryption. GBM encrypts data on-the-fly, meaning that it encrypts files as they are being copied
to the backup storage device instead of first encrypting the entire data then backing it up.
To add AES encryption protection to a backup job:
1.
2.
3.
4.
5.

From the left navigation menu in the backup wizard select Settings.
Select AES Encryption.
Type a password twice in the Password and Confirm Password text input boxes.
Click Encryption Strength.
Choose an encryption level.

Note





Encryption applies only to the contents of backed up files. Information about an
encrypted file, such as its name, date, size, and attributes, can be viewed, without a
password, by anyone who has access to the backup set.
Encryption is not supported in Easy Mode
Please store the password in a safe place. If lost, the backed up data is irretrievable.

Decrypting data during restore

Upon selecting a backup set with encryption protection for restore, GBM will request the
encryption password. The user will not be allowed to browse, view, extract or restore data
unless the correct password is supplied.

Encryption Passwords
The security of your data depends not only on the strength of the encryption method but also on
the strength of your password, including factors such as length and composition of the
password, and the measures you take to ensure that your password is not disclosed to
unauthorized third parties.
You should keep the following considerations in mind when choosing passwords for your files:
Encryption password cannot be less than 6 characters long
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In general, longer passwords are more secure than shorter passwords. To take
maximum advantage of the full strength of AES encryption passwords lengths must be
approximately:
 15 characters for 128-bit encryption.
 23 for 192-bit encryption.
 31 characters for 256-bit encryption.
Passwords that contain a combination of upper and lower case letters, digits, and
punctuation are more secure than passwords containing only letters.
Because you can use spaces and punctuation, you can create "pass phrases" that are
long enough but still easy to remember and type.

Microsoft Exchange Server





Avoid using easily guessed passwords such as names, birthdays, Social Security
numbers, addresses, telephone numbers, etc...
Avoid storing the password on the same volume on which the encryption data is located.
Keep a record of the passwords you use and to keep this record in a secure place. GBM
has no way to access the contents of an encrypted file unless you supply the correct
password.

Compression
Genie Backup Manager uses non-proprietary ZIP64 compatible compression to reduce backed up
data size and save space, supporting up to 264 -1 files within a zip archive as well as files that
have a size greater than 4GB, for a zip file size that can reach up to about 18 million terabytes (
more precisely, 2^64-1 bytes).
The Genie Backup Manager compression engine offers fast performance and low memory usage.
Speed improvements reach 25%-75% in certain contexts. It also provides 15 to 20% better
compression than other formats on many popular file types, especially XML data.
Users can choose between 9 levels of compression ranging form no-compression, to best.
To set GBM to compress backed up data:
1. From the left navigation menu in the backup wizard select Settings.
2. Select Use Compression.
3. Select the desired compression level from the combo box.

Backup without Compression
Selecting to backup data without compression would cause GBM to copy the data to a folder on
the storage device while preserving the original file/folder structure, this makes data more
accessible and less susceptible to corruption.

Power Management Options
Users can set Genie Backup Manager to trigger a power-saving event after a backup job has
been executed. Allowed options are:







Exiting Genie Backup Manager.
Shutting down computer.
Setting computer on Hibernate mode.
Logging off computer.
Setting computer on Stand-by mode.

To configure power-saving options for a backup job, select the Settings screen from the backup
wizard, click More Settings, then select Advanced Settings. Selected power-saving options

145

GBM User Manual

must be supported by the computer. To configure power management settings for your
computer, double-click Power Options in the Control Panel.

Command Line Parameters
Genie Backup Manager can be started with various command line parameters to execute
different actions on a particular backup job, such as loading and running a backup job, running
the application minimized, alternating between backup types, shutting down the computer after
backup etc. The parameters can be used to create shortcuts which start backup tasks
automatically.
Syntax

GBM9 [-e] [-job "backup job name"] [-h] [-noexit] [-showlogfile] [-novalidate] [-bt|1 2 3 4] [-shutdown|
1 2 3 4]

Parameters

Command

Result

-e

Activate the Command Line engine.

-job "job name" Name of the backup job to be performed.
-novalidate

Do not verify backed up data after backup.

-h

Run the backup monitor minimized when backup starts.

-showlogfile

Display backup log when backup is complete.

-noexit

Do not exit Genie Backup Manager after backup.

-bt

Specify backup type to be used with this backup run.
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-bt1

Force running the backup job in full mode (backup all selected
files).

-bt2

Force running the backup job in increment mode.

-bt3

Force running the backup job in mirror mode.

-bt4

Force running the backup job in differential mode.

Microsoft Exchange Server

-shutdown

Choose power saving option to be executed when backup is complete.
-shutdown1
-shutdown2
-shutdown3
-shutdown4

Shutdown computer.
Hibernate.
Logoff.
Standby.

Adding a Timestamp to the Backup File
A timestamp is a combination of date + time that is appended at the end of the backup filename
to indicate when the backup run was performed
To attach a timestamp to the backup set:
1.
2.
3.
4.
5.

From the left navigation menu in the backup wizard select Job Info.
Click Backup Filename Options.
Select Attach timestamp to backup set.
From the Timestamp format combo-box choose preferred date/time format.
Click Ok.

Timestamp formats
Timestamp formats are:










Month dd, yyyy@hh:mm:ss AM/PM
Day of the week, Month dd, yyyy
Month dd, yyyy
yyyy-mm,dd
Month dd
mm-dd-yyyy@hh-mm AM/PM
mm-dd-yyyy@hh-mm-ss AM/PM
hh.mm.dd AM/PM

Pre and Post Job Commands
To run commands before or after backup is completed, users can use the Pre and Post Job
Commands option.
These are some of the helpful tasks that a user can accomplish using pre, pre-backup and post
commands...
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Task

Command(s)

Checking disk drives for errors before backup.
Copying, moving, deleting and replacing files and folders.

CHKDSK
COPY, XCOPY, RENAME,
REPLACE, MOVE, DEL

Defragmenting a drive before or after backup.

DEFRAG

Temporally disabling real-time antiviral software to speed up
backup.

Refer to the command line
options section of your
anti-virus help
documentation.
PRINT

Printing documents (such as the activity log when backup is
done).
Shutting down, logging off or restarting the computer.

SHUTDOWN

For a complete list of Windows system commands that can be used, open the Start menu, click
Run, type CMD and click Ok, then type help and press enter. for more information on using a
specific command type "<command> /?" in the command prompt then press enter.

To attach pre/post job commands to a backup job:
1.
2.
3.
4.

From the left navigation menu in the backup wizard select Settings.
Click More Settings then select Pre & Post Job Commands.
Make sure the Enable Pre & Post Job Commands option is checked
From the Events list select whether to attach a pre, post, or pre-data confirmation job
command.
5. Make sure Enable Command is selected.
6. In the Command Line box, type the command you wish to be executed or browse for a
.batch, .cmd or script file you wish to execute for multiple commands
7. If you do not wish for one process to run until the previous one in the sequence has
finished, make sure the Wait until previous process ends option is selected. Other
wise the command and the backup job will run almost simultaneously.

Environmental Variables
Output files from backup jobs have varying names, depending on the backup job name and the
number of the backup run. Using special environmental variable strings, you can write
commands and pass the backup job's output files as parameters without having to worry about
their changing names:
$BACKUPOUTPUT$
$LOGFILE$

Resolves to the complete path of the main backup file/folder.

Resolves to the complete path of the backup log file.

$BACKUPPRFOLDER$
backup set.
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Resolves to the complete path of the parent folder containing the
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$BACKUPFILENAME$



The name of the output backup file, without the path.

Environmental variables passed to commands must be enclosed in quotations, such as
"$BACKUPOUTPUT$".

Built-In Commands
When using the following commands, Genie Backup Manager will open a dialog displaying the
progress of the command execution. Each one of these commands takes two parameters:





Copy: Copy a file or folder to a new location.
Move: Move a file or folder to a new location. The file/folder in the original location will
be deleted.
Rename: Rename a file or folder.

Exchange Continuous Data Protection
Exchange Continuous Data Protection (CDP)
Protecting your mission critical mailboxes strongly rely on understanding the Exchange backup
types. GBM gives the users and easy to use, Continuous Data Protection (CDP) for ultimate
Exchange data protection. Users can also perform single backups from the Single Level
Protection (SLP) page.

Exchange Backup Types
Exchange Backup Types
Choose between different backup methods for Exchange Backup. The first run in all times must
be Full or the backup will fail or its restore will fail even if the backup ran. Exchange backups are
not like other backups in GBM, as each backup done on Exchange backup, even if it is a different
job, depends on previous runs. It is recommended that your Exchange backups are created in
separate backup jobs from your other data.






Normal (Full): Backup the directory or Exchange store in its entirety, as well as the log
files, then purges the log files
Incremental: Backup the changes since the last full or incremental backup (backs up
the transaction logs that have accumulated since the last full or incremental backup) and
purges the logs.
Differential: Backup all items in the transaction log, but does not purge the logs.
Copy: Backup the directory or Exchange store in its entirety, as well as the log files, and
does not purge the log files.
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Normal
The normal backup process backs up the directory or Exchange store in its entirety, as well as
the log files. A normal backup marks the objects it has backed up so that incremental and
differential backups have context. This is accomplished by backing up the entire database and all
the log files, and then purging the log files. To restore from a normal backup, only one normal
backup is needed. Purging is supported in this type of backup if all the other backup types are
full and database-complete.
To set GBM to perform a Full Exchange backup:
1. From the left navigation menu in the backup wizard select CDP.
2. Go to Single Level Protection (SLP)
3. From the Exchange Backup Type group select Normal (full).

Incremental
An incremental backup backs up the subset of the component that has changed since the last
normal or incremental backup. Then it marks these objects as backed up. An incremental backup
backs up only the log files, and then purges them.
To set GBM to perform a Incremental Exchange backup:
1. From the left navigation menu in the backup wizard select CDP.
2. Go to Single Level Protection (SLP)
3. From the Exchange Backup Type group select Incremental.

Job naming in Incremental Backup
It is recommended that the user backs up Exchange data in a separate job, however there is no
restrictions on backing up Exchange or other data in the job, but if the backup types differ, it will
effect on the backup naming, for more information, please refer to Backup Types and file naming
If all the Exchange backup is done in the same job, your output files will look as follows:
Backup Job.gbp ... Normal (Full) backup
Backup Job.0.gbp ... First Incremental run
Backup Job.1.gbp ... Second Incremental run
Backup Job.2.gbp ... Third Incremental run
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If your differential runs are separate from the complete backup your output files will be as
follows:
complete.gbp ... Normal Full backup
differential.gbp ... First Incremental run
differential.0.gbp ... Second Incremental run
differential.1.gbp ... Third Incremental run

You can also make each operation in separate jobs as well and the naming will be as follows:
complete.gbp ... Normal Full backup
first run.gbp ... First Incremental run
second.gbp ... Second Incremental run
third.gbp ... Third Incremental run

Differential
A differential backup backs up changes in the directory or Exchange store that have occurred
since the last normal backup. A differential backup backs up only the log files but does not purge
them. If a normal backup is not performed before a differential backup, the job will fail.
To set GBM to perform a Differential Exchange backup:
1. From the left navigation menu in the backup wizard select CDP.
2. Go to Single Level Protection (SLP)
3. From the Exchange Backup Type group select Differential.

Job naming in Differential Backup
It is recommended that the user backs up Exchange data in a separate job, however there is no
restrictions on backing up Exchange or other data in the job, but if the backup types differ, it will
effect on the backup naming, for more information, please refer to backup types and output files
created.
If all the Exchange backup is done in the same job, your output files will look as follows:
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Backup Job.gbp ... Normal (Full) backup
Backup Job.0.gbp ... First Differential run
Backup Job.1.gbp ... Second Differential run
Backup Job.2.gbp ... Third Differential run

If your differential runs are separate from the complete backup your output files will be as
follows:
complete.gbp ... Normal Full backup
differential.gbp ... First Differential run
differential.0.gbp ... Second Differential run
differential.1.gbp ... Third Differential run

You can also make each operation in separate jobs as well and the naming will be as follows:
complete.gbp ... Normal Full backup
first run.gbp ... First Differential run
second.gbp ... Second Differential run
third.gbp ... Third Differential run

Copy
The copy backup is the same as a normal backup except no marking takes place to give
incremental and differential context. This means that performing an incremental backup after a
copy backup is equivalent to performing it before a copy backup. Use a copy backup to get a full
backup of the directory or Exchange store without disturbing the state of ongoing incremental or
differential backups. To restore from a copy backup, only one copy backup is needed. Purging is
not supported in this type of backup.
To set GBM to perform a Copy Exchange backup
1. From the left navigation menu in the backup wizard select CDP.
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2. Go to Single Level Protection (SLP)
3. From the Exchange Backup Type group select Copy.

Continuous Data Protection (CDP)
Continuous Data Protection
A common practice in protecting Exchange Mailbox Data is to run Full backups with differential
and/or incremental backup to ensure latest data recovery.

How to protect Exchange Mailboxes
1. From the left navigation menu in the backup wizard select CDP
2. Select Continuous Data Protection (CDP)
3. Full should be performed as you cannot perform a differential/incremental backup
without a full backup. Select how frequent you wish to run the backup as full backup
type:
 Run Every Few Hours: runs backup every few hours, in this option you can
also specify the days you wish the task to run
 Run Daily: Runs backup daily at a specific time
 Run Weekly: Specify the time and days you wish the backup to run
 Run Monthly: Specify the time and day of the month
 Run Once: Run this full backup one time on a specific time
 Run at Windows logon: Runs every time you logon into your computer
4. Select Differential/Incremental Backup (optional) and select how frequent you
wish to run differential/incremental backup:
 Run Every Few Hours: runs backup every few hours, in this option you can
also specify the days you wish the task to run
 Run Daily: Runs backup daily at a specific time
 Run Weekly: Specify the time and days you wish the backup to run
5. Under Security Settings, you can specify if you wish to run the backup whether the
user is logged on or not. If you select Run whether user is logged on or not, you
must enter the Windows login username or password; otherwise your backup will not
run if Windows is logged out.
6. In More Settings, you can specify the following options:
 Limit Number of backup sets to (if supported by media): This option enables
GBM to keep the most recent "X" number of full backups with its
incremental/differential backups
 Minimize backup window when running job: Selecting this option runs the
backup job while scheduled backup window is minimized
 Do not start backup if the computer is running on batteries: You can set
this option that tells the task to run only if the computer is on AC power (not
battery power)
 Do not wait 10 seconds before starting backup: By default the scheduled
backup has a 10 second delay counter before actually running the backup.
Choosing this option will enable to run the task without this 10 second delay.
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Wake up computer to run this task (if supported): If you computer is set to
sleep at the time of backup, you can choose to wake up the computer to run the
task. This option is enabled if Run whether user is logged on or not is
enabled.
Run Full backup now (Recommended): Choose this option if you wish to run
a Full backup after saving CDP settings.

Notes:



Limiting backup sets is not supported on FTP, CD/DVD using burning technology, and
when the backup is spanned to multiple locations

CDP Examples
Example 1:
Perform Full backups on the first Sunday of the month and differential backups weekly on
Fridays:






In CDP, under Full Backup, select Run Monthly
Set the time you wish the backup to run, and then select on the first Sun of the
month
Mark the checkbox next to Differential Backup (optional) to enable differential
backup schedule
Select Run Weekly and set the time for the backup to run and under on the following
days select Fri

Example 2:
Perform full backups weekly on Sunday, incremental backups daily every 5 hours the rest of the
week, differential daily, and keep only 1 full backup
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In the CDP, under Full backup, select Run Weekly
Set the time you wish the backup to run, and under on the following days select Sun
Mark the checkbox next to Differential (optional) to enable database-differential
backup schedule
Select Run Daily
Mark the checkbox next to Incremental Backup (optional) to enable transaction log
backup schedule
Select Run Every Few Hours, in Run Every set it to 5 hours, and under on the
following days select Mon, Tue, Wed, Thurs, Fri, and Sat
Under More Settings, change Limit number of backup sets to (if supported by
media) from unlimited to 01

Microsoft Exchange Server

Single Level Protection
Using single Level protection enables users to create fast Exchange backup using single backup
type. When performing Exchange Backup using GBM, you must perform a Full Backup before
any Differential and Incremental backup.

Using Single Level Protection:
1. From Backup choose Microsoft Exchange
2. Go to CDP and under Single Level Protection choose one of the following backup
types:






Normal (Full): Backup the directory or Exchange store in its entirety, as well as the log
files, then purges the log files
Incremental: Backup the changes since the last full or incremental backup (backs up the
transaction logs that have accumulated since the last full or incremental backup) and
purges the logs.
Differential: Backup all items in the transaction log, but does not purge the logs.
Copy: Backup the directory or Exchange store in its entirety, as well as the log files, and
does not purge the log files.

Restoring Exchange data
Restoring Exchange Server Data
Please read Prerequisites for Restoring Exchange Server, to ensure that Exchange Server is
configured properly before attempting to restore your Exchange Server data using Genie Backup
Manager.
If you have multiple runs to restore, it is recommended that you read Restoring Exchange Data
from Multiple Runs before proceeding.
How to Restore Exchange Data?
1. Open the restore wizard.
2. Load a backup, then click Next.
3. Expand the tree under Exchange Server and select an instance (you are only allowed
to restore one instance at a time)
4. From the right pane select the mailboxes you wish to restore
5. Specify a temp location path
Note
You can set GBM to automatically mount the database after restoration by selecting Mount
database after restore

Prerequisites for Restoring a Storage Group
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There are a few precautions that need to be taken into consideration before attempting to
restore Exchange Server data, or else restore would fail.:
1. Preparing MS Exchange Server when installed from scratch (Skip to step 2 if you do not
have to reinstall).
2. Configure the Storage Group for restore.

How to prepare MS Exchange Server When Installing from Scratch
A case may arise in which you have to completely reinstall and reconfigure Exchange. It is
extremely important that the new Exchange installation be configured identically to that of the
original server, please make sure that it is case sensitive.
1. The Site name must be the same.
2. The Organization name must be the same (Case sensitive).
3. The storage groups must be configured the same (Case Sensitive), along with the
original path and all the mailboxes.
4. Ensure that you install the same Exchange Service Packs that were existent on the
previous server.
5. Remember, the key is to build the new Exchange Server identical to the previous one.

Configure the Storage group for Restoration
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The store you are restoring must be dismounted before you run the restore. Note the
screen below for reference.



Before running your Exchange Restore, make sure that the This Database Can be
Overwritten option is selected - following these screenshots for reference.

Microsoft Exchange Server
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How to: Restore an Incremental or Differential Backup
In Exchange Backups must be restored in the order in which they were created. Before you can
restore a particular Incremental or differential backup. When you restore backup of an Exchange
database, the database is in an inconsistent state. The process of bringing the database to a
consistent state after a restore procedure is called "hard recovery." During hard recovery, the
Extensible Storage Engine (ESE) uses information in the log files and patch files to redo
operations performed on the database and then to undo any operations that belong to
incomplete transactions. The Last Backup Set check box (accessible from the right pane when
Exchange Server is selected in the restore wizard) determines if hard recovery should be run
after the backup completes. If you select this check box, hard recovery is run automatically after
the restore procedure finishes, and then the temporary files are removed. At this point, you can
mount the database.

Case scenario
First backup Full followed by two runs of incremental backups.
Restore sequence

Last Restore Set

Full
Incremental
Incremental

Not selected
Not selected
Selected

Mount database after
restore
No
No
Yes

Case scenario
First backup Full followed by Differential backup, then an Incremental backup.
Restore sequence

Last Restore Set

Full
Differential
Incremental

Not selected
Not selected
Selected
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Mount database after
restore
No
No
Yes

Run Backup
Run Backup
Users can run a backup job without going through the backup wizard by doing one of the
following:




From the Tools menu in the main page, click Run Backup and select a job to run.
Create a shortcut on the Desktop for the backup job and double-click it whenever you
wish to run a backup task.

The Backup Monitor
When running a backup job as a scheduled backup task or from a desktop shortcut the task will
be run in a small window called the Backup Monitor.

The Backup Monitor Controls:
Help: Opens the Help documentation
Show Log...: Displays the backup log, this option is only enabled after backup completes
Abort: Aborts backup progress
Status bar: This window will display the status of the backup task along with a bar indicating
progress.
Pause: Pauses the backup, this option is enabled during the backup process
Stop Timer: Cancels the 10 second timer before backup starts, to start the backup manually,
click Start Backup
Snooze: Postpones the backup and runs it later specified in the Click Snooze to be reminded
again in. You can choose the to snooze for:








10 minutes: after 10 minutes run backup
30 minutes: after 30 minutes, run backup
1 hour: after an hour run backup
2 hours: after 2 hours run backup
8 hours: after 8 hours, run backup
1 day: run this backup the next day at the same time

Computer power options: Set or change the computer power options to be performed after
backup completes. These options are:
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No Power option: do not perform anything after backup completes
Shutdown: Shutdown computer after backup completes
Logoff: Logoff computer after backup completes
Hibernate: Hibernate computer after backup completes
Suspend: Suspend computer after backup completes

For more information about power options, see Power Management Options
Note:
You can only snooze before backup starts

160

Backup Progress
After the user selects Backup Now from the Selection Confirmation window, GBM will start the
process of backing up data. The Backup Progression window displays the status of the backup
job, this information includes:
Backup Job Name: Name assigned to the backup job.
Backup File: The full path and filename of the output backup file/folder.
Backup Type: Backup type of this backup run (Full, Increment, Mirror or Differential).
Backup Status: The current action being carried out
Elapsed Time: Time elapsed since the user hit the Backup Now button.
Actual Size: Actual size of processed data.
Compressed Size: Size of processed data after compression.
Processed: Number of new files being added to the backup set.
Updated: Number of processed files that have changed since the previous backup run.
Skipped: Number of processed files that have not been added to the backup set due to errors.
Unmodified: Number of processed files that have not changed since the previous backup run.
Missing: Number of processed files that have been moved or deleted since the previous backup
run.

Backup Progress Options:
During backup, the user can change the following Options:
Pause: While the backup is running, the user can pause the backup if needed; however,
tampering with the created backup could lead to unstable results
Backup Performance: During backup, a user can speedup backup performance by moving the
pointer closer or exactly on Quicker backups or reduce impact on backup on the system with
moving the pointer closer to Faster Computer. You can globally change this setting from Global
Preferences in General - Advanced page
Enable/disable power options when backup completes: Using this option the user can
enable/disable power options upon completing backup or change the power option that was preconfigured during creating backup. For more information about power options, see Power
Management Options
Note:
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Backup progress options are only supported in Normal Mode
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Data Verification
Data Verification
Verification ensures that backed up data was successfully written on the storage media and that
it can be restored reliably. Genie Backup Manager will by default verify backed up data
immediately after the backup task is completed. But the user can also choose to test data
integrity of a backup archive at a later time using the Testing Data Integrity tool.
Testing data integrity can be done using one of two methods in Genie Backup Manager, these
are:





Bit-by-bit verification: This is the default method used by GBM to verify that a backup
archive is restorable, and the data contained within it is not corrupt. This is done by
reading every bit of each backed up file, however, this verification method does not
compare data to make sure that the backed up and original files are exactly identical.
This means that if the contents of a file in the backup archive were modified after
backup, Genie Backup Manager will not detect it.
CRC check verification: CRC is short for (Cyclic Redundancy Check); a very powerful
technique to obtain data reliability. The CRC is one of the most used techniques for error
detection in data communications and file verification.
When this verification method is used, Genie Backup Manager will generate a table of CRC
values for all the selected files during backup. Come verification time, a new CRC table is
generated for the data stored in the backup archive, and the CRC value for each file being
verified is compared against its counterpart in the original table created during backup. If
a file passes CRC check, that means that it can be restored reliably, and that it is exactly
the same as the file that was originally backed up.
CRC verification is not supported when backup is performed with encryption without
compression.

Genie Backup Manager by default uses bit-by-bit verification for testing backed up data, to
switch to CRC check, click the Tools menu, select Global Preferences, select Backup
Settings, select Advanced Settings, and make sure the option Use CRC check to compare
files is selected.
Genie Backup Manager will automatically verify backed up data when the user closes the backup
summary dialog. To change this behavior, click the Tools menu, select Global Preferences,
select Test Data Integrity, then choose one of the following options:





Automatically test data after backup: Always verify data after backup without asking
me
Ask me: Ask me whether to verify data when backup is completed.
Do not test: Do not verify backed up data.

By default, after an incremental, mirror or differential backup, Genie Backup Manager will only
verify new and changed files that have been added to the backup set, which saves time, based
on the assumption that the rest of the data was verified previously when it was first backed up.
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To set Genie Backup Manager to verify the entire backup archive at the end of each backup
execution, click the Tools menu, then select Global Preferences, select Test Data Integrity,
and make sure the option Test only new and changed files is not selected.
To manually test a backup, make sure that the storage media holding the backup is connected,
click the Tools menu, select Test Backup, select the backup job which created the backup
archive you wish to test, then click Test now. Alternatively, you can directly select the backup
by clicking Browse, navigating to the location of the archive, and selecting the backup's ".gbp"
file.
Post-backup data verification is not supported when the backup storage media is FTP or Amazon
S3 is selected. However, in all cases, data is verified while it's being written to the media.

Verification Methods
Testing data integrity can be done using one of two methods in Genie Backup Manager, these
are:





Bit-by-bit verification: This is the default method used by GBM to verify that a backup
archive is restorable, and the data contained within it is not corrupt. This is done by
reading every bit of each backed up file, however, this verification method does not
compare data to make sure that the backed up and original files are exactly identical.
This means that if the contents of a file in the backup archive were modified after
backup, Genie Backup Manager will not detect it.
CRC check verification: CRC is short for (Cyclic Redundancy Check); a very powerful
technique to obtain data reliability. The CRC is one of the most used techniques for error
detection in data communications and file verification.
When this verification method is used, Genie Backup Manager will generate a table of CRC
values for all the selected files during backup. Come verification time, a new CRC table is
generated for the data stored in the backup archive, and the CRC value for each file being
verified is compared against its counterpart in the original table created during backup. If
a file passes CRC check, that means that it can be restored reliably, and that it is exactly
the same as the file that was originally backed up.
CRC verification is not supported when backup is performed with encryption without
compression.

Changing the Verification Method
Genie Backup Manager by default uses the bit-by-bit verification method for testing backed up
data, to switch to the CRC check verification method, do the following:
1. From the tool bar, click Tools, then select Preferences.
2. Select Backup Settings then Advanced Settings.
3. Make sure the option Use CRC check to compare files is marked.

Verifying New and Changed Files
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By default, after an incremental, mirror or differential backup run, Genie Backup Manager will
only verify new and changed files that have been added to the backup set. This saves a lot of
time, based on the assumption that the rest of the data was verified previously when it was first
backed up.
To set Genie Backup Manager to verify the entire backup archive (data created by most recent
full backup along with all subsequent increments), you can do the following:
1. From the tool bar, click Tools, then select Global Preferences.
2. Select Testing Data Integrity.
3. Make sure the option Test only new and changed files is marked.

Data Integrity Testing Tool
The Data Integrity Testing tool verifies backed up data to ensure it can be reliably restored. To
open the Data Integrity Testing tool click Tools in the toolbar, then select Test Backup.

The Controls












Backup Jobs: List of executed backup jobs.
Backup Job: Name of backup job.
Status: Availability of the backup archive. If the media is not loaded, or the backup
archive has been moved, the backup will not be available for testing.
Backup File: Path and filename of the backup archive.
Refresh List: Refresh list of backup jobs and their statuses.
Browse: Manually locate the backup archive you wish to test.
Test Now: Perform data integrity test for the selected backup job from the list.
View Test Log: Displays the log produced by a performed data integrity test.
Settings: Open the data integrity testing settings page in the Global Preferences dialog.
Close: Close the Data Integrity Testing Tools dialog.
Help: Open this help page.
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Managing Open Files
Managing Open Files
Genie Backup Manager ensures business continuity of all their mission critical data, by backing
up opened or used files by other users or applications; leveraging Microsoft's latest Volume
Shadow-Copy Service (VSS) framework, to permit consistent backup of open files without the
need for additional applications or plug-ins.
Open File Backup agent is a utility that helps GBM capture files that are open, even if they are
changing during the backup, without locking users out of the applications or forcing them to log
off the network, giving your backup software the ability to protect ALL your mission critical data
by giving it access to exclusive, open or in use files. And ensuring business continuity by
protecting your data in real time without causing interruptions.

Volume Shadow Copy Service
The Volume Shadow Copy Service (VSS) provides the backup infrastructure for the Microsoft
Windows XP and above operating systems, serving a mechanism for creating consistent point-intime copies of data known as shadow copies. Microsoft's VSS component allows GBM to backup
opened files, resulting in a consistent backup free of skipped files.

Allowing VSS to handle backup of open files
1. From the toolbar click Tools, then select Global Preferences.
2. Select Open File Backup.
3. Select Use Volume Shadow Copy (fully integrated)

Limitation of Volume Shadow Copy Service:




Works only with NTFS formatted partitions.
Supported only on Windows XP and above
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How to: Load Backup from the Catalog
If you want to restore data from a backup that was created on the same computer you are
restoring to, and the original backup job configuration is still present, you can load the backup
and browse backed up files and folders even if the backup archive itself is not accessible at the
time.
To load a backup using the catalog:
1. Open the Restore Wizard.
2. Under Select a file to restore, click the plus sign next to the name of the backup job to
view a list of all its backup executions.
3. Select the backup run you wish to restore from.
4. Click Next to continue configuring the restore task.
Alternatively, you can do the following:
1. Open the Catalog.
2. Under History of backup runs, click the plus sign next to the name of the backup job
to view a list of all its backup executions.
3. Right-click a backup execution and select Restore. This will open the restore wizard and
load the selected backup.
4. Click Next to continue configuring the restore task.
Note:
Genie Backup Manager will try to locate the backup archive in the default backup destination
configured in the backup job. If GBM fails to find the archive, it will prompt you to insert/connect
the media on which the backup is stored, and select the folder containing the .gbp needed to
restore the data.

How to: Load Backup from the Archive
Backup catalogs ("index.gix" files) are saved locally and in the backup destination together with
the backup archive. When a backup job is executed, a new ".gbp" file is created, containing the
catalog file and other internal information needed by GBM to restore the data.
To load a backup in order to restore data from it, simply double-click the .gbp file corresponding
to the backup version you want to restore. Alternatively, you can open the Restore Wizard, click
Browse to navigate to the location of the .gbp file and select it, then click Open.
A special file naming convention is used by Genie Backup Manager to denote different backup
versions/executions of the same backup job. For more information, see Backup Types.

How to: Restore Using Self Restore
Users do not need to have Genie Backup Manager installed in order to restore data from a selfrestorable backup. Simply run the self-executable ".exe" file located in the backup folder, click
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Extract (or Run) to extract the backup archive to a temporary folder on your machine and open
the restore wizard. Then click Browse to select the .gbp file corresponding to the backup
version you wish to restore, and click Next to select data items you wish to restore. Finally click
Next to restore your data.




If the entire backup archive was stored in a single compressed self-executable file, the
SwiftRestore .exe file will be named <backup job name>.exe.
If the backup archive is not compressed or consists of more than one file (such as in the
case of incremental or differential backup, or when data is too big to fit into one .exe
file), the self-executable file will be named GBM8_SwiftRestore.exe.

Extracting the backup archive from a SwiftRestore file
If the self-executable .exe file got corrupted, users can extract the backup archive from the selfexecutable file in order to restore using the Genie Backup Manager application:
1.
2.
3.
4.
5.

Open Genie Backup Manager.
Select the Tools Menu.
Select Extract archive from .exe file.
Click Browse to locate and select the self-executable backup file.
Click Extract. The extracted backup archive will be stored in the same folder as the
original SwiftRestore .exe file.

How to: Restore/View Backups from Amazon S3
Genie Backup Manager currently supports backing up to Amazon S3 storage. To restore:
1. Download the backup using any third party application.
2. Open the Restore Wizard and browse for the last .gbp file created in the backup set
3. Proceed with the wizard

How to: Restore Data?
My Profile:
How to: Restore Outlook Data
How to: Restore Outlook Express Data
How to: Restore Windows Mail Data
How to: Restore Windows Registry
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How to: Restore Desktop Items
How to: Restore My Documents Folder
How to: Restore Windows Address book
How to: Restore Windows Contacts
How to: Restore Windows Favorites
How to: Restore Windows Fonts
How to: Restore Media Files
How to: Restore Images and Photos
How to: Restore Internet Explorer Settings
How to: Restore Windows Settings
My Folders:
How to: Restore Files and Folders
My Plugins:
Restore Plugins

Restoring SQL Server Data
Although GBM has the ability to backup multiple databases, you can only restore one at a time.
GBM can restore your database whether it is online or offline.
SQL Server data differs from other data in GBM in terms of restore in that backups must be
restored in the order in which they were created, whereas with other GBM data, restoring the
last backup will recover the latest versions of all files and folders.
If you are restoring a non-Database-Complete backup, please refer to the specific help pages on
Restoring a transaction log backup or a Restoring a differential database backup.

Important notes




If Leave database non-operational is selected on the last restore run, it will leave the
database unusable. To reverse this effect, repeat the restore process for the last run and
make sure that Leave database non-operational is not selected.
Under the full or bulk-logged recovery model, before you can restore a database, you
must back up the active transaction log.
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When you wish to restore databases you have the following two options and each option slightly
differs in the restoration process:




Restoring to a new database.
Restoring over existing database.

Restoring to a New Database
GBM enables the user to restore the data to a newly created database, as opposed to restoring
over an existent one, please refer to the following steps:
1.
2.
3.
4.

Open the Restore wizard.
Load a backup, then click Next.
In the Available Databases list, select Create new Database.
Under Set Restore Settings, Select Move database location and specify the paths of
the database location and logs location in the DB Location and Logs Location fields
respectively.
5. Select Leave database non operational if there are still other differential or
transaction runs that you wish to restore after this run.
6. Click Next to start restore.

Restoring Over an Existing Database
Before attempting to restore a system database (Master, MSdb, model, or Pubs) you must
start SQL Sever in single user mode.
1.
2.
3.
4.
5.

Open the Restore wizard.
Load a backup, then click Next.
From the Available Databases list, select the database you wish to restore to.
Under Settings, select Restore over existing database.
If you wish to change the location of the database and log; under Settings, select Move
Database location then specify the new paths for the Database and logs in the DB
Location and Logs Location fields respectively. Keep unchecked if you wish to restore
to original location.
6. Select Leave database non operational if there are still other differential or
transaction runs that you wish to restore after this run.
7. Click Next to start restore.

Restoring Exchange Server Data
Please read Prerequisites for Restoring Exchange Server, to ensure that Exchange Server is
configured properly before attempting to restore your Exchange Server data using Genie Backup
Manager.
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If you have multiple runs to restore, it is recommended that you read Restoring Exchange Data
from Multiple Runs before proceeding.
How to Restore Exchange Data?
1. Open the restore wizard.
2. Load a backup, then click Next.
3. Expand the tree under Exchange Server and select an instance (you are only allowed
to restore one instance at a time)
4. From the right pane select the mailboxes you wish to restore
5. Specify a temp location path
Note
You can set GBM to automatically mount the database after restoration by selecting Mount
database after restore
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Genie Disaster Recovery
Disaster recovery focuses on continuous system protection by backing up Windows, system
state, documents, settings, and programs to recover the system to a stable state prior system
failure.
Genie Backup Manager provides an easy to use wizard to create the disaster recovery backup.
Genie Disaster Recovery consists of two main steps
1. Create Genie Disaster Recovery (GDR) Bootable Disk
2. Create Genie Disaster Recovery (GDR) Backup
Opening the Disaster Recovery Wizard

To start the Disaster Recovery wizard do the following:



From the Main Screen click the Disaster Recovery button.

Important Note:
Disaster Recovery Backup should only be restored on the same hardware configuration of the
Disaster Recovery Backup.
Disaster Recovery backup is not supported on FTP and Amazon S3 storage

How to: Create Genie Disaster Recovery Bootable Disk
Genie Disaster Recovery (GDR) Bootable disc enables GBM to restore your Disaster recovery
data outside the Windows environment.
The boot disc is mainly a CD or DVD disc used to start GBM's Disaster Recovery's restore wizard
and therefore enables the user to select the most recent disaster recovery backup. Only one
copy of this disc is required, therefore it is unnecessary to perform this step every time a
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disaster recovery backup is performed.
This disc contains of the following components:

1. Windows boot files
2. Genie runtime files necessary to run the Disaster Recovery restore wizard
Important note:
You must create this bootable disc in order to restore your disaster recovery data, as the
regular GBM program is only operable in Windows environment.
To Create GDR Bootable Disc
1. In the Main Page, Select Disaster Recovery
2. A Dialog will open, click Create GDR Bootable or in the Welcome Page of the Disaster
recovery wizard, Select Create Genie Disaster Recovery (GDR) Bootable disc, then
click Next
3. Select the bootable Media to boot from:



CD/DVD recorder: Create a bootable CD or DVD



Create ISO Image: This enables users to create the boot image as a .iso file on
the local drive to be burnt using third party burning software.

4. Click Next to continue

How to: Create Genie Disaster Recovery Backup

How To: Create Genie Disaster Recovery Backup
After Genie Disaster Recovery bootable disc is created, it is required to backup essential data to
restore your system to the previous state prior the disaster.
The following components are always added to the disaster recovery backup job:
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Windows Folder
Program Files
Documents and Settings

Disaster Recovery



System State

Note:
It is recommended that the GDR backup job only consists this data as this backup is restored
outside windows environment and for a faster recovery without any conflicts or errors, it is
recommended that the size stays reasonable and all other data should be backed up in a
different backup and restored inside windows environment. For more information, please refer
to Disaster Recovery Strategies
To Backup Genie Disaster Recovery (GDR) Backup:
1. In the Main Page, select Disaster Recovery
2. If a Genie Disaster Recovery Bootable disk is not created and you do not wish to create
one in the time being, then click Skip creating disk. If a disk has been created, then
in the welcome page Select Create Disaster Recovery Backup and click Next
3. In Where to Backup page, Select the Backup Destination
4. In What to Backup a list of Disaster Recovery Data is displayed you can add additional
folders by clicking on Add Additional Files/Folders link or via My Folders Tab.
5. From the Settings Page Select the Settings of the backup job
6. Click Next to start backup

Important Note:
Creating Disaster Recovery bootable disk is essential to restore your Disaster Recovery Backup
job. However, this disk is system independent so you can create it on any system prior
restoration.

Disaster Recovery: Where to Backup
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In Disaster recovery you can backup to the following locations:
Internal and External Drives: This includes local drives, External USB drives, and Flask disks.
You can also enable multi drive spanning to span your disaster recovery backup to more than
one location
Network locations: This includes any drive, RAID, SANs NAS... remotely off your computer
Optical Media:This includes (DVD±RW/DVD±R/DVD-RAM/CD-R/CD-RW), including double layer
DVDs and Blu-ray, using both built-in burning capability and packet writing - with the aid of third
party software-.
Removable media: You can also create External USB, Flash disks, Zip, Jaz using removable
media option
Note:
Backing up to FTP and Amazon S3 are not supported

Disaster Recovery: What to Backup
What to Backup Consists of Two Tabs:
My GDR: Contains the essential data necessary to restore your system after failure to boot your
operating system or if it becomes unstable. This data consists the following:






Windows Folder: Contains the Windows Folder; Drive:\Windows
Program Files: Contains data of installed programs; Drive:\Program Files
Documents and Settings: Contains Documents and Settings Data for All users;
Drive:\Documents and settings
System State: Contains the following:
 Boot files, including system files and performance counter configurations
 COM+ Class registration database: A store of registration information for COM
objects in the Windows system. COM is a standard for binary interoperability of
registered software components.
 Windows Registry: A database that Windows uses to store hardware and
software configuration information, user preferences and setup information
 System Files under Windows File protection: A system service that protects
special operating system files. In the event that one of these files is deleted or
overwritten, System File Protection will replace the file with the original from its
cache

My Folders: If you wish to add other important files to your backup you can do so from the
Add additional Files/ Folders link or by Clicking on My Folders tab.
Note
Adding additional Files/Folders is not recommended because it will increase the size of the
backup and time resulting in increasing time of system recovery. It is recommended to keep a
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separate backup for your personal files/folders and restore them in Windows environment. For
more information, please refer to Disaster Recovery Strategies

Disaster Recovery Settings
The user can configure the disaster recovery backup job with the following settings:
Compression: Create Disaster Recovery backup with non-proprietary 64- bit ZIP compression
or perform backup without compression to view backup in native format. For more information,
please review the Compression section in the help documentation
Security: Disaster Recovery backup can be secured with multiple levels of protection to ensure
that backed up data is not accessible to unauthorized persons. Either with Zip password
protection or AES encryption. For more information about security options, see the Security in
GBM section.

Disaster Recovery Strategies
Having a disaster recovery job minimizes Recovery Time Objective (RTO) after unstable
systems, hardware failure, virus attacks, and erroneous deletion of system files...
Restoring Disaster Recovery is performed outside Windows environment; therefore, the disaster
recovery job consists of two Parts
1. Creating a bootable disk to run the disaster recovery restoration environment
2. The actual disaster recovery job.
To restore your data, you must insert the bootable disk when the computer starts, then browse
for your Disaster recovery job.

To ensure faster RTO, it is recommended:
1. Perform disaster Recovery on a newly installed machine with all important
programs installed on the system: Disaster Recovery job includes Windows folder, program
files, documents and settings, and System state; however, in fears of virus attacks, spyware or
other malicious attacks on these files; it is recommended that you perform disaster recovery on
a clean system to ensure consistent data.
2. Keep your disaster recovery backup as small as possible: Restoring disaster recovery
data is performed outside windows environment, leaving the system unfeasible. Therefore, it is
not recommended to include large files and folders in the Disaster recovery job, assuring faster
recovery time of the operating system. When the system is up, you may restore your data in
windows environment, if needed.
3. Perform separate backups of your data: GBM enables fast backup and restore of data
backups inside Windows environment. Therefore, it is recommended to perform recurrentscheduled data backups to avoid minimum data loss.
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Walkthrough: Creating Disaster Recovery
This Walkthrough summarizes how to create a complete disaster recovery backup

Step 1: Create Genie Disaster Recovery Bootable
In this Step you will create a bootable CD/DVD needed to boot the restoration runtime
environment. This step is only required once
Requirements: Blank or empty CD/DVD.
Recommended: New CD/DVD
Steps:
Create Bootable CD/DVD Disc
1. In the Main Page, Select Disaster Recovery
2. A Dialog will open, click Create GDR Bootable or in the Welcome Page of the
Disaster Recovery wizard, Select Create Genie Disaster Recovery (GDR) Bootable
disc, then click Next
3. Select CD/DVD Recorder and choose CD/DVD writer that contains a blank or empty
CD/DVD in order to create your bootable disc
4. Click Next to continue
Create ISO Image
1. In the Main Page, Select Disaster Recovery
2. A Dialog will open, click Create GDR Bootable or in the Welcome Page of the
Disaster Recovery wizard, Select Create Genie Disaster Recovery (GDR) Bootable
disc, then click Next
3. Select Create ISO Image and select a drive with efficient space to create this image
4. Click Next to continue
5. After the image is created, use a third party burning software to open the image and
burn it on a CD/DVD
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Warning: GBM will erase all contents of the disk prior creating the bootable disk; therefore,
please make sure that the disk does not contain any important data.
Step2: Create Disaster Recovery Job:
This step backs up the main data necessary to recover your system after it fails to load properly
Requirements: Backup storage media;
Recommended: External, or Network location.
Steps:
1. In the Main Page, select Disaster Recovery
2. If a Genie Disaster Recovery Bootable disk is not created and you do not wish to create one in
the time being, not recommended, and then click Skip creating disk. If a disk has been
created; in the welcome page Select Create Genie Disaster Recovery(GDR) Backup and
click Next
3. In Where to Backup page, Select the Backup Destination
4. In What to Backup a list of Disaster Recovery Data is displayed you can add additional
folders by clicking on Add Additional Files/Folders link or via My Folders Tab.
5. From the Settings Page Select the Settings of the backup job
6. Click Next to start backup

Restoring Disaster Recovery Job
Restoring Disaster Recovery Job
Disaster Recovery jobs are restored outside Windows environment. Therefore, the disaster
recovery boot disc loads the recovery environment and then after the disaster Recovery restore
wizard is loaded you can simply restore your system.
How to boot up the Disaster Recovery enviornment:
1. Insert the Disaster Recovery bootable disk you have created. If you haven't created one,
you can install GBM on any computer and create a bootable disk.
2. Restart your computer.
3. Change the boot sequence inside your BIOS, to enter BIOS or "Setup" the hotkey is
presented when you first start up your computer. It is usually Delete or F2.
4. Make the first boot sequence the CD/DVD drive.
5. The Disaster Recovery Restore wizard should appear.

181

GBM User Manual

Genie Disaster Recovery Restore Wizard
This Wizard loads up outside Windows environment when booting up the system from Genie
Disaster Recovery Bootable Media
These are the steps that you must confirm in the Genie Disaster Recovery restore wizard:
1. Select a file to restore: Select the Disaster recovery backup archive you wish to
restore data from. Depending on the destination on which the backup is stored, select
one of the following options from the left menu:
 Disk Restore: For selecting and loading a backup stored on disk-based media
 Online Restore: Select and load a Disaster Recovery job stored on your Genie
Online Backup Account.
2. Disaster Recovery Mode: This enabled users to select the whether to restore all data
or select specific data to restore, and whether to restore the boot manager.
3. Data Selection: Select the files and folders you wish restore. This step appears only if
custom restore is selected

Utilities

- Opens Windows Explorer
- Opens Mozilla Firefox web browser
- Opens FTP client to browse FTP sites
- Opens a partitioner utility enabling hard disk partitioning
- Opens Windows Notepad program.
- Opens Windows Command Prompt "cmd.exe" program.
- Enables network drive mapping to restore disaster recovery jobs stored on
a network location
- Views the status of the network connections

- Opens the Remote desktop connection to connect to a remote computer
- Enables users to install additional drivers
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Menu Commands
Menu

Item

Function

File

Exit

Close this wizard and return to Windows.

System
Utilities

Explore My
Computer
Windows Tasks
Manager
Partition
Manager
Notepad
Command
Prompt
Install Driver

Open Windows Explorer.

Web Browser

Open Mozilla Firefox web browser.

FTP Client
Telnet

Open FTP client to browse FTP sites
Enable access via Telnet protocol

Map Network
Drive
View Network
Status
Remote
Desktop
Connection

Enable network drive mapping to restore disaster
recovery jobs stored on a network location.
View the status of the network connections.

Contents
About

Open the help documentation.
Credits and basic information about the product.

Web
Utilities

Network
Utilities

Help

Open the Windows tasks manager.
Open a partitioner utility enabling hard disk
partitioning .
Open Windows Notepad program.
Open Windows Command Prompt "cmd.exe"
program.
Enable users to install additional drivers.

Open the Remote desktop connection to connect to
a remote computer

How to: Restore Disaster Recovery Job?
Disaster Recovery is only used to restore your current windows installation from virus attacks,
accidental deletion of system files, or any action leading to an unstable system.
You can simply restore your disaster recovery job by following these steps:
1. Make Sure that your CD/DVD Drive is the first bootable device in your boot sequence
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2. Insert the Genie Disaster Recovery Bootable media in your drive while your computer is
starting up
3. Press any key to boot from the disc
4. After the booting completes the Genie Disaster Recovery Restore wizard will appear,
browse for your disaster recovery backup. If the backup is spanned to multiple locations,
browse to the last location/disk it has spanned to.
5. Select Disaster Recovery Restore Mode
 Full disaster Recovery Restores (Highly Recommended)
 This option restores all disaster recovery data backed up in the disaster
recovery job. This mode is highly recommended as it ensures stable
recovery
 Custom Restore (for Advanced users)
 This option enables advanced users to select the items they wish to
recover. This is recommended for advanced users as it is difficult to
determine the cause of an unstable system and does not ensure full
recovery.
 Enable Restore Boot Manager (Highly Recommended) in the following two
cases:
1. You only have one Operating System installed
2. You have performed this Disaster Recovery job after installing all
Operating Systems on your machine
6. Click Next.
7. Continue with Restoration process
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Logs and Reports
Genie Backup Manager offers a variety of detailed logs and reports that help users to keep track
of what happens during its various operations, the most important of which is backup.

The Logs Manager
The Logs Manager utility provides users with a graphical interface for viewing, exporting and
printing backup activity logs. The logs manager keeps a complete archive of all the logs
produced by backup jobs that are currently configured in the Jobs Manager.
To open the Logs Manager, Click Tools, then select Logs Manager. Users have the choice of
viewing backup jobs in the following sorting orders:




By Jobs: Logs are sorted according to the names of their respective backup jobs.
Expanding the tree beneath a backup job displays a list of its versions sorted according
to their dates.
By Date: Logs are sorted according to the date on which the backup job was run. Jobs
that were run on the same day are grouped together.

The logs manager offers two types of logs: Normal and Detailed.

Normal
The normal log is opened by default after each backup run. It displays a summary of the backup
task's settings and statistics, grouped into four sections:






Job information: selected backup job settings, including the job's name, backup
destination, backup type, etc.
Backup information: a breakdown of the types and sizes of the backed up data
sources.
Backup summary: a summary of the types of processed files (new, modified,
unchanged, deleted, skipped) and errors encountered during backup.
Data integrity test: displays a summary of errors encountered during testing the
integrity of each file in the backup archive (if any).

You can print this log by clicking Print, or save it as an html file by clicking Save as.

Detailed
The detailed log lists all processed files along with each file's status - whether successfully
backed up or not. Genie Backup Manager's internal files - files creating by GBM in the backup
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archive for the purpose of cataloging and indexing - are hidden by default. You can view them by
checking the Show GBM system files option.
To only view skipped file - files that GBM failed to backup - select Show only skipped/failed
files and folders.
This log can be saved to a text file that can be later on printed or emailed by clicking the Export
button.

The Backup Log
The normal log is opened by default after each backup run. It displays a summary of the backup
task's settings and statistics, grouped into four sections:






Job information: selected backup job settings, including the job's name, backup
destination, backup type, etc.
Backup information: a breakdown of the types and sizes of the backed up data
sources.
Backup summary: a summary of the types of processed files (new, modified,
unchanged, deleted, skipped) and errors encountered during backup.
Data integrity test: displays a summary of errors encountered during testing the
integrity of each file in the backup archive (if any).

The Restore Log
To view the log file containing details about GBM's activity during restore click View Restore
Log in the last screen of the restore wizard
Their is only one restore log, which is overwritten during every restore task. The Restore log file
is located in the following folder:
Windows 2000/XP/2003: Drive:\Documents and Settings\%Username%\Application Data\GenieSoft\GBMAPPLICATION\Jobs\restore.html
Windows Vista and above:
C:\Users\USERNAME\AppData\Roaming\Genie-Soft\GBMAPPLICATION\Jobs\restore.html

Data Verification Log
After using the Data Integrity Test tool to perform data verification on a backup archive, you can
click the View Test Log button to display an HTML file containing the test results. Any
encountered errors will be listed in the log.
For a complete list of backed up files and the status of each tested file, select Click here for a
more detailed log.
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Event Viewer logging
Event Viewer maintains logs about program, security, and system events on your computer. You
can use Event Viewer to view and manage the event logs, gather information about hardware
and software problems, and monitor Windows security events. GBM logs backup information in
the Application logs of the Event viewer.

Opening the Event Viewer
To open Event Viewer, click Start > Control Panel > Administrative Tools > then doubleclick Event Viewer.

Logging information found in the event viewer:
GBM logs in the event viewer when three events occurs:
Starting a backup: GBM places the backup job name, backup media, backup type, and security
option applied for the job in the log.
Backup ending: The backup job name, backup size, and verification status are logged.
Applying power options: The power option type is logged.

Advanced Logging
GBM Trace Log
When trace log is activated, Genie Backup Manage logs all backup activities and dumps the
verbose to a file, for purposes of debugging. The file is typically located in:
Windows 2000/XP/2003: Drive:\Documents and Settings\%Username%\Application Data\GenieSoft\GBMAPPLICATION\Logs
Windows Vista:
C:\Users\USERNAME\AppData\Roaming\Genie-Soft\GBMAPPLICATION\Logs
Where X is the letter of the drive on which Windows is installed.
To activate the GBM trace log click the Tools menu, select Global Preferences, select
General, select Advanced, make sure Enable advanced logging for debugging is checked.
Note that activating the trace log will slightly slow down the program's operations.
The trace log is emptied every time Genie Backup Manager is restarted.

VSS Trace Log
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Genie Backup Manager logs all Volume Shadow Copy operations and stores them in a file
typically located in
Windows 2000/XP/2003: Drive:\Documents and Settings\%Username%\Application Data\GenieSoft\GBMAPPLICATION\Logs\vsslog.log
Windows Vista:
C:\Users\USERNAME\AppData\Roaming\Genie-Soft\GBMAPPLICATION\Logs\vsslog.log
If you encounter a problem with backup while GBM is set to use Microsoft's Volume Shadow
Copy service to backup open files, submit this file to the Genie9 support team for debugging.
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Email Notification
Email Notification
If you are a network administrator who is always on the move, and you've scheduled backup
jobs to run while you're away, but still need to make sure everything goes smoothly, then email
notification is the feature you need.
E-mail notification is a nifty feature that enables GBM to send information to the user about the
status of the performed backup upon its completion via email.

How to: Activate E-mail Notification
1.
2.
3.
4.

From the toolbar click Tools,then select Preferences.
Select Email Settings.
Select Enable e-mail notification.
Enter the following settings:








SMTP server: The name or IP address of SMTP server to be used for sending
notification emails
Port: SMTP sending port. (25 by default)
SSL: SSL (Secure Sockets Layer) is a security protocol that provides
communication privacy. Select this option if your SMTP server supports this
protocol.
From: The email address to appear in the From field of the sent notification
email
To: The address of the recipient of the notification email
Subject: Enter the description that will appear in the Subject field on the sent
email

How to: Send Email Notifications
1.
2.
3.
4.
5.

Make sure email notification is enabled.
From the left navigation menu in the backup wizard select Settings.
Click More Settings then select Email Notification.
Select Send e-mail notification.
Choose one of the following options:




When backup is complete: Send notification email when backup is over.
Only if error occurs: Send notification email only if GBM encountered a
problem during backup (skipped files, failed to create backup file, etc...)

1. Type a subject for the submitted email. If you do not manually enter a subject line, it
will by default be sent as "GBM Backup Notification"

SMTP Authentication
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GBM supports different SMTP authentication methods for sending email notifications. SMTP
authentication uses different methods of encryption to protect the user mail account's name and
password as they are being sent to the SMTP server. If you do not know which authentication
method your email server uses, please consult your system administrator.
To choose an authentication method:
1.
2.
3.
4.

From toolbar, click Tools, then select Preferences.
Select Email Notification Settings.
Click Authentication Method.
Choose one of the following authentication methods:






NONE: Send the password to the server in an insecure format.
AUTH LOGIN: Most common authentication method.
CRAM MD5: (Challenge Response Authentication Mode), most secure
authentication method.
LOGIN PLAIN: Sends authentication in plain text

Sound Alerts
Genie Backup Manager can be set to play sound files to notify users when specific backuprelated events take place, such as when a backup task is completed, or when GBM prompts the
user to replace a storage volume.
To open the Sound Alerts settings page, click Tools, select Global Preferences, expand the
General list, then select Sounds.
To disable sound alerts, uncheck the Enable sound alerts option.
To attach a sound file to a predefined event, select the event from the list, select Attach sound
to selected event, then click Browse to select a sound file from your computer.

Events that support sound alerts are:
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Finishing backup successfully.
Finishing backup with errors.
Completing data verification.
Prompting the user to replace disk during a multiple media backup.
Finishing data integrity testing.

Scripting
Scripting in Genie Backup Manager
GBM offers two powerful scripting environments that can help users take control of what and
how they backup




GenieScript: XML-based scripting designed to enable users to create custom plugins
that extend the capabilities of GBM.
GRunScript: Most backup software offer complex command line options to allow users
to perform backups without using the user interface, a feature which is intended to
provide extended flexibility for advanced users who wish for instance to create batch
files that can be shared with other network users to perform standardized backup tasks.
Genie Backup Manager takes this a step further by allowing users to create complete
backup jobs using XML based scripting.

Using XML Tags
This page is not intended to teach you scripting per se', it will however give you an insight on
the way tags work. GenieScript and GRunScript are very simple, and you don't have to be an
advanced user to understand how to use them for writing scripts. You can learn scripting while
creating your first GenieScript plugin, or GRunScript backup job, especially with the aid of the
Templates and Examples provided in this help section.
Tags are commands that come in two parts: A beginning and a closing tag, both parts are
enclosed within brackets, and the difference between a beginning and an ending tag is the
forward slash </> on the latter.
Ex: <Author> Genie9</Author>
The bracketed text is the command that needs to be performed, the text between the beginning
and ending tags is a value that is passed on to the command, for instance in the previous
example, the tag <Author> passes on the name of the author of the script to the compiler.
Sometimes tags also have properties; these are subcommands that are usually included in the
beginning tag that pass on specific properties to the compiler related to the main tag command.
Ex: <Folder IncludeSub =" False"> C:\personal </Folder>
Here, the tag <Folder> is telling GBM to backup the folder (C:\personal), the property
IncludeSub which is set to False instructs it to only backup files in the main folder, and to ignore
any underlying subfolders.

Note:



Tags are case sensitive.
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Environmental Variables
Environmental Variables are like the wildcards of file and folder paths, they are provided by
Windows so as to enable writing portable bits of code to be used on any Windows platform.
Each one of these variables corresponds to a certain system or custom folder in the Windows
OS, and will always get the right path for that folder, which might differ from one Windows
platform to another.
Say for instance that you want to write a code that uses the file Notepad.exe file located in the
Windows directory, in that case you would refer to the path to that file as
$$P_WIN$$/Notepad.exe, that will ensure that your code points to the right path whether you're
working under Windows XP, Vista or Server platforms
Here's a list of all Windows and custom environmental variables that you can use when writing
scripts:
Windows Environmental Variables
$$P_WIN$$

Windows path (C:\WINNT, C:\Windows)

$$P_WINTEMP$$

Windows temporary location

$$P_PROGRAM_FILES$$

Program files folder. A typical path is C:\Program Files.

$$P_COMMON_PROGRAMFILES$$ Contains application program related files that are, or
can be, used by more than one application program.
A typical path is C:\Program Files\Common Files
$$P_DESKTOP$$

File system directory used to physically store file objects
on the desktop (not to be confused with the desktop
folder itself).
A typical path is C:\Documents and
Settings\username\Desktop

$$P_COMMON_DESKTOP$$

Refers to the desktop items common for all the users.
A typical path is C:\Documents and Settings\All
Users\Desktop.

$$P_PROGRAMS$$

File system directory that contains the user's program
groups (which are also file system directories). A typical
path is C:\Documents and Settings\username\Start
Menu\Programs.

$$P_STARTMENU$$

File system directory containing Start menu items. A
typical path is C:\Documents and
Settings\username\Start Menu.

$$P_APPDATA$$

File system directory that serves as a common repository
for application-specific data. A typical path is
C:\Documents and Settings\username\Application Data
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$$P_SENDTO$$

File system directory that contains Send To menu items.
A typical path is C:\Documents and
Settings\username\SendTo.

$$P_STARTUP$$

File system directory that corresponds to the user's
Startup program group. The system starts these
programs whenever any user logs onto Windows NT® or
starts Windows® 95. A typical path is C:\Documents and
Settings\username\Start Menu\Programs\Startup.

$$P_COOKIES$$

File system directory that serves as a common repository
for Internet cookies. A typical path is C:\Documents and
Settings\username\Cookies.

$$P_FAVORITES$$

File system directory that serves as a common repository
for the user's favorite items. A typical path is
C:\Documents and Settings\username\Favorites.

$$P_HISTORY$$

File system directory that serves as a common repository
for Internet history items.

$$P_INTERNET_CACHE$$

File system directory that serves as a common repository
for temporary Internet files. A typical path is
C:\Documents and Settings\username\Temporary
Internet Files.

$$P_PERSONAL$$

File system directory that serves as a common repository
for documents. A typical path is C:\Documents and
Settings\username\My Documents.

$$P_COMMON_DOCUMENTS$$

Refers to the Documents common for all users.
Typical path C:\Documents and Settings\All
Users\Documents

$$P_COMMON_MUSIC$$

Refers to music files common for all users.
Typical path C:\Documents and Settings\All Users\Music

$$P_COMMON_PICTURES$$

Refers to pictures and image files common for all users.
Typical path C:\Documents and Settings\All
Users\Pictures

$$P_COMMON_VIDEO$$

Refers to video and media files common for all users.
Typical path C:\Documents and Settings\All Users\Video

$$P_RECENT$$

File system directory that contains the user's most
recently used documents. A typical path is C:\Documents
and Settings\username\Recent.

$$P_TEMPLATES$$

File system directory that serves as a common repository
for document templates.

$$P_SYSTEM$$

System folder. A typical path is C:\WINNT\SYSTEM32

$$P_LOCAL_APPDATA$$

File system directory that serves as a data repository for
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local (nonroaming) applications. A typical path is
C:\Documents and Settings\username\Local
Settings\Application Data
$$P_COMMON_PROGRAMS$$

File system directory that contains the directories for the
common program groups that appear on the Start menu
for all users. A typical path is C:\Documents and
Settings\All Users\Start Menu\Programs.

$$P_COMMON_STARTMENU$$

File system directory that contains the programs and
folders that appear on the Start menu for all users. A
typical path is C:\Documents and Settings\All Users\Start
Menu.

$$P_COMMON_STARTUP$$

File system directory that contains the programs that
appear in the Startup folder for all users. A typical path is
C:\Documents and Settings\All Users\Start
Menu\Programs\Startup.

$$P_COMMON_TEMPLATES$$

File system directory that contains the templates that are
available to all users. A typical path is C:\Documents and
Settings\All Users\Templates.

$$P_COMMON_APPDATA$$

Application data for all users. A typical path is
C:\Documents and Settings\All Users\Application Data.

$$P_CONNECTIONS$$

Refers to network and Dial-up Connections.

$$P_CDBURN_AREA$$

Refers to staging area used by Windows to store the data
before recording to CD.
Typical path USERPROFILE\Local Settings\Application
Data\Microsoft\CD Burning

$$P_NETHOOD$$

Location of the "Network Neighborhood" folder. Typically
located in "\Documents and
Settings\%Username%\NetHood"
Custom Environmental Variables

$$<Variable Name>$$

Returns the path or file/folder name assigned to the
variable in the <Variables> tag

$$P_APPPATH$$

Path for the application retrieved from Registry using the
<Path> tag (GenieScript)

$$P_APPPATHEXE$$

Current Application EXE file name. (GenieScript)

$$P_COMPUTERNAME$$

Returns network name for the computer on which the
backup job is being run.

$$P_USERNAME$$

Returns username of the user currently logged on into
Windows.

Plugin Scripting (GenieScript)
Plugin Scripting (GenieScript)
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GenieScript is XML-based scripting designed to enable users to create custom plugins that
extend the capabilities of GBM.

What Can GenieScript Do?
Any installed Windows based application stores data and settings on your computer through a
number of "changes" that it makes to your system, such as copying files to certain folders,
writing to registry, etc... GenieScript gives you access to these program-unique changes and
data so that you can back them up for safe keeping and restore them whenever the need to do
so arises. This means that with GenieScript you can backup anything from application settings
and saved games to entire programs.
GenieScript can be used effectively to automate the backup of items such as:







Entire programs.
Program settings and preferences.
Database files.
Mail clients' data.
Game saves.

And much more.
GenieScript also provides the means for making backed up items portable between different
Windows platforms using Environmental Variables.

Creating a Plugin
How to: Create a Plugin using XML Tags
In order to simplify learning GenieScript we've written an example using all the tags needed to
write a full plugin script and added explanation after each tag or block of script using the script
comments convention. (Sentences enclosed in <!-- --> are comments that the compiler will
ignore and are only there for the benefit of whoever reviews the script).
Notes:





Click the plus sign to view sub-tags and explanation.
Tags are case sensitive.
The script must be written using the same tag order as listed above.

<Backup> <!-- Starts the script file, a necessary tag that tells the compiler that the plugin script
has begun. -->
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<!-- Using GenieScript, you can create a plugin that backups up multiple items or programs.
Each individual application or group of settings you wish to backup should be enclosed
within the <Program> </Program> tags. -->

<Program> <!-- Begins the Program tag to indicate the start of a program's backup. -->
<!-- This is the section where you specify basic information about the group of
items you are backing up; if it's a whole application you should write its given name
and assign a category to it, otherwise you can choose any name you wish. -->

<Main> <!-- List basic information about the plugin and the data it backs up. -->
<Name> Winamp </Name>
<!-- Assigns a to the plugin, If you are backing up a program or an
application's settings, you should use the name of the program, for
example: Winamp, WinZip etc... If the script is intended to backup
a group of personal data items not related to an application, you
can choose any name you like. -->

<Category> Media </Category>
<!-- Assigns a category to the group of backed up data items, we
use CNET download.com programs categorizing scheme, for
example, Winamp goes under Media. If you're not backing up a full
application you can use either "Settings" or "Folders" to describe
the plugin. -->

<SubCategory> Player </SubCategory>
<!-- Optional. Assigns a subcategory to the plugin, we use CNET
download.com subcategories assigning convention, for example
the subcategory for Winamp would be Players. -->

<HomePageURL> http://www.winamp.com </HomePageURL>
<!-- Optional. Specifies a URL containing more information about
the data that the plugin is intended to backup, if one exists, The
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home page for the program backed up by the plugin is usually
used. -->

<HomePageText> Winamp Website </HomePageText>
<!-- Optional. Assigns a text description to link to the Homepage
URL, for example "Winamp Website", if non is given, the address
itself will be used as linking text. -->

<Note> Backup all winamp skins and plugins </Note>
<!-- This tag is used to write a small description for the benefit of
the user using the plugin, about what the script does, what items it
backs up, and any other relevant information. -->

</Main>

<Version> <!-- Declare the version(s) of an application that this plugin will be able
to backup. -->
<!-- Declares the start of the version script block. Which denotes the
versions of the application which the plugin is tested and will backup
successfully. -->
<Min> 2.0.0 </Min>
<!-- Specifies the earliest version of the application that is
supported by this plugin. To find out the version of the application
you're trying to backup:
1. Open Windows Explorer and browse to the location of the
main executable (.exe) file for the application in question.
2. Right click on the file and select Properties from the menu.
3. Click the Versions tab. -->

<Max> 2.9.9 </Max>
<!-- Specifies the latest version of the application that this script
can backup properly. -->
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</Version>

<Path> <!-- Retrieve the path of an application's program folder. -->
<!-- This section will tell Genie Backup Manager from where to get the path
to the program's main folder.
Every program stores its main program folder's path somewhere in the
registry.
Note that this path indicates the location of the program's main folder which
Genie Backup Manager will by default include in the backup, but in some
cases the program might store files and folders in other locations, these
can be backed up using the Folders and Files tags and with the help of
Variables.
To get the path for your script, you need to locate a registry key that points
to the main program executable file. For instance in Genie Backup
Manager that path is typically: C:\Program
Files\Genie9\GBM9Server\GBM9.exe. Once that registry key is provided in
the script, the plugin will use it to determine the main program folder for the
application during backup and restore, this ensures that the plugin will work
whether the user decides to install the program to its default location or to
an alternative folder. There are 4 scenarios that the user can choose from
while writing the path retrieval block in the script.
1st Scenario (Backing Up Personal Data and Program-Independent
Files and Folders).
If the user intends to backup program-independent data, such as
a personal work folder, or a folder containing MP3s etc... The
<Type> tag must be set to -1
Example:
<Path>
<FileName/>
<Type> -1 </Type>
<KeyName/>
<Value/>
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<IncludeSub> FALSE </IncludeSub>
<Enable> FALSE </Enable>
</Path>

2nd Scenario.
The default location that most programs use for storing the path
to its main executable file is the App Paths subkey in the
HKEY_LOCAL_MACHINE registry tree.
To find out whether the path to the application you intend to
create a plugin for is stored in this key browse to the key
"HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\Current
Version\App Paths\" and look for a subkey carrying the name of
the program's main executable file. If you find it, set the <Type>
tag to 1. and set the <KeyName> tag to the executable file
name.
Genie Backup Manager stores its path in:
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentV
ersion\App Paths\GBMServer7.exe
So the path tag would look like...
<Path>
<FileName> gbm7.exe </FileName>
<Type> 1 </Type>
<KeyName>GBMserver7.exe</KeyName>
<Value> Default </Value>
<IncludeSub> TRUE </IncludeSub>
<Enable> TRUE </Enable>
</Path>

3rd Scenario.
If you couldn't find the required registry key using the previous
method, you might be able to use type 2, which retrieves the
path using a file extension that is associated with the program.
For instance (.gbm) is a file extension usually associated with
Genie Backup Manager, (psd) is a file extension typically
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associated with Adobe Photoshop. These files are usually
assigned an icon that is stored in the application's main
executable file.
To use this path retrieval type:
1. Right click on the HKEY_CLASSES_ROOT tree and click
Find.
2. Type the main executable filename preceded by a
backslash (\) , for instance <\gbm7.exe>.
3. Make sure that only the Data checkbox is ticked.
4. Click Find Next.
If you find a DefaultIcon subkey with a value that points to the
path, then type 2 is the way to go.
Example:
Genie Backup Manager has the extension (.gbm) associated with
it, so in the, HKEY_CLASSES_ROOT tree we find the subkey
\GBMFile\DefaultIcon , with the default value pointing to the
path. With that in mind the path block would look like...
<Path>
<FileName> gbm7.exe </FileName>
<Type> 2</Type>
<KeyName>GBMFile\DefaultIcon</KeyName>
<Value>Default</Value>
<IncludeSub> TRUE </IncludeSub>
<Enable> TRUE </Enable>
</Path>

4th Scenario (When All Else Fails).
When all else fails, the user can get the program path from
anywhere inside the registry, you can do that by searching
through the registry for the name of the main executable file of
the application, if a registry key turns up with a value that points
to the path of that file, it can be used for path retrieval.
To perform a search using the registry editor, do the following:
1. From the toolbar click Edit then select Find.
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2. Type the main executable filename preceded by a
backslash \ , for instance <\gbm7.exe>.
3. In the Look at group, make sure only Data is ticked.
4. Click Find Next.
Performing a search for Quicken's main executable (qw.exe),
returns the key:
HKEY_CURRENT_USER\Software\Netscape\Netscape
Navigator\Viewers
With the value: application/x-qfx
So the Path tag would look like...
<Path>
<FileName> qw.exe</FileName>
<Type> 3 </Type>
<KeyName>
HKEY_CURRENT_USER\Software\Netscape\Netscape
Navigator\Viewers </KeyName>
<Value>application/x-qfx </Value>
<IncludeSub> TRUE </IncludeSub>
<Enable> TRUE </Enable>
</Path>

To know which type (scenario) to use, you need to open the Registry
Editor:
1. Click Start, then select Run.
2. Type regedit, then click OK. The Registry Editor will open. -->

<FileName> winamp.exe </FileName>
<!-- The name of the program's main executable (.exe) file, GBM
will refer to this file to retrieve the version of the program installed
on the machine during backup and restore. For instance Genie
Backup Manager's main executable file is named gbm7.exe -->
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<Type> 1 </Type>
<!-- Denotes one of 4 methods for retrieving the main program
folder's path. Click here for explanation. -->

<KeyName> Winamp.File\DefaultIcon </KeyName>
<!-- Indicates the registry key which contains the value that points
to the main program executable path. -->

<Value>Default</Value>
<!-- Default value= Default. Selects the value under the key
specified in the <KeyName> tag where the path is stored. This tag
is only applicable Type 2 and 3 only. -->

<IncludeSub>TRUE </IncludeSub>
<!-- Optional tag. Values TRUE or FALSE, Default = TRUE. Tells
GBM Server whether to include the subfolders when backing up
the main program folder or not, in most cases the user would want
this to be set to TRUE. -->

<Enable>TRUE</Enable>
<!-- Optional tag. Values TRUE or FALSE, Default = TRUE. Tells
Genie Backup Manager whether to backup the main program
folder, the user might want to set this to False for instance if he is
trying to backup specific settings or saved games, and not the
whole application, in which case Genie Backup Manager won't
backup the program folder but will check whether the program
exists or not when its time to restore those settings. -->

</Path>

<Variables> <-- Declare variables that will be used around the script. -->
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<!-- The path tag allows the user to get the main program folder's path from
the registry because that path can vary from one computer to another, or
from one platform to another. What if there are more than one folder
associated with the program you intend to backup? Also, What if you
encountered a file or a folder whose name or path is repeated several
times within the plugin script? Do you need to write the complete path over
and over, everywhere it appears in the script?
The Variables tag is provided to tackle such scenarios.
When a variable is assigned a string value (i.e. a file, folder or registry key
path or name), then every time that variable is used within the script (using
$$<Variable Name>$$), it will be replaced with its corresponding value at
runtime.

The <Var> tag is used to declare a variable. This tag takes two parameters
name, type and value. -->
<Varname="x1"type="Direct"> I:\NapsterSetup.exe </Var>

<Varname="x2"> HKEY_CLASSES_ROOT\.ZIP </Var>

<Varname="x3"type= "Reg"value="Test1">

HKEY_CURRENT_USER\Software\Genie-soft\GBMPro9\Main </Var>

<!-- name: assigns a name to the declared variable, the assigned name
should be enclosed within quotation marks, for instance name = "X1". This
name is used to represent the variable throughout the script in the format
$$<Variable Name>$$.
type: takes one of two values: Direct, or Reg, the value needs to be
enclosed within quotation marks. Direct means that the string value
assigned to the declared variable will be taken as is, whereas Reg means
that the string assigned to the variable is a registry key path which points to
to a value that contains the string that will be assigned to the variable.
value: when the type parameter is set to Reg, value should contain the
name of the value in the specified registry key, containing the desired
string. -->

</Variables>
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<RegistryKeys> <!-- Backup Windows Registry keys, subkeys and values. -->
<!-- Most programs will depend on the registry for storing their preferences
and settings. So to be able to backup any application successfully you
need to backup all the changes it makes to the Windows registry.
You can instruct Genie Backup Manager to backup keys with or without
including their sub keys or you can specify certain key values to be
modified when restoring the data. -->

<KeyIncludeSub="TRUE"> HKEY_LOCAL_MACHINE\
<!-- <Key>: Starts the backup of a registry key, it takes takes one
parameter IncludeSub.
IncludeSub: Optional. Values TRUE or FALSE, Default = TRUE.
When set to TRUE, the specified registry key will be backed up
with all its subkeys, this parameter is optional, and is by default set
to TRUE.
The <Key> </Key> tags enclose the complete path for the registry
key that needs to be backed up. -->
SOFTWARE\Classes\Directory\ shell\Winamp.Bookmark </Key>

<!-- If you want to specify only some of the registry values contained in that
registry key, you need to do the following:-->
<KeyIncludeSub="TRUE">
<Key> HKEY_CURRENT_USER\Software\ Geniesoft\GBMServer9\Main </Key>
<Value> BComplete </Value>
<Value> BOEWithoutClose </Value>
<Value> BOLWithoutClose </Value>
<Value> CDWXP_CacheImage </Value>
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<!-- <Value> </Value> enclose the name of the registry value that
you want to be backed up. -->
</Key>

</RegistryKeys>

<Files> <!-- Backup files. Path strings can be used. -->
<File> <!-- Declares backup of a single file. -->
<From> $$P_WIN$$\uninstbb.exe </From>
<!-- Specifies the full path including the name of the
desired file. -->

<To> $$P_WIN$$ </To>
<!-- Tells Genie Backup Manager where to copy the
backed up file during restore. It need not be the same path
as the <From> backup path. -->

<Filter> FALSE </Filter>
<!-- Optional tag. Values TRUE or FALSE, Default =
FALSE. Some files, whether binary or text, sometimes
contain paths that point to files or folder that get changed
when the backed up program or item is restored to a
different folder, machine or Windows platform. To ensure
that the paths will still point to the correct locations, Genie
Backup Manager can parse the file and substitute such
paths with environmental variables. That get restored to
their correct values at restore time. -->

<NeverUninstall> TRUE </NeverUninstall>
<!-- Optional tag. Values TRUE or FALSE, Default =
FALSE. Set this to TRUE when backing up (dll) files and
system files that might be shared and should not be
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deleted if the Plugin Uninstal Utilityl was used to uninstall
the program. -->

<CompareTimeStamp> TRUE </CompareTimeStamp>
<!-- Optional tag. Values TRUE or FALSE, Default =
TRUE. Set this to TRUE if you wish to avoid replacing
newer files with older versions when you restore data
backed up using this plugin. -->

<RegServer> TRUE </RegServer>
Optional tag. Values TRUE or FALSE , Default = FALSE .
When set to TRUE this will register a dll or Active-X file
using regsvr32 (for advanced users). -->

</File>
</Files>

<Folders> <!-- Backup folders. Path strings can be used. -->
<!-- Specify complete folders to be backed up.


You don't need to backup the main program folder here, if you've
already specified its path in the path extraction block and set the
<Enabled> tag to TRUE. -->

<FolderIncludeSub="TRUE"Extension="*.h;*.cpp">
<!--This tag starts the backup of a single folder (with or without its
subfolders). More than one <Folder> tag can be used within the
<Folders> </Folders> block to back up more than one folder. This
tag takes two parameters IncludeSub and Extension.
IncludeSub: Optional. Values TRUE or FALSE, Default = TRUE.
When set to TRUE, tells Genie Backup Manager to backup all the
subfolders within the specified folder.
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Extension: Optional. Values: file extensions. This parameter
enables you to filter backed up files within the selected folder
according to file types (extensions). The selected file types will be
included in backup, other files will be ignored. The value of the
parameter needs to be in the format *.doc *.exe *.txt etc ... To
include more than one files extension, use the semicolon as a
separator. Example: Extension ="*.h;*.cpp;*.exe". -->

<From> $$P_PERSONAL$$\my data </From>
<!-- This tag is used to specify the full path of a folder
intended for backup. -->

<To> $$P_PERSONAL$$\my data </To>
<!-- Tells Genie Backup Manager where to copy the
backed up folder during restore. It need not be the same
path as the <From> backup path. -->

</Folder>
</Folders>

<Ini> <!-- Moidfy ini file entries. -->
<!-- Many applications append to ini files when their installed, and in many
cases write their own ini files to hold their settings and preferences, which
the user might modify while using the program. The <Ini> tag allows you to
backup certain portions of ini files instead of backing up and restoring the
entire file, which in some cases might lead to errors.
The following is a portion taken from the Windows system.ini file:
...
[drivers]
wave=mmdrv.dll
timer=timer.drv
[mci]
[driver32]
[386enh]
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woafont=dosapp.FON
EGA80WOA.FON=EGA80WOA.FON
EGA40WOA.FON=EGA40WOA.FON
CGA80WOA.FON=CGA80WOA.FON
CGA40WOA.FON=CGA40WOA.FON
...
In the explanation below [drivers] is a key. wave is a value while
mmdrv.dll is that value's data. -->

<IniFile> <!-- Modify a single ini file. Use as many of these blocks to
modify as many ini files as needed. -->
<File> $$P_WIN$$\win.ini </File>
<!--Specifies an ini file to open for modification. More than
one file can be modified in a single script. >

<Key> drivers </Key>
<!--Contains the name of the key in the ini file that the user
wishes to append new values to, or modify existing values
under. >

<ValueName> wave </ValueName>
<!--Specifies the name of the value to be appended or
modified within the ini file and under the Key specified in
the previous tag, <Key>. -->

<Value> mmdrv.dll </Value>
<!--Assigns data to the value selected in the previous tag,
<ValueName>. -->

<!-- Note:
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You can use as many of these last 3 tags as you need to
convey all the changes in an ini file. -->

</IniFile >
</Ini>

<Links> <!-- Backup shortcuts. -->
<!-- Most programs create shortcuts on the desktop among other locations
that serve as a link to the main executable file(s) for faster access.
GenieScript enables you to backup these shortcuts along with their
attributes.
Right-click on the desired link and choose properties, then use the data
inside the properties window in the following block of script. -->
<Link> <!-- Starts backup of an individual shortcut. -->
<URL>TRUE</URL>
<!- Optional tag. Values TRUE or FALSE, Default =
FALSE. This will create a URL link instead of normal
shortcut - a URL link is a link that points to an address on
the World Wide Web. -->

<SavePath> $$P_DESKTOP$$\Babylon.lnk </SavePath>
<!-- Contains the full path to the location of the shortcut file
to be backed up. -->

<Target> $$P_APPPATH$$\Babylon.exe </Target>
<!-- Specifies the full path of the target executable to which
the link refers, this path can be found in the target field in
the shortcut's properties window. If you are creating a URL
link, this should be an internet address path. -->

<IconIndex> 0 </IconIndex>
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<!-- Optional. Values: integers equal or larger than zero,
Default = 0. If you specify a file as the holder of the
shortcut's icon, in the <IconLocation> tag, the <IconIndex>
tag will indicate which of the embedded icons should be
used, by default the first icon with index 0 will be used.


To know which index number to use, click the
"change icon" button inside the shortcut properties
window, choose the desired file containing the
icons, you should then see all the available icons,
the index number is calculated starting from 0 at
the top left corner icon and increasing by one as
you go from left to right and then downwards.

If the shortcut has a default icon set by Windows, such as
text files (.txt), then write the following
<IconIndex/>
<IconLocation/>
-->

<IconLocation> $$P_APPPATH$$\ Babylon.exe </IconLocation>
<!-- This tag carries the full path of the file containing the
icon that will be assigned to the shortcut file. Note that this
file must either already exist on the destination machine (to
which the backed up data will be restored) or be included
with the backup, to insure that this tag does not point to a
non-existent file. -->

</Link>

</Links>

<Restore> <!-- Plugin restore settings. -->
<!-- After Backing up an application, you need to tell GBM Server where to
restore it to on the target machine, notice that here too you will be using
environmental variables in order to insure portability when needed. -->
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<RestorePath> $$P_PROGRAM_FILES$$\Babylon </RestorePath>

<!-- Contains the full path to which Genie Backup Manager should
restore your backed up application or item, if this tag is missing,
Genie Backup Manager will restore the program to the original path
location retrieved using the Path tag. -->

<RestoreNote> Comments </RestoreNote>

<!-- If you have any comments or notes about the restore
procedure, here is where it goes.-->

<PathMustExist> TRUE </PathMustExist>
<!-- Optional tag. Values TRUE or FALSE, Default = TRUE. When
set to TRUE, Genie Backup Manager will not restore the data
backed up using the plugin, unless the related application program
is installed on the target machine. -->

</Restore>

<Author> <!--Script author information. -->
<!-- Give credit where credit is due, if you're going to write the plugin script
and you intend to share it so that other GBM Pro users can benefit from it,
you'll probably want to be able to leave your mark, the <Author> tag,
enables you to provide your personal information for users of the plugin to
see..-->

<Name> Genie9 </Name>

<!-- Name of the author of the script. -->

<Company> Genie9 </Company>
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<!-- Company of the author of the script. -->

<Date> 26-2-2012 </Date>

<!-- Date of creation of the script. -->

<HomePage> http://www.genie9.com </HomePage>

<!-- Website containing information about the author of the script,
or belonging to the author. -->

<email> support@genie9.com </email>

<!-- Contact email address of the author. -->

</Author>

</Program>

</Backup>

How to: Create a Plugin using XML Tags
In order to simplify learning GenieScript we've written an example using all the tags needed to
write a full plugin script and added explanation after each tag or block of script using the script
comments convention. (Sentences enclosed in <!-- --> are comments that the compiler will
ignore and are only there for the benefit of whoever reviews the script).
Notes:
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Click the plus sign to view sub-tags and explanation.
Tags are case sensitive.
The script must be written using the same tag order as listed above.
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<Backup> <!-- Starts the script file, a necessary tag that tells the compiler that the plugin script
has begun. -->
<!-- Using GenieScript, you can create a plugin that backups up multiple items or programs.
Each individual application or group of settings you wish to backup should be enclosed
within the <Program> </Program> tags. -->

<Program> <!-- Begins the Program tag to indicate the start of a program's backup. -->
<!-- This is the section where you specify basic information about the group of
items you are backing up; if it's a whole application you should write its given name
and assign a category to it, otherwise you can choose any name you wish. -->

<Main> <!-- List basic information about the plugin and the data it backs up. -->
<Name> Winamp </Name>
<!-- Assigns a to the plugin, If you are backing up a program or an
application's settings, you should use the name of the program, for
example: Winamp, WinZip etc... If the script is intended to backup
a group of personal data items not related to an application, you
can choose any name you like. -->

<Category> Media </Category>
<!-- Assigns a category to the group of backed up data items, we
use CNET download.com programs categorizing scheme, for
example, Winamp goes under Media. If you're not backing up a full
application you can use either "Settings" or "Folders" to describe
the plugin. -->

<SubCategory> Player </SubCategory>
<!-- Optional. Assigns a subcategory to the plugin, we use CNET
download.com subcategories assigning convention, for example
the subcategory for Winamp would be Players. -->
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<HomePageURL> http://www.winamp.com </HomePageURL>
<!-- Optional. Specifies a URL containing more information about
the data that the plugin is intended to backup, if one exists, The
home page for the program backed up by the plugin is usually
used. -->

<HomePageText> Winamp Website </HomePageText>
<!-- Optional. Assigns a text description to link to the Homepage
URL, for example "Winamp Website", if non is given, the address
itself will be used as linking text. -->

<Note> Backup all winamp skins and plugins </Note>
<!-- This tag is used to write a small description for the benefit of
the user using the plugin, about what the script does, what items it
backs up, and any other relevant information. -->

</Main>

<Version> <!-- Declare the version(s) of an application that this plugin will be able
to backup. -->
<!-- Declares the start of the version script block. Which denotes the
versions of the application which the plugin is tested and will backup
successfully. -->
<Min> 2.0.0 </Min>
<!-- Specifies the earliest version of the application that is
supported by this plugin. To find out the version of the application
you're trying to backup:
1. Open Windows Explorer and browse to the location of the
main executable (.exe) file for the application in question.
2. Right click on the file and select Properties from the menu.
3. Click the Versions tab. -->
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<Max> 2.9.9 </Max>
<!-- Specifies the latest version of the application that this script
can backup properly. -->

</Version>

<Path> <!-- Retrieve the path of an application's program folder. -->
<!-- This section will tell Genie Backup Manager from where to get the path
to the program's main folder.
Every program stores its main program folder's path somewhere in the
registry.
Note that this path indicates the location of the program's main folder which
Genie Backup Manager will by default include in the backup, but in some
cases the program might store files and folders in other locations, these
can be backed up using the Folders and Files tags and with the help of
Variables.
To get the path for your script, you need to locate a registry key that points
to the main program executable file. For instance in Genie Backup
Manager that path is typically: C:\Program
Files\Genie9\GBM9Server\GBM9.exe. Once that registry key is provided in
the script, the plugin will use it to determine the main program folder for the
application during backup and restore, this ensures that the plugin will work
whether the user decides to install the program to its default location or to
an alternative folder. There are 4 scenarios that the user can choose from
while writing the path retrieval block in the script.
1st Scenario (Backing Up Personal Data and Program-Independent
Files and Folders).
If the user intends to backup program-independent data, such as
a personal work folder, or a folder containing MP3s etc... The
<Type> tag must be set to -1
Example:
<Path>
<FileName/>
<Type> -1 </Type>
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<KeyName/>
<Value/>
<IncludeSub> FALSE </IncludeSub>
<Enable> FALSE </Enable>
</Path>

2nd Scenario.
The default location that most programs use for storing the path
to its main executable file is the App Paths subkey in the
HKEY_LOCAL_MACHINE registry tree.
To find out whether the path to the application you intend to
create a plugin for is stored in this key browse to the key
"HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\Current
Version\App Paths\" and look for a subkey carrying the name of
the program's main executable file. If you find it, set the <Type>
tag to 1. and set the <KeyName> tag to the executable file
name.
Genie Backup Manager stores its path in:
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentV
ersion\App Paths\GBMServer7.exe
So the path tag would look like...
<Path>
<FileName> gbm7.exe </FileName>
<Type> 1 </Type>
<KeyName>GBMserver7.exe</KeyName>
<Value> Default </Value>
<IncludeSub> TRUE </IncludeSub>
<Enable> TRUE </Enable>
</Path>

3rd Scenario.
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If you couldn't find the required registry key using the previous
method, you might be able to use type 2, which retrieves the
path using a file extension that is associated with the program.
For instance (.gbm) is a file extension usually associated with
Genie Backup Manager, (psd) is a file extension typically
associated with Adobe Photoshop. These files are usually
assigned an icon that is stored in the application's main
executable file.
To use this path retrieval type:
1. Right click on the HKEY_CLASSES_ROOT tree and click
Find.
2. Type the main executable filename preceded by a
backslash (\) , for instance <\gbm7.exe>.
3. Make sure that only the Data checkbox is ticked.
4. Click Find Next.
If you find a DefaultIcon subkey with a value that points to the
path, then type 2 is the way to go.
Example:
Genie Backup Manager has the extension (.gbm) associated with
it, so in the, HKEY_CLASSES_ROOT tree we find the subkey
\GBMFile\DefaultIcon , with the default value pointing to the
path. With that in mind the path block would look like...
<Path>
<FileName> gbm7.exe </FileName>
<Type> 2</Type>
<KeyName>GBMFile\DefaultIcon</KeyName>
<Value>Default</Value>
<IncludeSub> TRUE </IncludeSub>
<Enable> TRUE </Enable>
</Path>

4th Scenario (When All Else Fails).
When all else fails, the user can get the program path from
anywhere inside the registry, you can do that by searching
through the registry for the name of the main executable file of
the application, if a registry key turns up with a value that points
to the path of that file, it can be used for path retrieval.
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To perform a search using the registry editor, do the following:
1. From the toolbar click Edit then select Find.
2. Type the main executable filename preceded by a
backslash \ , for instance <\gbm7.exe>.
3. In the Look at group, make sure only Data is ticked.
4. Click Find Next.
Performing a search for Quicken's main executable (qw.exe),
returns the key:
HKEY_CURRENT_USER\Software\Netscape\Netscape
Navigator\Viewers
With the value: application/x-qfx
So the Path tag would look like...
<Path>
<FileName> qw.exe</FileName>
<Type> 3 </Type>
<KeyName>
HKEY_CURRENT_USER\Software\Netscape\Netscape
Navigator\Viewers </KeyName>
<Value>application/x-qfx </Value>
<IncludeSub> TRUE </IncludeSub>
<Enable> TRUE </Enable>
</Path>

To know which type (scenario) to use, you need to open the Registry
Editor:
1. Click Start, then select Run.
2. Type regedit, then click OK. The Registry Editor will open. -->

<FileName> winamp.exe </FileName>
<!-- The name of the program's main executable (.exe) file, GBM
will refer to this file to retrieve the version of the program installed
on the machine during backup and restore. For instance Genie
Backup Manager's main executable file is named gbm7.exe -->
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<Type> 1 </Type>
<!-- Denotes one of 4 methods for retrieving the main program
folder's path. Click here for explanation. -->

<KeyName> Winamp.File\DefaultIcon </KeyName>
<!-- Indicates the registry key which contains the value that points
to the main program executable path. -->

<Value>Default</Value>
<!-- Default value= Default. Selects the value under the key
specified in the <KeyName> tag where the path is stored. This tag
is only applicable Type 2 and 3 only. -->

<IncludeSub>TRUE </IncludeSub>
<!-- Optional tag. Values TRUE or FALSE, Default = TRUE. Tells
GBM Server whether to include the subfolders when backing up
the main program folder or not, in most cases the user would want
this to be set to TRUE. -->

<Enable>TRUE</Enable>
<!-- Optional tag. Values TRUE or FALSE, Default = TRUE. Tells
Genie Backup Manager whether to backup the main program
folder, the user might want to set this to False for instance if he is
trying to backup specific settings or saved games, and not the
whole application, in which case Genie Backup Manager won't
backup the program folder but will check whether the program
exists or not when its time to restore those settings. -->

</Path>
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<Variables> <-- Declare variables that will be used around the script. -->
<!-- The path tag allows the user to get the main program folder's path from
the registry because that path can vary from one computer to another, or
from one platform to another. What if there are more than one folder
associated with the program you intend to backup? Also, What if you
encountered a file or a folder whose name or path is repeated several
times within the plugin script? Do you need to write the complete path over
and over, everywhere it appears in the script?
The Variables tag is provided to tackle such scenarios.
When a variable is assigned a string value (i.e. a file, folder or registry key
path or name), then every time that variable is used within the script (using
$$<Variable Name>$$), it will be replaced with its corresponding value at
runtime.

The <Var> tag is used to declare a variable. This tag takes two parameters
name, type and value. -->
<Varname="x1"type="Direct"> I:\NapsterSetup.exe </Var>

<Varname="x2"> HKEY_CLASSES_ROOT\.ZIP </Var>

<Varname="x3"type= "Reg"value="Test1">

HKEY_CURRENT_USER\Software\Genie-soft\GBMPro9\Main </Var>

<!-- name: assigns a name to the declared variable, the assigned name
should be enclosed within quotation marks, for instance name = "X1". This
name is used to represent the variable throughout the script in the format
$$<Variable Name>$$.
type: takes one of two values: Direct, or Reg, the value needs to be
enclosed within quotation marks. Direct means that the string value
assigned to the declared variable will be taken as is, whereas Reg means
that the string assigned to the variable is a registry key path which points to
to a value that contains the string that will be assigned to the variable.
value: when the type parameter is set to Reg, value should contain the
name of the value in the specified registry key, containing the desired
string. -->
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</Variables>

<RegistryKeys> <!-- Backup Windows Registry keys, subkeys and values. -->
<!-- Most programs will depend on the registry for storing their preferences
and settings. So to be able to backup any application successfully you
need to backup all the changes it makes to the Windows registry.
You can instruct Genie Backup Manager to backup keys with or without
including their sub keys or you can specify certain key values to be
modified when restoring the data. -->

<KeyIncludeSub="TRUE"> HKEY_LOCAL_MACHINE\
<!-- <Key>: Starts the backup of a registry key, it takes takes one
parameter IncludeSub.
IncludeSub: Optional. Values TRUE or FALSE, Default = TRUE.
When set to TRUE, the specified registry key will be backed up
with all its subkeys, this parameter is optional, and is by default set
to TRUE.
The <Key> </Key> tags enclose the complete path for the registry
key that needs to be backed up. -->
SOFTWARE\Classes\Directory\ shell\Winamp.Bookmark </Key>

<!-- If you want to specify only some of the registry values contained in that
registry key, you need to do the following:-->
<KeyIncludeSub="TRUE">
<Key> HKEY_CURRENT_USER\Software\ Geniesoft\GBMServer9\Main </Key>
<Value> BComplete </Value>
<Value> BOEWithoutClose </Value>
<Value> BOLWithoutClose </Value>
<Value> CDWXP_CacheImage </Value>
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<!-- <Value> </Value> enclose the name of the registry value that
you want to be backed up. -->
</Key>

</RegistryKeys>

<Files> <!-- Backup files. Path strings can be used. -->
<File> <!-- Declares backup of a single file. -->
<From> $$P_WIN$$\uninstbb.exe </From>
<!-- Specifies the full path including the name of the
desired file. -->

<To> $$P_WIN$$ </To>
<!-- Tells Genie Backup Manager where to copy the
backed up file during restore. It need not be the same path
as the <From> backup path. -->

<Filter> FALSE </Filter>
<!-- Optional tag. Values TRUE or FALSE, Default =
FALSE. Some files, whether binary or text, sometimes
contain paths that point to files or folder that get changed
when the backed up program or item is restored to a
different folder, machine or Windows platform. To ensure
that the paths will still point to the correct locations, Genie
Backup Manager can parse the file and substitute such
paths with environmental variables. That get restored to
their correct values at restore time. -->

<NeverUninstall> TRUE </NeverUninstall>
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<!-- Optional tag. Values TRUE or FALSE, Default =
FALSE. Set this to TRUE when backing up (dll) files and
system files that might be shared and should not be
deleted if the Plugin Uninstal Utilityl was used to uninstall
the program. -->

<CompareTimeStamp> TRUE </CompareTimeStamp>
<!-- Optional tag. Values TRUE or FALSE, Default =
TRUE. Set this to TRUE if you wish to avoid replacing
newer files with older versions when you restore data
backed up using this plugin. -->

<RegServer> TRUE </RegServer>
Optional tag. Values TRUE or FALSE , Default = FALSE .
When set to TRUE this will register a dll or Active-X file
using regsvr32 (for advanced users). -->

</File>
</Files>

<Folders> <!-- Backup folders. Path strings can be used. -->
<!-- Specify complete folders to be backed up.


You don't need to backup the main program folder here, if you've
already specified its path in the path extraction block and set the
<Enabled> tag to TRUE. -->

<FolderIncludeSub="TRUE"Extension="*.h;*.cpp">
<!--This tag starts the backup of a single folder (with or without its
subfolders). More than one <Folder> tag can be used within the
<Folders> </Folders> block to back up more than one folder. This
tag takes two parameters IncludeSub and Extension.
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IncludeSub: Optional. Values TRUE or FALSE, Default = TRUE.
When set to TRUE, tells Genie Backup Manager to backup all the
subfolders within the specified folder.
Extension: Optional. Values: file extensions. This parameter
enables you to filter backed up files within the selected folder
according to file types (extensions). The selected file types will be
included in backup, other files will be ignored. The value of the
parameter needs to be in the format *.doc *.exe *.txt etc ... To
include more than one files extension, use the semicolon as a
separator. Example: Extension ="*.h;*.cpp;*.exe". -->

<From> $$P_PERSONAL$$\my data </From>
<!-- This tag is used to specify the full path of a folder
intended for backup. -->

<To> $$P_PERSONAL$$\my data </To>
<!-- Tells Genie Backup Manager where to copy the
backed up folder during restore. It need not be the same
path as the <From> backup path. -->

</Folder>
</Folders>

<Ini> <!-- Moidfy ini file entries. -->
<!-- Many applications append to ini files when their installed, and in many
cases write their own ini files to hold their settings and preferences, which
the user might modify while using the program. The <Ini> tag allows you to
backup certain portions of ini files instead of backing up and restoring the
entire file, which in some cases might lead to errors.
The following is a portion taken from the Windows system.ini file:
...
[drivers]
wave=mmdrv.dll
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timer=timer.drv
[mci]
[driver32]
[386enh]
woafont=dosapp.FON
EGA80WOA.FON=EGA80WOA.FON
EGA40WOA.FON=EGA40WOA.FON
CGA80WOA.FON=CGA80WOA.FON
CGA40WOA.FON=CGA40WOA.FON
...
In the explanation below [drivers] is a key. wave is a value while
mmdrv.dll is that value's data. -->

<IniFile> <!-- Modify a single ini file. Use as many of these blocks to
modify as many ini files as needed. -->
<File> $$P_WIN$$\win.ini </File>
<!--Specifies an ini file to open for modification. More than
one file can be modified in a single script. >

<Key> drivers </Key>
<!--Contains the name of the key in the ini file that the user
wishes to append new values to, or modify existing values
under. >

<ValueName> wave </ValueName>
<!--Specifies the name of the value to be appended or
modified within the ini file and under the Key specified in
the previous tag, <Key>. -->

<Value> mmdrv.dll </Value>
<!--Assigns data to the value selected in the previous tag,
<ValueName>. -->
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<!-- Note:


You can use as many of these last 3 tags as you need to
convey all the changes in an ini file. -->

</IniFile >
</Ini>

<Links> <!-- Backup shortcuts. -->
<!-- Most programs create shortcuts on the desktop among other locations
that serve as a link to the main executable file(s) for faster access.
GenieScript enables you to backup these shortcuts along with their
attributes.
Right-click on the desired link and choose properties, then use the data
inside the properties window in the following block of script. -->
<Link> <!-- Starts backup of an individual shortcut. -->
<URL>TRUE</URL>
<!- Optional tag. Values TRUE or FALSE, Default =
FALSE. This will create a URL link instead of normal
shortcut - a URL link is a link that points to an address on
the World Wide Web. -->

<SavePath> $$P_DESKTOP$$\Babylon.lnk </SavePath>
<!-- Contains the full path to the location of the shortcut file
to be backed up. -->

<Target> $$P_APPPATH$$\Babylon.exe </Target>
<!-- Specifies the full path of the target executable to which
the link refers, this path can be found in the target field in
the shortcut's properties window. If you are creating a URL
link, this should be an internet address path. -->
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<IconIndex> 0 </IconIndex>
<!-- Optional. Values: integers equal or larger than zero,
Default = 0. If you specify a file as the holder of the
shortcut's icon, in the <IconLocation> tag, the <IconIndex>
tag will indicate which of the embedded icons should be
used, by default the first icon with index 0 will be used.


To know which index number to use, click the
"change icon" button inside the shortcut properties
window, choose the desired file containing the
icons, you should then see all the available icons,
the index number is calculated starting from 0 at
the top left corner icon and increasing by one as
you go from left to right and then downwards.

If the shortcut has a default icon set by Windows, such as
text files (.txt), then write the following
<IconIndex/>
<IconLocation/>
-->

<IconLocation> $$P_APPPATH$$\ Babylon.exe </IconLocation>
<!-- This tag carries the full path of the file containing the
icon that will be assigned to the shortcut file. Note that this
file must either already exist on the destination machine (to
which the backed up data will be restored) or be included
with the backup, to insure that this tag does not point to a
non-existent file. -->

</Link>

</Links>

<Restore> <!-- Plugin restore settings. -->
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<!-- After Backing up an application, you need to tell GBM Server where to
restore it to on the target machine, notice that here too you will be using
environmental variables in order to insure portability when needed. -->

<RestorePath> $$P_PROGRAM_FILES$$\Babylon </RestorePath>

<!-- Contains the full path to which Genie Backup Manager should
restore your backed up application or item, if this tag is missing,
Genie Backup Manager will restore the program to the original path
location retrieved using the Path tag. -->

<RestoreNote> Comments </RestoreNote>

<!-- If you have any comments or notes about the restore
procedure, here is where it goes.-->

<PathMustExist> TRUE </PathMustExist>
<!-- Optional tag. Values TRUE or FALSE, Default = TRUE. When
set to TRUE, Genie Backup Manager will not restore the data
backed up using the plugin, unless the related application program
is installed on the target machine. -->

</Restore>

<Author> <!--Script author information. -->
<!-- Give credit where credit is due, if you're going to write the plugin script
and you intend to share it so that other GBM Pro users can benefit from it,
you'll probably want to be able to leave your mark, the <Author> tag,
enables you to provide your personal information for users of the plugin to
see..-->

<Name> Genie9 </Name>

<!-- Name of the author of the script. -->
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<Company> Genie9 </Company>

<!-- Company of the author of the script. -->

<Date> 26-2-2012 </Date>

<!-- Date of creation of the script. -->

<HomePage> http://www.genie9.com </HomePage>

<!-- Website containing information about the author of the script,
or belonging to the author. -->

<email> support@genie9.com </email>

<!-- Contact email address of the author. -->

</Author>

</Program>

</Backup>

How to: Create a Plugin using Plugin Creator
Most users prefer dealing with GUIs to perform tasks. The Plugin creator generates the XML file
automatically without the need to write the XML tags. This can be done in 11 simple steps:
Step 1: Information
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This is the section where you specify basic information about the group of items you are
backing up; if it's a whole application you should write its given name and assign a
category to it, otherwise you can choose any name you wish.
Name: Assigns a name to the plugin, If you are backing up a program or an
application's settings, you should use the name of the program, for example: Winamp,
WinZip etc... If the script is intended to backup a group of personal data items not
related to an application, you can choose any name you like.
Category: Assigns a category to the group of backed up data items, we use CNET
download.com programs categorizing scheme, for example, Winamp goes under Media.
If you're not backing up a full application you can use either "Settings" or "Folders" to
describe the plugin.
Subcategory: Optional. Assigns a subcategory to the plugin, we use CNET
download.com subcategories assigning convention, for example the subcategory for
Winamp would be Players.
Home Page URL: Optional. Specifies a URL containing more information about the data
that the plugin is intended to backup, if one exists, The home page for the program
backed up by the plugin is usually used.
Home Page Text: Optional. Assigns a text description to link to the Homepage URL, for
example "Winamp Website", if non is given, the address itself will be used as linking
text.
Note: This tag is used to write a small description for the benefit of the user using the
plugin, about what the script does, what items it backs up, and any other relevant
information.

Step 2: Supported Version
A script written to backup an application or a programs' settings might not work for all
the versions and builds of the program in question. It's vital when writing a script that
backs up program-related data to specify which version(s) of the application the script
will backup properly. In most cases, unless the leftmost number in the version number is
different from the one you worked on, the script should work.
ALL: If the script is intended to backup non-program-related items, such as an MP3s
folder, or if you know the plugin will work for all versions of an application, then select
All.
Support these
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Earliest Version:Specifies the earliest version of the application that is
supported by this plugin.
Latest Version: Specifies the latest version of the application that this script
can backup properly.
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To find out the version of the application you're trying to backup click Browse... to the
location of the main executable (.exe) file for the application in question.
Step 3: Main Program Path
This section will tell the backup application where to get the path to the program's main
folder. Every program stores its main program folder's path somewhere in the registry.
Main executable filename: The name of the program's main executable (.exe) file,
GBM will refer to this file to retrieve the version of the program installed on the machine
during backup and restore. For instance Genie Backup Manager's main executable file is
named GBM8.exe, if in the Step2: Supported Versions step, you have found the
versions number via browsing for the exe file, this field will be filled automatically.
The four types for retrieving the main program folder's path:







Type -1: Non-program related data: If the user intends to backup programindependent data, such as a personal work folder, or a folder containing MP3s
etc
Type 0: Application File name: This will take the Main executable filename as
it is, it also can be a variable
Type1: HKEY LOCAL
MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\App
Paths\:The default location that most programs use for storing the path to its
main executable file is the App Paths subkey in the HKEY_LOCAL_MACHINE
registry tree. To find out whether the path to the application you intend to create
a plugin for is stored in this key click Browse and search for
"HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\App
Paths\" and look for a subkey carrying the name of the program's main
executable file and select it to be placed in Registry key. If you find it, then
select this type.
Type 2: File extension that is associated with the program: If you couldn't
find the required registry key using the previous type, you might be able to use
type 2, which retrieves the path using a file extension that is associated with the
program. For instance (.gbm) is a file extension usually associated with Genie
Backup Manager, (.psd) is a file extension typically associated with Adobe
Photoshop. These files are usually assigned an icon that is stored in the
application's main executable file.

To use this path retrieval type click Browse :
Right click on the HKEY_CLASSES_ROOT tree and click Find
Type the main executable filename preceded by a backslash (\) , for instance
<\GBM8.exe>
Make sure that only the Data checkbox is ticked
Click Find Next
If you find a DefaultIcon subkey with a value that points to the path select it to be
placed in Registry key. And go with type 2.
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Type 3: Random registry key :When all else fails, the user can get the
program path from anywhere inside the registry, you can do that by searching
through the registry for the name of the main executable file of the application,
if a registry key turns up with a value that points to the path of that file, it can
be used for path retrieval.

To perform a search using the registry editor, do the following:
From the toolbar click Edit then select Find
Type the main executable filename preceded by a backslash \ , for instance
<\GBM8.exe>
In the Look at group, make sure only Data is ticked
Click Find Next
Key Value : Default value= Default . Selects the value under the key specified in the
Registry key field where the path is stored. This tag is only applicable to Type 2 and 3
only
Backup main program folder: Tells whether to backup the main program folder, the
user might not want to select this, for instance if he is trying to backup specific settings
or saved games, and not the whole application, in which case Genie Backup Manager
won't backup the program folder but will check whether the program exists or not when
its time to restore those settings.
Include subfolders: Tells GBM whether to include the subfolders when backing up the
main program folder or not, in most cases the user would want this to select this.
Step 4: Variables
The path tag allows the user to get the main program folder's path from the registry
because that path can vary from one computer to another, or from one platform to
another. What if there are more than one folder associated with the program you intend
to backup? Also, What if you encountered a file or a folder whose name or path is
repeated several times within the plugin script? Do you need to write the complete path
over and over, everywhere it appears in the script?
The Variables tag is provided to tackle such scenarios.
Variable name: assigns a name to the declared variable.
Variable Type: takes one of two values either String or from registry
String: that the string value assigned to the declared variable will be taken as is
Value: enter the string value in this field
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From registry: that the string value assigned to the variable is a registry key
path which points to to a value that contains the string that will be assigned to the
variable.
Registry key: Search for the variable's registry key by clicking on ...
Registry value: value should contain the name of the value in the
specified registry key, containing the desired string.
Flags: The Following are the variable flags to modify
Remove arguments: This attribute allow you to backup the variable excluding the
arguments (options) attached
Remove quotation:This attribute allows you to backup the variable removing the
quotations if any.
Remove filename: This attribute allows you to backup the path of the variable
removing the variable's file name.

Remove: Removes the selected variable from the list.
Clear all: Deletes all what is in the fields in the Variable box
Add/Update: Adds the variable created with its type and value to the variables list
Step 5: Registry
Most programs will depend on the registry for storing their preferences and settings. So
to be able to backup any application successfully you need to backup all the changes it
makes to the Windows registry.
You can instruct Genie Backup Manager to backup keys with or without including their
sub keys or you can specify certain key values to be modified when restoring the data.
Registry Key: Starts the backup of a registry key, to browse for it click Add Key ...
There are three options for the functionality of the Registry key:





Do not include sub keys: the specified registry key will not back up with all its
subkeys
Include sub keys: the specified registry key will be backed up with all its
subkeys
Include only these values: backs up only some of the registry values
contained in that registry key
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Registry value: the chosen registry value contained in the selected registry key to be
included at backup; searching for by clicking Add Value... And to remove a registry
value from the list select the value and click Remove ...
Add/Update: To add the registry key and its information of the registry key to the
Registry key list.
Remove: Removes the selected registry key from the Registry key list.
Step 6: Files
This step will allow you to backup individual files.
File: Specifies the full path including the name of the desired file finding it is done by
clicking Browse... or inserting manually full path
Restore to: Tells Genie Backup Manager where to copy the backed up file during
restore. It need not be the same path as in File. It is found by clicking Browse... or
inserting manually full path.
Never Uninstall: Default unchecked. Check this if when backing up (dll) files and
system files that might be shared and should not be deleted
Filter Internal file data: Default unchecked. Some files, whether binary or text,
sometimes contain paths that point to files or folder that get changed when the backed
up program or item is restored to a different folder, machine or Windows platform.
Compare Time Stamp: Default unchecked. Check this if you wish to avoid replacing
newer files with older versions when you restore data backed up using this plugin.
Register server (Using regsvr32.exe): Default unchecked. If this is checked then this
will register a dll or Active-X file using regsvr32 (for advanced users).
Remove: Removes the selected filename from the list.
Clear all: Deletes all the fields in the Files box
Add/Update: Adds the File record created with its information to the Files list.
Step 7: Folders
In this step you can backup the most important part of any application, the actual files
and folders.
Folder: Specifies the full path including the name of the desired folder finding it is done
by clicking Browse... or inserting manually full path
Restore to: Tells Genie Backup Manager where to copy the backed up folder during
restore. It need not be the same path as in Folder. It is found by clicking Browse... or
inserting manually full path.
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Include Sub Folders: The default is unchecked. When checked, Genie Backup Manager
will backup all the subfolders within the specified folder.
Filter file types: Default unchecked. If checked it enables you to filter backed up files
within the selected folder according to file types (extensions) which is typed in Filer file
types . The selected file types will be included in backup, other files will be ignored. The
value of the parameter needs to be in the format *.doc *.exe *.txt etc ... To include
more than one files extension, use the semicolon as a separator.
Remove: Removes the selected folder from the list.
Clear all: Deletes all whats in the fields in the Folder box
Add/Update: Adds the Folder record created with its information to the Folder list.
Step 8: Ini Files
Many applications append to ini files when their installed, and in many cases write their
own ini files to hold their settings and preferences, which the user might modify while
using the program. This section allows you to backup certain portions of ini files instead
of backing up and restoring the entire file, which in some cases might lead to errors.
INI Files: Specifies an ini file to open for modification, finding it is done by clicking on
Browse...
Key: Contains the name of the key in the ini file that the user wishes to append new
values to, or modify existing values under.
Value name: Specifies the name of the value to be appended or modified within the ini
file and under the Key specified in the Key.
Value: Assigns data to the value selected in the Value name.
Remove: Removes the selected Ini file from the list.
Clear all: Deletes all whats in the fields in the Ini Files box
Add/Update: Adds the Ini file record created with its information to the Ini files list.
Step 9: Shortcuts
Most programs create shortcuts on the desktop among other locations that serve as a
link to the main executable file(s) for faster access. Genie Plugin Creator enables you to
backup these shortcuts along with their attributes.
Shortcut location: Contains the full path to the location of the shortcut file to be
backed up, finding it is done when clicking on Browse...
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Target: Specifies the full path of the target executable to which the link refers, this
path can be found in the target field in the shortcut's properties window. If you are
creating a URL link, this should be an internet address path or by clicking on Browse...
Icon location: This tag carries the full path of the file containing the icon that will be
assigned to the shortcut file, finding it is done when clicking on Browse...
Icon index: Values: integers equal or larger than zero, Default = 0 . If you specify a
file as the holder of the shortcut's icon, in the Icon Location, it will indicate which of the
embedded icons should be used, by default the first icon with index 0 will be used.
Create web URL: Default unchecked. This will create a URL link instead of normal
shortcut - a URL link is a link that points to an address on the World Wide Web.
Remove: Removes the selected shortcut from the list.
Clear all: Clear all fields in the Shortcut box
Add/Update: Adds the Shortcut record created with its information to the Shortcuts
list.
Step 10: Restore
After backing up an application, you need to tell GBM where to restore it to on the
target machine, you will be using environmental variables in order to insure portability
when needed.
Restore data to: Contains the full path to which Genie Backup Manager should restore
your backed up application or item, it can be selected by clicking Browse... or typing in
the path manually.
Note: Add additional comments or notes needed for the plugin.
Application must be installed: Default unchecked. When checked, Genie Backup
Manager will not restore the data backed up using the plugin, unless the related
application is installed on the target machine.

Step 11: Author
Give credit where credit is due, if you're going to create the plugin and you intend to
share it so that other GBM users can benefit from it, you'll probably want to be able to
leave your mark, this step, enables you to provide your personal information for users of
the plugin to see.
Name: Name of the author of the script.
Company: Company of the author of the script.
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Date: Date of creation of the script (Automated)
Home page: Website containing information about the author of the script , or
belonging to the author.
Email: Contact email address of the author.
Clear all: Empty all the fields.

GenieScript Examples
Win Zip
<Backup>
<Program>
<Main>
<Name>WinZip</Name>
<Category> Utilities</Category>
<SubCategory> File Compression</SubCategory>
<HomePageURL>http://www.winzip.com </HomePageURL>
<HomePageText>WinZip Web Site</HomePageText>
</Main>
<Version>
<Min>0</Min>
<Max>8.1</Max>
</Version>
<Path>
<FileName>winzip32.exe</FileName>
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<Type> 1</Type>
<KeyName> winzip32.exe</KeyName>
<IncludeSub> TRUE</IncludeSub>
</Path>
<RegistryKeys>
<Key> HKEY_CLASSES_ROOT\.ZIP </Key>
<Key> HKEY_CLASSES_ROOT\.ARC </Key>
<Key> HKEY_CLASSES_ROOT\.ARJ </Key>
<Key> HKEY_CLASSES_ROOT\WinZip </Key>
<Key> HKEY_CLASSES_ROOT\*\shellex\ContextMenuHandlers\WinZip </K
ey>
<Key> HKEY_CLASSES_ROOT\.cab </Key>
<Key> HKEY_CLASSES_ROOT\CLSID\{E0D79304-84BE-11CE-9641444553540000}</Key>
<Key> HKEY_CLASSES_ROOT\CLSID\{E0D79305-84BE-11CE-9641444553540000}</Key>
<Key> HKEY_CLASSES_ROOT\CLSID\{E0D79306-84BE-11CE-9641444553540000}</Key>
<Key> HKEY_CLASSES_ROOT\CLSID\{E0D79307-84BE-11CE-9641444553540000}</Key>
<Key> HKEY_CLASSES_ROOT\Directory\shellex\DragDropHandlers\WinZi
p</Key>
<Key> HKEY_CLASSES_ROOT\Directory\shellex\ContextMenuHandlers\Wi
nZip</Key>
<Key> HKEY_CLASSES_ROOT\Drive\shellex\DragDropHandlers\WinZip </K
ey>
<Key> HKEY_CLASSES_ROOT\Folder\shellex\DragDropHandlers\WinZip </
Key>
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<Key> HKEY_CLASSES_ROOT\Folder\shellex\ContextMenuHandlers\WinZi
p</Key>
<Key> HKEY_CURRENT_USER\Software\Nico Mak
Computing\WinZip</Key>
<Key> HKEY_LOCAL_MACHINE\SOFTWARE\Classes\WinZip </Key>
<Key> HKEY_LOCAL_MACHINE\SOFTWARE\Classes\*\shellex\ContextMen
uHandlers\WinZip</Key>
<Key> HKEY_LOCAL_MACHINE\SOFTWARE\Classes\CLSID\{E0D7930484BE-11CE-9641-444553540000}</Key>
<Key> HKEY_LOCAL_MACHINE\SOFTWARE\Classes\CLSID\{E0D7930584BE-11CE-9641-444553540000}</Key>
<Key> HKEY_LOCAL_MACHINE\SOFTWARE\Classes\CLSID\{E0D7930684BE-11CE-9641-444553540000}</Key>
<Key> HKEY_LOCAL_MACHINE\SOFTWARE\Classes\CLSID\{E0D7930784BE-11CE-9641-444553540000}</Key>
<Key> HKEY_LOCAL_MACHINE\SOFTWARE\Classes\Directory\shellex\Dra
gDropHandlers</Key>
<Key> HKEY_LOCAL_MACHINE\SOFTWARE\Classes\Directory\shellex\Dra
gDropHandlers\WinZip</Key>
<Key> HKEY_LOCAL_MACHINE\SOFTWARE\Classes\Directory\shellex\Con
textMenuHandlers\WinZip</Key>
<Key> HKEY_LOCAL_MACHINE\SOFTWARE\Classes\Drive\shellex\DragDr
opHandlers\WinZip</Key>
<Key> HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVe
rsion\App Paths\winzip.exe </Key>
<Key> HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVe
rsion\Uninstall\WinZip</Key>
</RegistryKeys>
<Files>
</Files>
<Folders>
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</Folders>
<Ini>
</Ini>
<Links>
<Link>
<SavePath> $$P_DESKTOP$$\winzip.lnk</SavePath>
<Target>$$P_APPPATH$$\winzip32.exe </Target>
<IconIndex>0</IconIndex>
<IconLocation> $$P_APPPATH$$\winzip32.exe </IconLocation>
<Comment/>
<Arguments/>
</Link>
<Link>
<SavePath> $$P_COMMON_PROGRAMS$$\WinZip\winzip.lnk </Sa
vePath>
<Target>$$P_APPPATH$$\winzip32.exe </Target>
<IconIndex>0</IconIndex>
<IconLocation> $$P_APPPATH$$\winzip32.exe </IconLocation>
</Link>
<Link>
<SavePath> $$P_COMMON_STARTMENU$$\winzip.lnk </SavePath
>
<Target>$$P_APPPATH$$\winzip32.exe </Target>
<IconIndex>0</IconIndex>
<IconLocation> $$P_APPPATH$$\winzip32.exe </IconLocation>
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</Link>
<Link>
<SavePath> $$P_COMMON_PROGRAMS$$\WinZip\Uninstall
WinZip.lnk</SavePath>
<Target>$$P_APPPATH$$\winzip32.exe </Target>
<IconIndex>0</IconIndex>
<IconLocation> $$P_APPPATH$$\winzip32.exe </IconLocation>
<Arguments>/uninstall</Arguments>
</Link>
<Link>
<SavePath> $$P_COMMON_PROGRAMS$$\WinZip\Help
Manual.lnk</SavePath>
<Target>$$P_APPPATH$$\WINZIP.HLP </Target>
<IconIndex>0</IconIndex>
<IconLocation/>
<Arguments/>
</Link>
<Link>
<SavePath> $$P_COMMON_PROGRAMS$$\WinZip\Whats
New.lnk</SavePath>
<Target>$$P_APPPATH$$\WHATSNEW.TXT </Target>
<IconIndex>0</IconIndex>
<IconLocation/>
<Arguments/>
<Comment>What's New</Comment>
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</Link>
<Link>
<SavePath> $$P_COMMON_PROGRAMS$$\WinZip\ReadMe.txt.lnk
</SavePath>
<Target>$$P_APPPATH$$\ReadMe.txt </Target>
<IconIndex>0</IconIndex>
<IconLocation/>
<Arguments/>
<Comment/>
</Link>
<Link>
<SavePath>$$P_COMMON_STARTUP$$\WinZip Quick
Pick.lnk</SavePath>
<Target>$$P_APPPATH$$\WZQKPICK.EXE </Target>
<IconIndex>0</IconIndex>
<IconLocation/>
<Arguments/>
<Comment>WinZip Quick Pick</Comment>
</Link>
</Links>
<Restore>
<RestorePath> $$P_PROGRAM_FILES$$\WinZip </RestorePath>
<RestoreNote/>
</Restore>
<Author>
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<Name>Genie9</Name>
<Company> Genie9</Company>
<Date>8-04-2012</Date>
<HomePage>http://www.genie9.com</HomePage>
<email>support@genie9.com</email>
</Author>
</Program>
</Backup>

How to: Compile a Plugin Script
After you've finished writing a backup script you need to convert it into a binary file that GBM
can understand, this is done using GenieScript Compiler which can be found in the "Genie
Backup Manager Tools" window under Genie9 in the Start Menu.
To compile a GS script:
1. From the toolbar in Genie Backup Manager, click Tools, then select GenieScript
Compiler.
2. Click Open and browse to the location where you've stored your script.
3. Click Compile.
4. If your script is error free the compiler will create a file with the extension (gpc) in the
same folder as the script.
5. Copy the output file to the folder GScript in your GBM main program folder. This is
typically: Drive:\Program Files\Genie9\GBMAPPLICATION\GScript

Script Compilation Errors
Error Message

Number Description

The operation was successful

0

Failed to create output file
name

1

File does not exist

2

Could not find "Backup"
main tag

3

Could not find "Program" tag

4

Could not find "Main" tag

5

Operation was successful
Failed to create output filename, make sure there is
enough space or that the folder is not locked
The script file does not exist or GScript can’t open the file,
make sure the file is not locked
Couldn’t find or open <Backup> tag, make sure the tag is
spelled correctly; tags are case sensitive
Couldn’t find or open <Program> tag, make sure the tag
is spelled correctly; tags are case sensitive
Couldn’t find or open <Main> tag, make sure the tag is
spelled correctly; tags are case sensitive
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Could not find "Main ->
Name" tag

6

Could not find "Version" tag

7

Could not find "Path" tag

8

Could not find "Path ->
Filename" tag
Could not find "Path ->
Type" tag

9
0

Could not find "Path ->
Keyname" tag

10

Could not find
"RegistryKeys" tag

11

Could not find "RegistryKeys
-> Key" tag

12

Error while Parsing
"IncludeSub" Attribute inside
"Key" tag
Error while Parsing "Files"
tag
To without From, Must write
from tag
Error while Parsing "Links"
tag

13
14
15
16

Icon index is invalid

17

Could not find "Restore" tag

18

Could not find "RestorePath"
tag

19

Could not parse "Path ->
IncludeSub" tag

20

Could not parse "File ->
Filter" tag
Could not parse "Folders"
tag
To without From, Must write
from tag
Could not parse "Folders ->
IncludeSub" tag
Could not parse "File ->
NeverUninstall" tag
Could not parse " File->
CompareTimeStamp" tag

244

21
22
23
24
26
27

Couldn’t find or open <Name> tag inside <Main>.This tag
is necessary, it contains name of the item that the script
backs up
Couldn’t find or open <Version> tag, you must specify
the version or you can type ”ALL” to make script
applicable to all versions
Couldn’t find or open <Path> tag, make sure the tag is
spelled correctly; tags are case sensitive
Couldn’t find or open <Filename> tag, make sure the tag
is spelled correctly; tags are case sensitive
Couldn’t find or open <Type> tag inside <Path>. Valid
Type values are: -1, 1, 2, 3
Couldn’t find or open <Keyname> tag inside <Path>,
make sure the tag is spelled correctly; tags are case
sensitive
Couldn’t find or open <RegistryKeys> tag, make sure the
tag is spelled correctly; tags are case sensitive
Couldn’t find or open <Key> tag inside <RegistryKeys>,
make sure the tag is spelled correctly; tags are case
sensitive
Could not parse attribute ”IncludeSub” within <Key> tag
inside <Registry>, valid values are TRUE or FALSE (case
sensitive)
Couldn’t find or open <Files> tag, make sure the tag is
spelled correctly; tags are case sensitive
<To> without <From>, you must enter a <From> tag
before you write <To> tag
Couldn’t find or open <Links> tag, , make sure the tag is
spelled correctly; tags are case sensitive
Links icon index is invalid, valid values are 0 and higher
Couldn’t find or open <Restore> tag, make sure the tag
is spelled correctly; tags are case sensitive
Couldn’t find or open <RestorePath> tag, make sure the
tag is spelled correctly; tags are case sensitive
Could not parse <IncludeSub> tag within <Path> tag,
valid values are TRUE or FALSE (case sensitive)
Could not parse <Filter> tag within <File> tag, valid
values are TRUE or FALSE (case sensitive)
Couldn’t find or open <Folders> tag, make sure the tag is
spelled correctly; tags are case sensitive
<To> without <From>, you must enter <From> tag
before you write <To> tag
Could not parse <IncludeSub> tag within <Folders> tag,
valid values are TRUE or FALSE (case sensitive)
Could not parse <NeverUninstall> tag within <File> tag,
valid values are TRUE or FALSE (case sensitive)
Could not parse <CompareTimeStamp> tag within <File>
tag, valid values are TRUE or FALSE (case sensitive)
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Could not parse "File ->
RegServer" tag
Could not find "Ini -> IniFile"
tag
Error while Parsing "Links ->
URL" tag
Error while Parsing "Path ->
Enable" tag
Error while Parsing "Restore
-> PathMustExist" tag
Error while Parsing "Restore
-> Uninstall" tag

28
29
30
31
32
33

Could not parse <RegServer> tag within <File> tag, valid
values are TRUE or FALSE (case sensitive)
Couldn’t find or open <IniFile> tag within <Ini>, make
sure the tag is spelled correctly; tags are case sensitive
Could not parse <URL> tag within <Links> tag, valid
values are TRUE or FALSE (case sensitive)
Could not parse <Enable> tag within <Path> tag, valid
values are TRUE or FALSE (case sensitive)
Could not parse <PathMustExist> tag within <Restore>
tag, valid values are TRUE or FALSE (case sensitive)
Could not parse <Uninstall> tag within <Restore> tag,
valid values are TRUE or FALSE (case sensitive)

Scripted Backup (GRunScript)
Scripted Backup (GRunScript)
Most backup software offer complex command line options to allow users to perform backups
without using the application's graphical user interface, a feature which is intended to provide
extended flexibility for advanced users who wish for instance to create batch files that can be
shared with other network users to perform standardized backup tasks. Genie Backup Manager
takes this a step further by allowing users to create complete backup jobs using XML based
scripting.
GRunScript is created by feeding the script all the settings and selections the user would specify
using the backup wizard, these include:
1.
2.
3.
4.

Backup Job information.
Backup storage device selection.
Data selection.
Settings.
 Backup Type.
 Security settings.
 Compression settings.
 Email notification settings.

How to: Create a Backup Job Script
In order to simplify learning GRunScript we've written an example script using all the tags
needed to write a full script file and added explanation after each tag or block of script using the
script comments convention. (Sentences enclosed in <!-- --> are comments that the compiler
will ignore and are only there for the benefit of whoever reviews the script).
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Notes




Click the plus sign next to each tag to expand it.
Tags are case sensitive.

<Backup> <!-- Starts the script file, a necessary tag that tells GBM to start interpreting -->

<!-- For the compiler to know where the script starts and where it ends it needs the <
Backup > </ Backup > tags, all other tags should be enclosed within these two, the compiler
will ignore anything not lying between them. -->

<Main> <!-- Basic backup job information. -->
<!-- Sets the basic backup job information, including:










Job name
Backup filename
job description
New job or an existing backup job
Backup Media selection
Backup monitor visibility
Count-down to backup
Time Stamping
Deployment settings

-->

<Jobname> Test1 </Jobname>
<!-- Assigns a name to the backup job. -->

<Type> 0 </Type>
<!--Optional. Values 0 or 1, Default = 0. Indicates whether this is a new
backup job or is meant to load an existing backup job. 0 = New backup
job, 1= Loading an existing backup job. Loading an existing backup job
would use the backup job name to load the settings and selections of the
specified backup job and ignore the rest of the script. -->
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<MediaType> 4 </MediaType>
<!-- Values 0,1,2,3. Indicates the storage media that will be used for
backup. The user selects a number denoting the desired media, then
GBM looks for its settings in the Media tag.
Media Types:






0=Local/Lan
1=Removable
2=FTP
3=CD,DVD

<HideMonitor> FALSE </HideMonitor>
<!--Optional tag. Values TRUE or FALSE, Default = FALSE. Instructs GBM
Server whether to display the backup monitor while running the script.
When set to TRUE, the backup monitor will minimized when the backup
start. -->

<TimeToBackup> 0 </TimeToBackup>
<!-- Optional. Values: integer value higher than -1, Default = 10. Sets the
number of seconds for thea count-down before starting backup (Window
for user to cancel backup)



-1= Default value.
0= Disable countdown.

-->

<Description> Just a simple test </Description>

<DriveNumber> 0 </DriveNumber>
<!-- Number corresponding to the recorder's drive letter as listed
inside GBM Server. I.e. 0 for the 1st drive, 1 for the 2nd drive ->
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<SpaceType> 0 </SpaceType>

<!-- Whether to allow GBM Server to utilize all available space on
each inserted disc or to use a fixed amount of space
Values:



0 = Utilize maximum available space (Default)
1 = Use fixed size

-->

<SplitSize> 600 mb </SplitSize>

<!-- When SpaceType (1) is selected, user must enter a fixed split
size
Default is 600 MB -->

<UsePacketWriting>FALSE</UsePacketWriting>

<!-- Writing to CD/DVD media using third party packet writing
software, default value is False -->

<Erase>FALSE</Erase>

<!-- Delete contents of inserted CD/DVD media before backup,
default value is False -->

<TimeStamp> FALSE </TimeStamp>
<!-- Optional tag. Values TRUE or FALSE, Default = FALSE. Used to
attach a timestamp to the backup filename, timestamps indicate when a
backup run was carried out. Use <TimStampType> tag to choose
timestamp format. -->
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<TimeStampType> 0 </TimeStampType>

<!-- Values: 1,2,3,4,5,6,7 . C hoose a format for the attached timestamp
Values:









0= Month dd, yyyy@hh:mm:ss AM/PM
1= Day of the week, Month dd, yyyy
2= Month dd, yyyy
3= yyyy-mm,dd
4= Month dd
5= mm-dd-yyyy@hh-mm AM/PM
6= mm-dd-yyyy@hh-mm-ss AM/PM
7= hh.mm.dd AM/PM

-->

<Filename> My Backup </Filename>
<!--Name assigned to the output file/folder produced by backup, if not
specified, job name will be used. -->
<Deployment> 0 </Deployment>
<!--Specify whether you wish to run, deploy, or deploy and run this job.
Where 0 = run, 1= Deploy and run, and 2= Deploy. -->

</Main>

<Media> <!-- Where to store the backup. -->
<!-- GBM Server will look in this section for the tag corresponding to the media type
selected in <Type> tag under <Main> to retrieve the settings associated with the
selected media type. -->

<LocalLan> <!-- Backup to a storage location readily accessible from Windows
Explorer (Internal/External hard disks, NAS, SAN, LAN locations etc ...) -->
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<OutputPath> I:\ </OutputPath>
<!-- Output folder, if not specified, default backup location will be
chosen \My Documents\My Backups -->

<SplitSize/>
<!-- Split size, default value 2 GB. -->

</LocalLan>

<Removable> <!--Backup to multiple disks ( JAZ disks, ZIP disks etc...) -->

<Drive> H:\ </Drive>
<!-- Drive letter for the selected removable media drive,
selecting a non-removable media device will cause backup to fail
-->

<Erase>FALSE</Erase>
<!-- Causes GBM Server to erase each inserted disk before
backup without prompting the user. WARNING: Selecting this
option will erase ALL data on the inserted disks -->

</Removable>

>

<FTP> <!-- Backup to an FTP server or a remote location using FTP service --

<Host> ftp.server.com </Host>
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<!-- Hostname or IP address or remote location -->

<Port> 21 </Port>

<!-- Port number for establishing connection, default value is 21. ->

<Username> myusername </Username>

<!-- Username for FTP account. -->

<Password> 123456 </Password>
<!--Password for FTP account, WARNING: Password will not be
secure if saved inside the script -->

<Folder> backup_test1 </Folder>
<!-- Folder on the FTP location to backup data to -->

<PassiveMode>TRUE</PassiveMode>
<!-- Connecting in Passive or active mode, Default value is False
-->

<UsePreConfig>TRUE </UsePreConfig>
<!-- Use pre-configured settings (Get settings from the machine,
for example: "proxy settings" from the control panel). Default is
TRUE. -->

<KeepLocally>TRUE</KeepLocally>
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<!-- Causes GBM Server to keep the temporary backup files
stored locally on the machine before being uploaded, default
value is False -->

<StorePath> </StorePath>
<!-- Specify local temporary folder used for storing backup files
created before being uploaded to the FTP location, if left empty
the default backup location will be used -->

<UseFTPProxy>FALSE</UseFTPProxy>

<!-- Enable connecting through an FTP proxy, default value is
False -->

<FTPProxy></FTPProxy>

<!-- FTP Proxy address -->

<FTPProxyPort> 21 </FTPProxyPort>

<!-- FTP Proxy port, default value (21) -->

<FTPProxyUsername></FTPProxyUsername>

<!-- FTP Proxy access Username -->

<FTPProxyPass></FTPProxyPass>

<!-- FTP Proxy access Password -->

</FTP>
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<DVD_CD> <!-- Backup to CD/DVD media -->
<!--Optional description for the created backup job, if left empty it will
be set to default (Time and date of job creation). -->

</DVD_CD>

</Media>

<Data> <!-- Select files/folders and items to be backed up. -->

<MyProfile> <!-- Select items from the My Profile tab in GBM Server. -->

<OutlookExpress> <!-- Backup Outlook Express emails and settings -->

<Identity>

<!-- Select Outlook Express identities to be backed up,
backing up multiple identities is supported, identities can
be selected by either specifying the identity name or its
corresponding GUID-->
<IdentityName> Main identity </IdentityName>
<!-- Select an identity by specifying its name as
displayed in Outlook Express Identity Manager or
GBM Server, or enter $$ALL$$ to backup all
identities -->

<IdentityGUID/>
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<!-- Select an identity by supplying its GUID. To
find an identity's GUID refer to Windows Registry
key
HKEY_CURRENT_USER\Identities -->

</Identity>

</OutlookExpress>

<Outlook> <!-- Backup Outlook emails, PST files, settings etc ... -->

<ProfileName> </ProfileName>
<!-- Select a profile by supplying its name, You can see a
list of all available Outlook profiles by going to Control
Panel -> Mail -> Show Profiles. Enter $$ALL$$ to backup
all profiles -->

</Outlook>

<Registry> <!-- Backup Windows Registry. -->

<Key>ALL</Key>
<!-- Backup entire registry database -->

<Key> HKEY_LOCAL_MACHINE\SOFTWARE </Key>
<!-- Backup a specific key with all its sub-keys. -->
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</Registry>

<WinSettings>FALSE</WinSettings> <!-- Backup Windows settings, True
to backup all supported Windows settings, and False to skip them -->

<IESettings>FALSE</IESettings> <!-- Backup Internet Explorer settings,
values are True or False -->

<Favorites>FALSE</Favorites> <!-- Backup Favorites, values are True or
False -->

<Wab>FALSE</Wab> <!-- Backup Windows Address Book, values are
True or False -->

<Desktop>FALSE</Desktop> <!-- Backup the Desktop area, values are
True or False -->

<Fonts>FALSE</Fonts> <!-- Backup Windows fonts, values are True or
False -->

<MyDocuments>True</MyDocuments> <!-- Backup My documents folder,
values are True or False -->

<MediaPlaylist> <!-- Parse media playlists and backup media files they
point to>

<File> I:\playlist\1.m3u </File> <!-- Full path and file name of the
media playlist -->

255

GBM User Manual

</MediaPlaylist>
<WindowsMail>True<\WindowsMail><!-- Backup Windows Mail, values
are True or False -->

<WindowsContacts>True<\WindowsContacts><!-- Backup Windows Mail,
values are True or False -->

</MyProfile>

<MyFolders> <!-- Backup files and folders. -->

<FolderIncludeSub="FALSE"> I:\CD1 </Folder>
<!-- Path for folder selected for backup, use of Path Strings is
supported.
IncludeSub: instructs GBM Server whether to include all subfolders
of the selected folder, Default is True. -->

<FolderIncludeSub="TRUE"> $$P_DESKTOP$$ </Folder>
<!-- Path for folder selected for backup, use of Path Strings is
supported.
IncludeSub: instructs GBM Server whether to include all subfolders
of the selected folder, Default is True. -->

<File> I:\CD2\layout_start_V3.psd </File>
<!-- Full path and filename of file to be backed up, use of
wildcards is supported -->

<Filters> <!--Add filters -->
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<Rule IncludeSub="FALSE"> I:\CD1 </Rule>
<!-- Path for folder selected to create filter rules, use of
Path Strings is supported.
IncludeSub: instructs GBM Server whether to include all
subfolders of the selected folder, Default is True. -->

<FilterType>0</FilterType>
<!-- Specify whether to include or exclude the
following filters 0= include 1=exclude-->

<Filters>"*.doc;*.txt"</Filters>
<!-- filter the following types; wildcards are
supported -->

</Filters>
</MyFolders>

<MyPrograms> <!-- Backup items listed in MY Plugins tab. -->

<Program> Winzip </Program> <!-- Name of item as listed in My Plugins. ->

</MyPrograms>

</Data>

<Settings>

<!-- Configures backup job settings, including:
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Backup Type
Compression Type
Security Type
Power options
Pre & Post job commands

-->

<BackupType> 0 </BackupType>
<!-- Values 0, 1, 2, 3. Set the backup type for this backup job. See backup
types.
Backup Types:





0=Full
1=Incremental
2=Mirror
3=Differential

-->

<CompressionType> 1 </CompressionType>
<!-- Optional tag. Values 0 or 1, Default = 1. Compression Type, 0= Without
compression (Preserves file/folder structure), 1= use zip format
compression. See compression. -->

<CompressionLevel> 6 </CompressionLevel>
<!-- Optional tag. Values 0 - 9, Default = 6. Level of compression (if
compression was selected in the previous tag). Ranges between 0 (No
compression, fastest) and 9 (Maximum compression, slowest). -->

<Security> 0 </Security>
<!-- Values = 0, 1, 2. Default= 0. Data protection type to be used, 0=None,
1= Zip Password protection, 2=AES encryption. See Security. -->
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<AESType> 0 </AESType>
<!-- AES Encryption strength (if encryption security is selected in the
previous tag)
Values:




0=128 bit
1=192 bit
2= 256 bit

-->

<Password> MyPassword246 </Password>
<!-- Password for security type 1 and 2. WARNING: Security option when
using GRS scripting is compromised since the password is saved without
encryption in the script. -->

<Password_Confirm> MyPassword246 </Password_Confirm>
<!-- Retype the password for confirmation. -->

<ShutdownGBM>FALSE</ShutdownGBM>
<!-- Optional tag. Values TRUE or FALSE. Exit GBM Server when backup
is complete. -->

<ShutdownComputer>FALSE</ShutdownComputer>
<!-- Optional tag. Values TRUE or FALSE, Default = FALSE . Perform
power saving action when backup is complete, See next tag. -->

<ShutdownComputerType> 0</ShutdownComputerType>
<!-- Values: 0, 1, 2, 3. Power saving action to perform when backup is
complete.
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0 = Shut down
1 = Hibernate
2 = Logoff
3 = Standby

-->

<PreJobCommandWait="TRUE"></PreJobCommand>
<!-- Optional tag. Type a command to be performed automatically right
BEFORE the backup job starts. Takes one parameter: Wait: When set to
TRUE, means that GBM will wait for this process to end before starting
backup. -->

<PostJobCommandWait="TRUE"></PostJobCommand>
<!-- Optional tag. Type a command to be performed automatically right
AFTER the backup job ends. Takes one parameter: Wait: When set to
TRUE, means wait for the previous process to end before running the
command. -->

</Settings>

</Backup>

How to: Run a Scripted Backup
To run a scripted backup:
1. Convert the script's extension from .xml to .grs.
2. Double click the file. This will automatically start the backup job without the need of
opening the GBM interface.

To schedule your script as an unattended backup task:
1. Click Start, click All Programs, point to Accessories, point to System Tools, and
then click Scheduled Tasks.
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2.
3.
4.
5.

Double-click Add Scheduled Task.
Click Next.
Click Browse, then select the script file.
Continue by following the on-screen instructions.

261

Troubleshooting
Scheduling Unattended Backup Tasks
1. Generic troubleshooting tips.
2. GBM Is requesting a username for scheduling an unattended backup although I do not
use one.
3. Error Message: "Failed to create a scheduled backup job."
4. Error message: "0x80070005: Access is denied."

Generic troubleshooting tips
GBM uses Windows Schedule task to schedule the backup tasks. However, under certain
circumstances, Windows fails to run the scheduled tasks. Here are steps to troubleshoot
scheduling issues.
1. Run the Job manually from GBM: If the scheduled task does start but encountered
problems running, open GBM and run the task from there as it may be a problem from
the backup job itself. If you encounter problems in the manual run, please contact
technical support.
2. Check the scheduled task status: If your scheduled tasks are running in different times
than expected or not running at all, check your scheduled tasks from Control Panel>
Scheduled Tasks, remove all unwanted schedules of the task or edit the schedule time of
the schedule task by right-clicking the scheduled task> properties> under the schedule
tab you can edit the schedule. You can also edit the scheduled tasks via GBM from
Scheduled Wizard> Edit Existing Tasks. You can also check the Status column in the
Scheduled Tasks window. The following table describes the status types.
Status
Blank
Running
Missed
Could not start

Description
The task is not running, or it ran and was successful.
The task is currently being run.
One or more attempts to run this task was missed.
The most recent attempt to start the task failed.

For details on the scheduled tasks status, go to step 4.
3. Run the job via scheduled Tasks: You can try to attempt a manual run from opening the
scheduled task in the task wizard> Right-click> Run and see if the tasks runs.
4. Check the scheduled task logs for detailed tasks status: The Scheduled Tasks log
(SchedLgU.txt), enables you to view more information about the status of a scheduled
task. This log file for Scheduled Tasks is stored in the Windows folder, where it is used to
record the activity of scheduled tasks. You can use the log file to determine why a task
might have stopped, by viewing errors that may have encountered the task or to check
on the status of a task. Usually, you can search the Microsoft knowledge base
http://support.microsoft.com/search/ with the error codes you are encountering and
find fixes and workarounds for common errors.
5. Manually schedule the task: You may refer to the following knowledgebase article on
how to manually schedule unattended GBM backup tasks.
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http://www.genie9.com/asp/Community/KnowledgeArticle.asp?KBID=55
6. Schedule a Task non- related to GBM: Try scheduling a task that is not related to GBM
so you can identify if the problem is related to GBM or Windows.
Back to top

GBM Is requesting a username for scheduling an unattended backup although I do not
use one.
SYMPTOMS:
Genie Backup Manger requests a username and password for scheduling an unattended backup
task even though mine is a standalone computer and no user name or password are required to
log in.
CAUSE:
Your Windows has a login password, but its set to Null.
RESOLUTION:
Use the following when you are prompted to enter a username and password
User: {Username}
Password: Empty
Back to top

Error Message: "Failed to create a scheduled backup job."
If you are on a domain the user name must be written in the format Domain/Username. Also
make sure that the user name and password that you entered are the ones for the user logged
onto the machine when the backup job is intended to run.
GBM uses Windows Scheduled Tasks agent to schedule unattended backup jobs. Make sure
that the Scheduled Tasks agent is active by manually creating a scheduled task and running it
once. For instructions on how to do this, please follow the link below:
http://www.genie9.com/asp/Community/KnowledgeArticle.asp?KBID=55
In most cases, the user will get an error message that reads
"The new task has been created, but may not run because the account information could not be
set. The specific error is: 0x8007007a: The data area passed to a system call is too small."
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This indicates that the buffer that stores account information for ALL scheduled tasks is finite,
and has been exhausted.
To work around this error:
1. Copy/Paste the following to a notepad file and name it StopStartTaskScheduler.bat:
@echo off
net stop "Net Logon"
net stop "Windows Time"
net stop "Task Scheduler"
net start "Windows Time"
net start "Net Logon"
net start "Task Scheduler"
@ping -n 901 127.0.0.1>nul
@echo You may set the account information for the 'new task' and schedule
additional tasks.
2. Open a CMD prompt.
3. Type StopStartTaskScheduler.bat and press Enter.
4. When you see the You may set the account information for the 'new task' and
schedule additional tasks message, in 15 minutes, the Task Scheduler scavenger
tool, which start 10 minutes after the Task Scheduler service is started, should have
freed enough buffer memory.
NOTES:




You may have to press OK in a dialog that tells you that some scheduled tasks have
been missed.
When the script starts the Task Scheduler, it is normal to receive: "The requested
service has already been started."
Back to top

Error message: "0x80070005: Access is denied"
SYMPTOMS:
When I try to create a scheduled job manually from windows schedule wizard I get an error
message that reads ”r;0x80070005: Access is denied”
CAUSE:
This problem also occurs because of a regression that was introduced in Windows XP Service
Pack 2 (SP2) and Windows XP Tablet PC Edition 2005.
RESOLUTION:
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Please make sure that you are logged on into your user’s account with the correct password,
Even though if you are an administrator the scheduler will not recognize you as you are not
logged on with admin password.
From Microsoft knowledge base :"A supported hotfix is now available from Microsoft, but it is
only intended to correct the problem that is described in this article. Only apply it to systems
that are experiencing this specific problem. This hotfix may receive additional testing. Therefore,
if you are not severely affected by this problem, we recommend that you wait for the next
Windows XP service pack that contains this hotfix."
To download fix please use the following link:
http://www.microsoft.com/technet/security/bulletin/ms04-022.mspx
To work around this problem:
1. Click Start, click Run, type Gpedit.msc, and then click OK.
2. Expand the following items in the Local Computer Policy list:






Computer Configuration
Windows Settings
Security Settings
Local Policies

3. Click User Rights Assignment.
4. Double-click Access this computer from the network, and then click Add User or
Group.
5. Add the new user name or the group name in the Enter the object names to select
area.
6. Click Check Names to verify the entries.
7. Click OK two times.
Back to top

Restoring a Self-Restorable Backup
1. Error message: "The application has failed to start because {MSVCP71.dll or
MFC71U.dll} was deleted. Reinstalling the application may fix the problem"

Error message: "The application has failed to start because {MSVCP71.dll or
MFC71U.dll} was deleted. Reinstalling the application may fix the problem"
SYMPTOMS:
While trying to restore from a self-restorable (SwiftRestore) backup, the system displays an
error saying that a DLL file is missing.
CAUSE:
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You have previously uninstalled a program that inadvertently deleted a files that is necessary for
this operation.
RESOLUTION:
Click HERE to download the file MSVCP71.dll
Click HERE to download the file MFC71U.dll
Place the downloaded file in the folder:
C:\WINDOWS\system32
Back to top

Backup Types
1. Error Message: "Missing index.gix file, can't continue without this file".
2. GBM is set to backup only new and changed files, but it reports the size of the entire set
of selected files and folders before backup, even though few files were added or
updated.

Error Message: "Missing index.gix file, can't continue without this file"
SYMPTOMS:
When backing up in mirror or incremental mode with compression disabled, the backup can't
find index.gix and reports the error message:
"Missing index.gix file, can't continue without this file"
CAUSE:
Your previous backup run was interrupted.
RESOLUTION:

267

GBM User Manual

Run a full backup. This will recreate the index.gix file.
Back to top

GBM is set to backup only new and changed files, but it reports the size of the entire
set of selected files and folders before backup, even though few files were added or
updated
CAUSE
During the "confirming data selections" step before backup, Genie Backup Manager depends on
the Archive bit/flag attribute to determine which files have not already been backed up. If GBM
was not able to reset this flag during previous backups, for instance if the source was writeprotected, it will assume that all files need to be backed up. Note that this does not prevent GBM
from actually backing up only the correct set of files in real-time, as it refers to its own internal
index.
RESOLUTION
If the data source was a network location, change the share permissions for folders that you've
selected for backup to "full control". Otherwise, please make sure that the source media is not
write-protected.
Back to top
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Technical Support
Contacting Support
Even though we strive to make Genie Backup Manager easy to install and use, we understand
that sometimes you may need a helping hand.
Before contacting the support team, please take the time to collect the following information that
will help our team identify the problem and provide you with timely support:
1. Name of the product you are using and build number. You can find the build number by
opening the main application and going to Help > About.
2. Windows platform the program is being used on.
3. Registration name and serial number if applicable.
4. Can the problem be consistently reproduced, if so what are the steps that can be
followed to replicate the error.

You can contact the support team at Genie9 using the helpdesk call tracking system. Users must
be signed up with My Account in order to send inquiries (available for free for both registered
and non registered users). Sign up with My Account.
If you've forgotten your password, click on the Forgot your password? link in the My Account
login page, enter your email address, and click Send. An email will be sent to you. Click the link
in the email to confirm the request. The system will then automatically reset your password and
send you another email containing the new password.

Using the Helpdesk
To access the helpdesk, log in to 'My Account'. From the My Account menu, select Helpdesk.
If you click on Main, a list of all open tickets will be displayed; click on a ticket's case number to
view your inquiry and the support technician's responses.
To submit a new inquiry, click on Submit New Request, complete the form, then click Send.
To attach a file to the call ticket, click Choose to select the file you wish to send from your
computer, then click Attach.
Upon form submission, a ticket will be created in our call tracking system. When the support
specialist assigned to your call responds to your inquiry, an e-mail will be sent to notify you with
a URL and a unique ticket number that you can use to view the response. You can send a reply
by writing a new message in the text box at the bottom of the page, then clicking Send.
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Ordering Genie Backup Manager
Genie Backup Manager has a trial version. This means that you can evaluate a fully functional
copy of the software for FREE. You are entitled to evaluate the software for up to 30 days
without obligation to pay. After 30 days, if you decide to keep the software, you must pay for
and register your copy with us.
There are also a number of 'incentives' for registering:
1.
2.
3.
4.
5.
6.

Removes the registration and license dialogs.
You can use the software after the trial period.
You can use the auto update feature to check for new software upgrades and fixes.
Receive priority customer support.
Free upgrades to any minor version (9.x)
Special offers on major upgrades.

How to register / purchase:
To purchase the software point your web browser to http://www.genie9.com/store/store.html

Software Satisfaction Guaranteed
If for any reason you are not satisfied with software purchased directly from Genie9, simply
contact us for a refund within 30 days of purchase.
For returns, please contact sales@genie9.com
Please note that shipping and delivery charges are non-refundable.
These terms and conditions apply only to Genie9 software purchased directly from Genie-Soft. If
your software was purchased through a different vendor, it must be returned to that vendor and
is subject to the return policies of that vendor.

Your Order Is Secure
Ordering through Genie9. is certain to provide you with a safe and secure credit card
transaction.
Your order is secure because we use Secure Socket Layer (SSL) encryption for every
transaction.
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